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 multi-screen display technology. It 
mage with digital imagery, video 
omputer technology. Use it with 
ook it up to monitors, video wall 
screen arrangements.

  

rts:

n, giving you the big picture. Start 
 your first look at WATCHOUT.

ows, menus, commands and other 
re about specific functions

l information related to particular 
 inputs and external control proto-

   

rsion of this manual, the table of 
 can be clicked to jump directly to 

  

4. The latest version of the software 
ined from:
Chapter 1     Introduction

1 INTRODUCTION

WELCOME Welcome to WATCHOUT™, a fully digital,
combines the qualities of traditional multi-i
and the graphics power of contemporary c
projectors for large, seamless images, or h
cubes or plasma screens for other creative 

About This Manual This manual is divided into the following pa

• A Quick Start and an Introduction sectio
here if you’re a new user or just having

• A reference section, describing all wind
details. Refer to this section to learn mo

• A number of appendices with additiona
areas of the product, such as live video
cols.

◆ HINT: If you’re reading the electronic ve
contents, index and all cross references
the referenced page.

WATCHOUT Version 4 This manual refers to WATCHOUT version 
and its documentation can always be obta

http://www.dataton.com/watchout/

Just Getting Started?

To get up to speed with 
WATCHOUT as fast as 
possible, go straight to 
“Quick Start” on page 14.

http://www.dataton.com/watchout/


   

 various components in a very 
gether.

  

duction work. This is where you 
te your presentation. Using the 

3), you simply drag media into 
indow and along the Timeline.

lay Display
4

Projectors

Display
computers
8 Chapter 1     Introduction

SYSTEM OVERVIEW This section provides a brief introduction to the
basic WATCHOUT system, and how they fit to

Production Computer This is the focal point for your WATCHOUT pro
collect all the source material, or media, to crea
WATCHOUT production software (see page 1
your presentation, positioning it in the Stage w

Display
2

Display 1

Disp
3

• Safety
• Speed
• Tires!

Main image
area using

overlapped
projectors

Separate
plasma
display

Ethernet Network

Production
computer
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y computers through the network, 
 as well as controlling the playback 
layback while running the show.

  

isplay device (projector, monitor, 
uters handle all the hard work 
ideo. They also apply edge blends 

 display device makes the system 
ays are added, you also add more 

  

g the production computer to 
k is created by connecting the 
 shown in the overview illustration).

n, or revise existing media, these 
 the network, to the appropriate 
ers your display configurations, 
f your presentation to the display 
 the display computers, very little 

ork during playback, avoiding 

  

y display device that can be 
s, LCD and plasma displays. See 
ails.
Chapter 1     Introduction

The production computer talks to the displa
transferring media files for you as required,
of the show. It can also be used for audio p

Display Computers You need one display computer for each d
etc) used in you presentation. Display comp
associated with rendering still images and v
and can play sound files.

The fact that there’s one computer for each
scalable to virtually any size; as more displ
computing power to drive these displays.

Network The network ties the parts together, allowin
manage all display computers. The networ
computers to a common hub or switch (not

As you add new media to your presentatio
changes are automatically propagated, via
display computers. The network also transf
timeline programming and other aspects o
computer. With all this material residing on
information needs to be sent over the netw
network congestion.

Display Devices WATCHOUT can be used with virtually an
connected to a computer, such as projector
“Display Issues” on page 207 for more det



   

ction software on its own in 
appreciate the full power of 
omputers. The illustration to the 
ollowing components:

on software.

oftware

r a projector).

ogether via a hub or switch.

g WATCHOUT must have a 
se Keys” on page 18).

   

d on its own without a license 
 display software.

  

ou arrange the displays. The 
play arrangements. In addition, 
d surfaces (see “Geometry 

Arch built using
multiple LCD displays
10 Chapter 1     Introduction

Minimal System Configuration Although you can use the WATCHOUT produ
order to get acquainted, you won’t be able to 
WATCHOUT until you connect some display c
left shows a minimal system, consisting of the f

• A computer running WATCHOUT producti

• A computer running WATCHOUT display s

• A display device (for example, a monitor o

• A network, connecting the two computers t

In addition, each computer in a system runnin
WATCHOUT license key connected (see “Licen

◆ NOTE: The production software can be use
key. License keys are required for using the

Alternative Display Layouts WATCHOUT is very flexible in terms of how y
illustrations below show some more unusual dis
WATCHOUT also supports projection on curve
Correction” on page 146).

Display

Network
Switch

Production
computer

Display
computer

Plasma display
column

Vertically oriented, edge
blended projectors

Diamond-shaped
display cluster
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media, such as still images, video 
 a wide variety of file formats, 
F, Targa, AVI, QuickTime, MPEG-

2 and Windows Media), AIFF and 
eas (alpha channel) are supported 
ing on chosen file formats).

ia supported by WATCHOUT, see 

  

HOUT can also incorporate live 

e image of a speaker into the 

ayer or a satellite link.

presentations.

re, such as capture cards, in order 
Live Video” on page 49). In other 
o the system through the network.

  

ystems and technologies to build 
ch panel as an interactive front-
T clusters. Use Dataton PICKUP as 
chronized, multi-lingual audio. 
CHOUT using a computer network, 
feed (see separate sections and 
 options).
Chapter 1     Introduction

Images, Sound and Video A WATCHOUT presentation uses multiple 
clips, sound files, etc. WATCHOUT accepts
including PhotoShop, JPEG, BMP, PNG, TIF
1, MPEG-2, High Definition Video (MPEG-
WAV. Transparent and semi-transparent ar
in both still images and video files (depend

For more details on the various kinds of med
“Media” on page 35.

Live Feeds In addition to pre-produced content, WATC
feeds of various kinds:

• Video camera, e.g., for integrating a liv
presentation.

• Other external feeds, such as a DVD pl

• Computer graphics, e.g., a PowerPoint 

Some live feeds require additional hardwa
to bring the signal into WATCHOUT (see “
cases, the external feed can be brought int

External Control WATCHOUT can be combined with other s
entire presentation environments. Use a tou
end, controlling any number of WATCHOU
a simple remote control and to provide syn
Connect other devices and systems to WAT
serial port, MIDI, DMX-512 or a timecode 
appendices for details on external interfaceTouch panel and Dataton PICKUP.



   

ATCHOUT production software.

  

isplays (screen areas) to reflect 
eview of the end result, and 
ovement of images.

  

nto a timeline window, where 
bnail icon of the media. You 
e position and length of these 
ow represent the order of over-

  

e media files also appear in the 
ry for all media used in your 
h media file, and allows the file 
oses.

  

ced by applying tween tracks. 
media on stage, such as posi-

  

e changes can be transferred to 
. This automatically transfers 
e relevant display computers 
les and cues are cached locally 
o run at any time by simply 
12 Chapter 1     Introduction

SOFTWARE OVERVIEW This section gives a brief introduction to the W

Stage Window The Stage window allows you to organize the d
their expected placement. It also provides a pr
allows you to manipulate the placement and m

Timeline Media files are dragged from your hard disk i
they appear as cues. Each cue features a thum
determine timing and duration by adjusting th
cues. The horizontal layers in the timeline wind
lapping images, back-to-front.

Media As media is added, thumbnails representing th
Media window. This acts as a central reposito
presentation. It provides information about eac
to be easily accessed for editing or other purp

Cues and Tween Tracks The cues in the timeline window can be enhan
Tween tracks control the dynamic behavior of 
tion, size or transparency.

System Management As you make changes to the presentation, thos
all the display computers by a single keystroke
any media you have added, or modified, to th
and shows the result on screen. As the media fi
on each display computer, the show is ready t
pressing the spacebar.
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esigned to get you up to speed 
 start running the WATCHOUT 

g and editing a full-blown 
 have the WATCHOUT DVD-
appendix A).

  

e WATCHOUT Installer found 
tructions to install WATCHOUT 
M also installs other required 

   

nown incompatibilities with 
e on your computer, you may 

ng WATCHOUT, thereby 
commended version.

  

” from the WATCHOUT DVD-
 hard disk. Alternatively, if you 
pack the archive file.

   

tion from its folder on the DVD-
 hard disk.

  

his is inside the folder that you 
Double-click this file to open it 

HOUT examines and caches 
This happens only once.
14 Chapter 1     Introduction

QUICK START If you’re new to WATCHOUT, this section is d
as quickly as possible. Follow the instructions to
production software on your computer, playin
WATCHOUT presentation. It assumes that you
ROM and a modern Windows computer (see 

Install the Software If you haven’t already done so, double-click th
on this DVD-ROM and follow the on-screen ins
on your computer. The installer on the DVD-RO
components, such as QuickTime.

◆ NOTE: Some versions of QuickTime have k
WATCHOUT. If you already have QuickTim
want to un-install QuickTime before installi
allowing the automatic installation of the re

Copy the Demo Show Drag the folder titled “Demo Show and Media
ROM to a suitable location on your computer’s
obtained the demo show from our web site, un

◆ NOTE: It is not possible to open the presenta
ROM. You must copy it to your computer’s

Open the Show Locate the file named “WATCHOUT Demo.” T
copied to your hard disk in the previous step. 
using the WATCHOUT production software.

When opening a show for the first time, WATC
media files, as indicated by the progress bar. 
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s shown on the previous page. 
e you have sound playback 
hing the show in its entirety, you 
eyboard to review any section, 
page.

 is designed to play using three 
window on your computer 
ing it full-scale on a big screen, 
TCHOUT show is put together.

   

 demo show – such as those 
re a more powerful computer 
ications in Appendix A.

  

 the demo show. Move things 
ns and edit the parameters of 
r details.

  

le presentations, you need to 
ther display devices) as shown 

ng up and configuring a 

es, you also need to acquire 
n page 18). To run a show like 
 WATCHOUT Starter Kit 
license keys – perfect for a three 
 production computer and one 
16 Chapter 1     Introduction

Watch the Show The show should now appear on your screen, a
Press the space bar to run the show. Make sur
enabled, so you can hear the audio. After watc
can use the Function keys on your computer’s k
as indicated in the illustration on the previous 

As you can see in the Stage window, this show
overlapped projectors. Watching it in a small 
doesn’t come anywhere near the impact of view
but should still give you an idea of how a WA

◆ NOTE: For best effect, some sections of the
involving high definition video – may requi
than is stated in the minimum system specif

Change the Show To get familiar with WATCHOUT try modifying
around, replace graphics, change cue duratio
cues. Please refer to Chapter 4 “Production” fo

Where to Go From Here To use WATCHOUT for running actual, full-sca
hook up display computers and projectors (or o
on page 8. Chapter 2 provides details on setti
complete system.

In addition to the computers and display devic
WATCHOUT license keys (see “License Keys” o
the demo in this section, you could start with a
(product number 3154-1), which includes four 
projector show. You would use one key for the
for each display computer.

WATCHOUT Starter Kit
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2

 

ired software components as well 

  

from the WATCHOUT CD-ROM or 

nstructions. This installs both the 
ts, adding them to your Start menu.

   

r primarily for WATCHOUT, first 
uter” on page 195.

  

OUT CD-ROM, QuickTime is 
WATCHOUT from the web, Quick-

  

to obtain it from:

l?artnum=120297  (recommended)

nload/  (latest)

   

nded version (QuickTime 6.4), 
tallation mode, then click “Select 
Chapter 2     Installation

2 INSTALLATION

This chapter tells you how to install the requ
as how to hook up the hardware.

SOFTWARE Obtain the “WATCHOUT Installer”, either 
by downloading it from

http://www.dataton.com/watchout/

Run the installer and follow the on-screen i
production and display software componen

◆ NOTE: If you intend to use the compute
read the section titled “Dedicated Comp

Installing QuickTime If you install WATCHOUT from the WATCH
installed automatically. If you downloaded 
Time is not included. In this case you need 

http://docs.info.apple.com/article.htm

http://www.apple.com/quicktime/dow

▲ IMPORTANT: If you install the recomme
make sure you choose the “Custom” ins
All” to install all components.

http://www.dataton.com/watchout/
http://www.apple.com/quicktime/download/
http://docs.info.apple.com/article.html?artnum=120297


   

uters must be interconnected 
hich comes standard on most 
mended, Gigabit and 10 MBit 

rally not recommended.

  

stem, this is usually all you need 

  

OUT license key, including the 
 USB (Universal Serial Bus) port 

   

e off-line without a license key 
n-line to communicate with the 

t switch

Display
Computers
18 Chapter 2     Installation

NETWORK The production computer and all display comp
using a TCP/IP compatible Ethernet network, w
computers. Although 100 MBit Ethernet is recom
can also be used. Wireless networks are gene

Stand-alone System Connect all computers to a hub or switch.

For stand-alone operation of a WATCHOUT sy
to do in terms of hardware hook-up.

LICENSE KEYS Each computer in the system requires a WATCH
production computer. Plug the key into any free
on the computer.

◆ NOTE: You can run the production softwar
connected. A key is needed when you go o
display computers.

Etherne

Production
Computer
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eleased (for example, going from 
 must be upgraded in order to be 
grade may be purchased and 
 “Upgrading your Licenses” on 

  

y technologies, including CRT, DLP 
, video wall cubes and plasma 
ny display device that’s compatible 
er. 

h a high contrast ratio (2000:1 or 
s” on page 207 for further details 
nnect them to WATCHOUT.

  

s, it is important to choose the 
u buy your screen material from a 
rements of multi-image projection, 

, or “silver” screens. Such screens 
hen using multiple projectors and/

 See “Banding” on page 214.

on screens is the “hot-spot” caused 
 projection surface. See “Rear 
Chapter 2     Installation

Upgrading License Keys When a major revision of WATCHOUT is r
version 3.x to version 4.x), old license keys
used with the new software version. An up
supplied electronically via the Internet. See
page 105 for more details.

DISPLAY DEVICES WATCHOUT can be used with most displa
and LCD projectors, LCD and CRT monitors
screens. Generally speaking, you can use a
with the display card in the display comput

For projection purposes, DLP projectors wit
better) is recommended. See “Display Issue
on various kinds of displays, and how to co

PROJECTION SCREEN As in all multi-screen projection application
screen material with caution. Make sure yo
screen manufacturer familiar with the requi
or similar applications.

For front projection, avoid using high-gain
often cause uneven brightness or banding w
or when viewing from non-optimal angles.

A related problem when using rear projecti
by the projection lens showing through the
Projection” on page 214.



   

play computers, or through the 
d output from the computer 
r powered speakers.

io signal a long distance, you 
 converts the unbalanced signal 
l, thereby reducing the risk of 

nal audio amplifier.

  

ing at the same time, thereby 
nization between computers is 
port or special effects sound 
hannel sound reproduction.

nd card in a display computer. 
e accurate sound channels. See 
etails.

  

ng video input devices, such as 
atellite link or the image 
 Microsoft PowerPoint

 

®

 

 presen-
nput solutions, see “Live Video 

  

 where it’s supposed to appear. 
mputers, and you want to show 
 display areas, both those 
 kind of capture card, and the 
both cards. 
20 Chapter 2     Installation

SOUND Sound can be provided through any of the dis
production computer. Simply connect the soun
(usually a 3.5 mm mini-jack) to the amplifier o

If you need to run the computer’s line level aud
should use an audio line level transformer. This
coming from the computer to a balanced signa
hum and noise when connected to a professio

Using Multiple Sound Channels You can have multiple display computers play
providing multiple audio channels. The synchro
generally good enough for multi-language sup
tracks, but not for true, phase accurate, multi-c

Another option is to install a multi-channel sou
Such sounds cards can handle up to eight phas
“Multi-Channel Audio” on page 47 for more d

LIVE VIDEO INPUT WATCHOUT can integrate live video feeds usi
capture cards. This may be a camera feed, a s
displayed by another computer (for example, a
tation). For examples on some suitable video i
Input” on page 194.

Feeding Multiple Display Computers The video signal must be fed to each computer
For instance, if your system uses five display co
a live video image straddling two of those five
display computers must be fitted with the same
video signal must be fed to the same input on 

Sound output jack symbols.
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 required to distribute the signal to 
rom companies such as Extron and 

  

ware drivers. Although such a 
a CD-ROM, it’s often a good idea 
 latest driver version. For a list of 

ut” on page 194.

nputs have additional drivers that 
ate the capture function. Please see 
commended procedure, since the 
 sometimes important.

  

uter that will show live video as 
 133. Optionally, you can also 

ow of the production computer (see 

  

devices using the MIDI and DMX-
 devices connected through a serial 
requires a Windows compatible 
ough a USB port. Follow the instruc-
stall any required software or 

 more details.
Chapter 2     Installation

A video DA (distribution amplifier) may be
multiple inputs. Such devices are available f
Kramer Electronics:

http://www.kramer.co.il/

http://www.extron.com/

Software Driver Installation Most capture cards require specialized soft
driver is usually delivered with the card on 
to check the manufacturer’s web site for the
suitable capture cards, see “Live Video Inp

Some graphics cards that include capture i
must be installed separately in order to activ
the manufacturer’s documentation on the re
order in which these drivers are installed is

WATCHOUT Configuration Configure each WATCHOUT display comp
described under “Add Live Video” on page
choose to show live video in the Stage wind
“Video In” on page 115).

MIDI AND DMX-512 WATCHOUT can communicate with other 
512 industry standard protocols, as well as
or network data link. MIDI communication 
MIDI interface, which is often connected thr
tions included with your MIDI interface to in
drivers. 

See “Inputs and Outputs” on page 173 for

http://www.extron.com/
http://www.extron.com/


   

tem in WATCHOUT to integrate 
for example, to display Excel or 
ntation), you must install VNC 
ust be a separate computer – it 
CHOUT software. 

   

ic WATCHOUT functions. You 
t to use the “Computer Screen” 
ge 131).

are is available for a wide 
elow describe its installation 

ble in several forms:

of the above locations, and 
Windows Vista, you’re advised 
e application.

mputer to run the VNC server 
porate into your presentation 

nnected to the WATCHOUT 
 its TCP/IP settings (see 
rameters must match the 
t its firewall is disabled, or that 

“Firewall Settings” on page 27).
22 Chapter 2     Installation

VNC SERVER SOFTWARE If you want to use the Computer Screen media i
a live computer display into your presentation (
Powerpoint as part of a speaker-support prese
server software on the remote computer. This m
can not be one of the computers running WAT

◆ NOTE: This software is not required for bas
only need to install this software if you wan
feature (see “Add Computer Screen” on pa

VNC (Virtual Network Computing) server softw
variety of operating systems. The instructions b
under Windows. VNC is free software, availa

http://www.realvnc.com/ 

http://ultravnc.sourceforge.net/

Download the VNC server software from one 
follow its installation instructions. When using 
to start the VNC server software as a user mod

For best performance, use a reasonably fast co
software and the application you wish to incor
(for example, Powerpoint). 

Make sure that the VNC server computer is co
network, and has a fixed, known IP number in
page 26). This IP number and other TCP/IP pa
network to which it is connected. Also verify tha
the VNC port 5900 is open in the firewall (see 

http://www.realvnc.com/
http://ultravnc.sourceforge.net/
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are, you will be prompted to enter 
 appears as an icon in the lower 
inting at this icon displays the IP 
 icon to change the settings.
Chapter 2     Installation

The first time you run the VNC server softw
a password. The VNC server software then
right corner of the screen while running. Po
number of the VNC server. Double-click the

VNC Server software settings.

Enter the desired VNC server 
password here.



   

/IP networking. Click the Start 
etwork and Sharing Center”. 

shown in the list.

on, then click “Properties” in the 
ndow. You may need to type 
s point.
24 Chapter 2     Installation

COMPUTER SETTINGS Each computer needs to be configured for TCP
button and choose Control Panel. Open the “N
Make sure there’s a “Local Area Connection” 

Click “View Status” for the Local Area Connecti
subsequent “Local Area Connection Status” wi
your password to continue configuration at thi

Click “View Status”.
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P/IPv4)” is available and selected.
Chapter 2     Installation

Ensure that “Internet Protocol Version 4 (TC



  

)”, click “Properties…” and 
26 Chapter 2     Installation

Choose “Internet Protocol Version 4 (TCP/IPv4
enter the numbers as shown below.

◆ NOTE: The example shown is 
appropriate if you’re building a 
stand-alone system. If your 
WATCHOUT subnet is connected 
to a larger network, you should 
consult your network admini-
strator for the correct information.
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ormal operation of WATCHOUT. 
irewall, or by configuring the fire-
isable the firewall, open the 
n below.

” You may need to enter your pass-
s Firewall Settings” window (see 
wall.
Chapter 2     Installation

Firewall Settings The Windows firewall may interfere with n
You can avoid this either by disabling the f
wall to allow WATCHOUT to function. To d
“Windows Firewall” control panel, as show

If the firewall is on, click “Change Settings.
word at this point. This opens the “Window
next page), allowing you to turn off the fire



    

ewall entirely, you may 
 and any other related functions 
ter’s documentation for details 
28 Chapter 2     Installation

◆ NOTE: As an alternative to disabling the fir
configure the firewall to allow WATCHOUT
to pass through. Please consult your compu
on how to configure the Windows firewall.

▲ IMPORTANT: A WATCHOUT sys-
tem should not be accessible from 
the Internet, or other external net-
work. If you need to access the In-
ternet from your system, use a 
separate firewall device to protect 
your complete system from 
security attacks.

The firewall feature should be turned 
off. Otherwise it may interfere with 
the ability to connect to and down-
load media files to the display 
computers.
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 in your WATCHOUT system, you 
isplay computers. Most of the 
rt button and choosing Control 

  

ontrol panel and configure TCP/IP 
 unique IP number for each display 
address digits.

ne production computer and three 
IP addresses assigned like this:

ne but connected to a larger 
dministrator for the correct IP 

rs.

   

ust be manually assigned a unique 
ter, the display computers may not 
gnment.

  

. 

Display
computers

.168.0.11
192.168.0.12
Chapter 2     Installation

DISPLAY COMPUTER SETTINGS To achieve best performance and reliability
need to adjust several settings on all your d
settings below are found by clicking the Sta
Panel.

Network Open the “Network and Sharing Center” c
as described on preceding pages. Specify a
computer by changing the last group of IP 

As an example: in a system consisting of o
display computers, you would end up with 

If your WATCHOUT subnet is not stand-alo
network, you should consult your network a
number, subnet mask, and other paramete

▲ IMPORTANT: Each display computer m
IP address. Unlike the production compu
use automatic (dynamic) IP number assi

Display Properties • Open the Personalization control panel

• Click Display Settings. 

192.168.0.1

Production
computer

192.168.0.10
192



  

ettings for this display in your 

 Apply. 
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• Choose the Resolution slider to match the s
presentation. 

• Set “Colors” to “Highest (32 bit)” and click

• Click the “Advanced Settings...” button. 
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fresh rate” as set in the “Display 
dialog box of your WATCHOUT 
OK.
Chapter 2     Installation

• Click the Monitor tab and set “Screen re
Framerate” specified in the Preferences 
presentation (see page 113), and click 



  

 mixed PAL and NTSC video, 
es dialog box, and set the 

   

lays work better at 60 fps than 
L video. If you experience jerky 
ant to try setting both the 
 computers to 60 fps/Hertz.

 change the refresh rate. In this 
 under the Adapter tab. This 
ay card drivers and the display 
Rate Settings” on page 204 for 

   

pt to set the display resolution 
ly is usually preferable. The rea-
w WATCHOUT to set the most 
g the display resolution and re-
ATCHOUT, you avoid the risk 

.
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If you don’t intend to use video, or if you have
choose “60 fps” in the WATCHOUT Preferenc
display’s refresh frequency to 60 Hz.

◆ NOTE: Some video projectors and LCD disp
other refresh rates even when displaying PA
motion and/or video playback, you may w
WATCHOUT Preferences and your display

Some system configurations don’t allow you to
case, the Refresh rate option will not be shown
may vary depending on the display card, displ
connected to the system. See “Display Refresh 
more information.

▲ IMPORTANT: While WATCHOUT will attem
automatically, setting the resolution manual
son is that many display adapters don’t allo
optimal display refresh frequency. By settin
fresh frequency manually before starting W
of getting a non-optimal display frequency
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playback, you must enable the 
 Open the Sound control panel and 
 not, select the desired playback 
Chapter 2     Installation

Sound Settings When using a display computer for sound 
correct sound output and turn up its volume.
make sure the correct output is activated. If
device and click “Set Default”.

Indicates the currently active 
(default) sound output port.



  

he list shown on the previous 
under the Levels tab.
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Once you have selected the desired output in t
page, click Properties and turn up the volume 

Turn up the volume.

◆ NOTE: The look of this window 
may vary depending on the 
features of your audio interface.



35

3

not include any media creation or 
our presentation must be supplied 

edia and file formats supported by 
lar applications used to create or 

s in a folder that is located in the 
ile, or in a sub-folder. This allows 
aths, making it easier to move the 
Chapter 3     Media

3 MEDIA

WATCHOUT is a compositing tool; it does 
editing functions. All media to be used in y
and edited using other means.

This chapter provides an overview of the m
WATCHOUT, as well as examples of popu
edit such media files.

▲ IMPORTANT: Keep a show’s media file
same folder as the WATCHOUT show f
the software to use relative file access p
show to another disk or computer.

Various kinds of media in the 
WATCHOUT Media window.



perimposed on other images. 
ling, mirroring and rotation for 

ts, including BMP, GIF, JPEG, 

application used to create/edit 
 to edit images, save the images 
 applications support saving or 

ause a loss of information. This 

ages with WATCHOUT, files 
mpatibility” enabled. This Pho-
ile Handling, File Compatibility.

d or shot using a digital 
rovides the best compromise 
ind that JPEG is a lossy 
rmally unnoticeable, details in 

sion process.

ooth areas (for example, 
format.
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STILL IMAGES Still images can be used as backgrounds or su
You can control the degree of transparency, sca
all images (stills as well as moving images).

Supported Formats WATCHOUT reads most popular image forma
Photoshop, PICT, PNG, Targa and TIFF. 

Preferably, use an image format native to the 
the images. For example, if you use Photoshop
as Photoshop files. Although most image editing
exporting to other file formats, doing so may c
can make it difficult to edit the image later.

▲ IMPORTANT: In order to use Photoshop im
must be saved with “Maximize PSD File Co
toshop option is found under Preferences, F

For photographic images (for example, scanne
camera), JPEG at a high quality setting often p
between image quality and file size. Keep in m
compression format. This means that minor, no
the original image may be lost in the compres

For computer-generated images with large, sm
screenshots), PNG is a suitable cross-platform 



37

nformation in addition to the image 
etimes referred to as an “alpha 
plications use this term for other 
te non-square images, holes inside 
drop shadows. Photoshop, PNG, 
mats that support transparency. 

ts writing to a particular file format, 
ormat. Perform tests with images to 
rmats and applications.

for encoding transparency into 
termined automatically. If not, you 
pecifications dialog box for the 
(see “Transparency” on page 130).

hen composited in 
HOUT.
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Transparency Some image formats include transparency i
itself. This transparency information is som
channel”, although some image editing ap
functions. Transparency can be used to crea
images or semi-transparent areas, such as 
TIFF and Targa file are examples of file for

▲ CAUTION: Even if an application suppor
it may not support transparency in that f
determine the suitability of particular fo

WATCHOUT supports most methods used 
images. Which method to use is usually de
can specify this manually by opening the S
image and choosing the desired encoding 

+ =

Background image. Image with a transparent back-
ground and a semi-transparent 
shadow.

Result w
WATC



other applications, such as 
nctions, such as multiple fonts, 
s effects that can be applied to 

tion computer, you can edit the 
e Media window. Save the text 

menu
38 Chapter 3     Media

TEXT Text, like other images, must be created using 
Adobe Photoshop. In addition to text editing fu
kerning, etc, Photoshop also supports numerou
the text, with the text remaining fully editable.

Assuming Photoshop is installed on the produc
text by simply double-clicking its thumbnail in th
then choose Refresh on WATCHOUT’s Media 

Creating text using Adobe 
Photoshop.

Applying Layer Effects such as glow 
and drop shadow.
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important that the application used 
y. It must also be able to render the 
f transparency, often referred to as 
e edges of the text will appear 
alo around the text.

eos saved in a Windows Media 
at, including MOV, WMV, AVI, 

 (a resolution of 1280 x 720 or 
s Media 9 format. To play back 
 Player 9 or later must be installed 
d from Microsoft).

a video can be encoded by, for 

/products/ProCoderSW/

r is TMPEGEnc Express:

dex.html

ed using the free Windows Media 

indowsmedia/default.aspx

uires a fast computer (a 3 GHz 
ontent will play on less powerful 
Chapter 3     Media

Anti-aliasing of Text When overlaying text on other images, it is 
to save the text image supports transparenc
edges of the text using a variable amount o
anti-aliasing. If that is not done properly, th
jagged, or there will be a thin contour or h

MOVING IMAGES WATCHOUT can play back movies and vid
(DirectShow) or QuickTime-compatible form
DV and MPEG-1/2.

High Definition Video WATCHOUT supports high definition video
more) using either MPEG-2 or the Window
Windows Media 9 video, Windows Media
on each display computer (a free downloa

High definition MPEG-2 or Windows Medi
example, the Canopus ProCoder:

http://desktop.thomsongrassvalley.com

Another excellent and very flexible encode

http://tmpgenc.pegasys-inc.com/en/in

Windows Media content can also be encod
Encoder 9:

http://www.microsoft.com/windows/w

◆ NOTE: Windows Media HD content req
Pentium 4 or equivalent). MPEG-2 HD c
computers.

http://desktop.thomsongrassvalley.com/products/ProCoderSW/
http://tmpgenc.pegasys-inc.com/en/index.html
http://www.microsoft.com/windows/windowsmedia/technologies.aspx


ontent, a progressive (that is, 
ple, “30p”).

es, you must specify the frame 
g rendering. Generally, when 

ded video material, the frame 
ly, if your playback computer is 
the WATCHOUT display frame 
or example, 60 fps progressive.

er generated, moving images 
ring only the parts of an image 
rden on the playback machine, 
ind that you can make non-
 using transparency options in 

esolution independent, it is also 
han a single display area. Very 
to be used in WATCHOUT (see 
ending on the performance of 
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When shooting and encoding high definition c
non-interlaced) format is preferable (for exam

Computer-generated Animations When using computer-generated moving imag
rate and resolution of the resulting movie durin
combining computer generated and pre-recor
rate is dictated by the live material. Alternative
fast enough, match the rendered frame rate to 
rate (see “Display Framerate” on page 113); f

It’s often advantageous to use smaller, comput
layered on top of larger still images. By rende
that actually move, not only do you lower the bu
but you also reduce rendering times. Keep in m
square movies, or even holes inside movies, by
supporting applications and codecs.

As computer generated movies are by nature r
possible to make movies that are much larger t
large movies may need to be pre-split in order 
“Pre-splitting Large Movies” on page 44), dep
the display computers.
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tion software, often save the 
his may also be the case when 
. Such a sequence of images must 
ropriate frame rate, before it can 

n be done using, for example, 

 all ending in a frame number. This 
or example, File001.tga, 

cts. To assemble a movie from still 
Import, Footage File” on the File 
d select the “<Format> Sequence” 

pecified in Preferences prior to 
any time by choosing “Interpret 

hoose “Open Image Sequence” 
port and specify the desired frame 

r. Using Autodesk Cleaner, 
 menu and locate the first image in 
 for the desired frame rate.

ns (such as TMPGEnc Express and 
 an image sequence.
Chapter 3     Media

Assembling Individual Frames Some applications, most notably 3D anima
resulting frames as individual image files. T
scanning images frame by frame from film
be converted into a movie file, with the app
be incorporated into WATCHOUT. This ca
Adobe After Effects or Apple QuickTime.

The individual images must be saved as files
number precedes the file name extension: f
File002.tga, File003.tga, etc. 

Assembling using Adobe After Effe
images using Adobe After Effects, choose “
menu, select the first file in the sequence, an
checkbox. The desired frame rate can be s
importing the images, or can be altered at 
Footage, Main” on the File menu.

Assembling using QuickTime Pro. C
on the File menu, select the first image to im
rate.

Assembling using Autodesk Cleane
choose “Open Image Sequence” on the File
the sequence. Cleaner will then prompt you

◆ NOTE: Many video encoding applicatio
Procoder) can also encode directly from



rency information in the gene-
 come from the source material 
), or be added afterwards (for 

, or movies with holes in them, 
es in many creative ways.

 the movie file, you must choose 
“Millions+” of colors. The “+” at 
n. This is sometimes called 
ation that’s capable of repro-
ation, such as Adobe After 

o stream, storing and playing 
le. Video compression is based 
ds for compressor/decom-
echnology responsible for 
 video. 

ch optimized for a particular 
ents. WATCHOUT supports 

ow codec technologies for play-
ommonly used codecs:

all files. Optimized for camera 
uarter of the video format’s 

ot of computation power, use it 
s at the same time.
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Using Transparency Some applications support inclusion of transpa
rated movie file. Such transparency can either
(for example, a computer generated animation
example a mask applied to a video clip).

Being able to create arbitrarily shaped movies
means you can combine moving and still imag

In order to include transparency information in
a QuickTime codec that’s capable of handling 
the end stands for the transparency informatio
“Millions+Alpha”. You must also use an applic
ducing and/or generating transparency inform
Effects. 

Video Compression Due to the large amount of raw data in a vide
back uncompressed video is usually not feasib
on the concept of codecs. A codec (which stan
pressor) is the part of the editing and display t
storing and playing back compressed digitized

There’s a wide variety of codecs available, ea
kind of source material and playback requirem
both Apple QuickTime and Microsoft DirectSh
back. Here’s a rundown of some of the more c

MPEG-1. Medium quality. Generates very sm
video. Native frame size is fixed, based on a q
frame size. Since this codec doesn’t require a l
when you need to play a lot of small video clip

Computer generated movie with 
transparent background and semi-
transparent drop shadow playing 
over a background image.
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o discs. Optimized for camera 
 high definition formats with some 
age 39). The WATCHOUT MPEG-

tically when required.

ery low compression. Optimized 
 transparency when set to 

tructive). Low compression. Opti-
pports transparency when set to 

ptimized for video editing. Gener-
ers. Native frame size is fixed, 
st performance, use the AVI file 
CHOUT.

le in terms of frame size (useful for 
and interlacing/progressive 
ed when using high resolutions at 

s for your source material and play-
entation.

 file formats, some formats tend to 
use MPEG-2 or Windows Media 9 
h case QuickTime Animation is the 
 processor power, but provides 

e sizes.
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MPEG-2. High quality. Used on DVD vide
video at normal frame sizes. Also supports
encoders (see “High Definition Video” on p
2 decoder performs de-interlacing automa

Quicktime Animation. High quality. V
for computer-generated material. Supports
“Millions+” of colors.

QuickTime PNG. High quality (non-des
mized for computer-generated material. Su
“Millions+” of colors.

DV. High quality. Medium compression. O
ated directly by most digital video camcord
based on video format’s frame size. For be
format for DV content to be used with WAT

Windows Media 9. High quality. Flexib
making tall or narrow movies), frame rate 
options. Very demanding on processor spe
full frame rate.

Choosing the right codec and codec setting
back hardware may require some experim

Recommended Compression 
Formats

Although WATCHOUT supports most video
give better results. As a general guideline, 
unless an alpha channel is required, in whic
recommended codec. WM9 requires more
greater flexibility in terms of supported fram



laying at least one high defini-
ven be able to play several high 
long as what you need to play 
ilities, you should generally 
dia high definition format.

g numerous displays, even 
andle the required resolution as 
omputer generated movies, 
e rate your animation software 
es can be played by splitting 
includes only the portion of the 
.

OUT for still images, it is not 
 primary reason for this differ-
st likely have to be compressed 
play computers. To split the 
ecompress each frame, split it 
playback. This would mean that 
e end result would be a loss of 

 storage and bandwidth consid-
original (large) movie in order 
ed in compressing it twice. The 
vie, particularly to achieve the 
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Pre-splitting Large Movies Modern computers are generally capable of p
tion video file. Some very fast computers may e
definition movies at the same time. Hence, as 
fits within the realm of your computer’s capab
choose either the MPEG-2 or the Windows Me

However, for extremely large movies, spannin
modern computers may not be fast enough to h
one large movie. This applies in particular to c
which can be made at any resolution and fram
is capable of producing. Such very large movi
them into individual pieces, where each piece 
frame that will play on each display computer

While this splitter function is built into WATCH
handled automatically for moving images. The
ence is that the original, large movie would mo
in order to be stored and distributed to the dis
movie, the display computers would have to d
and then re-compress the result again for final 
each movie frame will be compressed twice. Th
image quality.

In addition to this quality aspect, there are also
erations related to distributing and storing the 
to split it, as well as the processing time involv
latter would be significant for such a large mo
best quality.
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e using the originating application, 
ow you to crop the output to any 
ven set up batches to generate all 

800 by 600 pixel displays with a 
 of 1200 by 480 pixels, the split 
ft.

 an example. Most modern 
 movie as is, without pre-splitting it.

tion of the image in the overlap will 
he displays aren’t overlapping you 
dges of the display areas by speci-
e split.

to the initial image size. This means 
calculated based on the height and 

vie into smaller pieces like this, 
 source. Doing so would introduce 
ression step, resulting in lower qual-
ith the original material, such as in-
les.

r. Give each file the name of the 
ar. Select “Pre-split for Multiple 
lder (see “Add Proxy” on page 
Chapter 3     Media

This can all be avoided by splitting the imag
prior to compression. Most applications all
desired rectangle. In some cases, you can e
the individual movie files in one go.

As an example, assume that you have two 
30% overlap, and want to display a movie
would appear as in the illustration to the le

◆ NOTE: These figures are only chosen as
computers would be able to play such a

Include the overlap in the split, since the por
have to play on both displays. Likewise, if t
will have to factor in any gap between the e
fying a corresponding gap when making th

Most applications specify cropping relative 
that the bottom and right edges need to be 
width of the original (large) image.

▲ IMPORTANT: When splitting a large mo
avoid using a compressed movie as the
an additional de-compression/re-comp
ity. Thus, whenever possible, start out w
dividual, computer-generated, image fi

Save the resulting files into a separate folde
WATCHOUT display on which it will appe
Displays” and link the Video Proxy to the fo
128).

A 1200 x 480 movie to be pre-split 
across two overlapping 800 by 
600 display areas.

Crop right 
by 480 
pixels.

Crop left 
by 480 
pixels.



be After Effects:
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This is how you would split a movie using Ado

Crop the resulting movie as 
required on each side.
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t’s very similar to moving images. 
T and place its icon on the display 
 sound file to play.

n so that it straddles multiple 
e same sound file to play from 
ound file play from a computer that 
 places an unnecessary processing 

 file that can be played using 
mmended sound file format is 
ompressed sound file format, such 
 step adds unnecessary load. The 
 not an issue with the kind of 
presentations.

audio using a suitable sound card 
e saved as WAV files using the 
e applications capable of saving 
Nuendo, Digidesign ProTools and 

ulti-channel WAV files from a 
xample the “CDP Multi-Channel 

ls.html
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AUDIO Audio is used in WATCHOUT in a way tha
Simply bring the sound file into WATCHOU
in the Stage window where you want to the

◆ NOTE: Do not place the sound file’s ico
displays, unless you specifically want th
multiple display computers. Having the s
isn’t really used for sound reproduction
load on that computer.

Audio File Formats WATCHOUT can generally play any sound
Windows Media Player. However, the reco
WAV. There’s usually no reason to use a c
as MP3, and the additional decompression
size of uncompressed sound files is usually
computers used to play back WATCHOUT 

Multi-Channel Audio WATCHOUT can play back multi-channel 
(see page 20). Multi-channel sound files ar
“Wave Format Extensible” file format. Som
multi-channel WAV files include Steinberg 
Adobe Audition. 

Free tools are also available for creating m
number of single-channel WAV files. For e
ToolKit”, found here:

http://www.cs.bath.ac.uk/~rwd/mctoo

http://www.cs.bath.ac.uk/~rwd/mctools.html


rack in addition to the video. In 
splay computer(s) as the video 
 out of the movie and place it in 
edia files: one containing the 
ace them separately in 
y computer. You’ll need two 
at the same time.

 compatible video editing soft-
uickTime movie into two sepa-

mposite movie and choose 
u. Select the sound track and 
o its own movie, which you can 
ort command on the File menu.

mpatible, you may not be able 
 file using a video editing appli-
io into a separate track, which 

und as separate cues. You can 
window, allowing the sound 
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Using Embedded Audio Some video and movie files contain an audio t
this case, the sound will play from the same di
does. If you don’t want this, cut the sound track
a file of its own, thereby ending up with two m
video and one the audio. This allows you to pl
WATCHOUT, making the sound play from an
separate cues along the timeline to start them 

You can use QuickTime Pro or any QuickTime
ware to split the audio and video tracks of a Q
rate movies. In QuickTime Player, open the co
“Show Movie Properties” on the Window men
click “Extract”. This extracts the sound track int
then save as an AIFF or WAV file using the Exp

◆ NOTE: If your video file is not QuickTime co
to extract the audio from it. Try opening the
cation, which may allow you to extract aud
can then be exported.

In WATCHOUT, add both the video and the so
now position them independently in the Stage 
track to play through any display computer.
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entation. This is particularly useful 
ows you to bring an image of the 
 to play video from tape or other 
ideo originating from satellite links 

ecting the video source directly to 
ve video. This minimizes the delay 
 support applications – while maxi-
 the video signal. See “Live Video 

the live video image like any other 
ly add the live video object to the 
or Timeline from there. See “Add 

n your presentation, you can also 
n a computer's screen. This can be 
ides, a Web browser, or similar 
ntation.

er’s screen is sent continuously via 
mputers, where WATCHOUT 
le, you can put a plain Powerpoint 
on background, thereby enhancing 
abilities of WATCHOUT.

e VNC server software installed 
” on page 22 for more details. 
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LIVE VIDEO Live video can be integrated into your pres
in speaker support applications, since it all
speaker onto the screen. It can also be used
external video playback devices, or to use v
or video conference feeds.

Video is brought into WATCHOUT by conn
each display computer that will show the li
in the video signal – important for speaker
mizing the quality by avoiding compressing
Input” on page 194 for more details.

From a production viewpoint, you can use 
still image or video played from disk. Simp
Media window and drag it onto the Stage 
Live Video” on page 133 for more details.

COMPUTER SCREEN Just like you can display a live video feed i
incorporate a live image of what appears o
used to show Excel graphics, Powerpoint sl
software applications, as part of your prese

The image displayed on the source comput
the network to the WATCHOUT display co
composites it with other media. For examp
presentation on top of a large, high-resoluti
it with all the high-quality presentation cap

The computer to supply the image must hav
and configured. See “VNC Server Software



ve computer image just like any 
bject to the Media window and 
ee “Add Computer Screen” on 

ove provides excellent image 
equire a fast computer for 
ay not provide full frame rate, 
ter somewhat, since it has to 

n being displayed (for example, 

B capture card to bring the 
sentially identical to the “Live 
quires a different capture card 
 of a video camera. 

tapath VisionRGB:

rds.html

 be used with a DVI-to-HDMI 
 to use an HDMI capture card 
 Input” on page 194).
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From a production point of view, you use the li
other image. Simply add a Computer Screen o
drag it onto the Stage or Timeline from there. S
page 131 for more details.

Using an RGB Capture Card Although the VNC-based solution discussed ab
quality at virtually no additional cost, it does r
running the VNC server software. Even so, it m
and may impair the performance of the compu
handle both the VNC server and the applicatio
Powerpoint). 

As an alternative, you may instead use an RG
computer into WATCHOUT. This solution is es
Video” input, described above. However, it re
that can be connected to the computer instead

An example of an RGB capture card is the Da

http://www.datapath.co.uk/rgbcaptureca

Some computers have an HDMI output, or can
adaptor cable, in which case you may be able
for computer display purposes (see “Live Video

An RGB capture card.

http://www.datapath.co.uk/rgbcapturecards.html
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4

d to produce a presentation using 
ady produced the source media 

e display areas and provides a 
ages that appear inside a display 

arranging displays side by side or 
iple displays.

ose “Add Display” on the Stage 
 standard display sizes. Once a 
nd other settings through its Speci-
tions” on page 144).

licking it with the mouse so it shows 
it menu.

ge menu, you can not add or 

ey do, images that span multiple 
 edges. Alternatively, displays can 

 gap between them, for a videowall 
e window according to the actual 
Chapter 4     Production

4 PRODUCTION

This chapter goes through the steps require
WATCHOUT. It assumes that you have alre
files, as described in the previous chapter.

STAGE The Stage window allows you to arrange th
preview of your presentation. Portions of im
will be shown by that physical display. By 
vertically, you can make images span mult

Adding and Removing Displays To add a display to the Stage window, cho
menu. This menu item provides a choice of
display has been added, set its IP address a
fications dialog box (see “Display Specifica

To remove a display, select the display by c
a bold outline, then choose Clear on the Ed

◆ NOTE: If “Online” is selected on the Sta
manipulate any displays.

Arranging Displays Displays may overlap each other. When th
displays will be automatically blended at the
be positioned edge-to-edge, or with a small
look. By positioning the displays in the Stag



 image areas, images that span 

heir desired positions using the 
merically by selecting a display 
 Type in the desired position, in 
tage (see “Display 

d in order to manipulate the 
its title bar. You can not select 
dow, as this is used to select and 
e. If the “Online” item on the 
, change or delete displays.
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arrangement and separation of the monitors or
multiple display areas will line up properly. 

To arrange the displays, simply drag them to t
mouse. Alternatively, you can position them nu
and choosing Specifications on the Edit menu.
pixels, relative to the upper left corner of the S
Specifications” on page 144).

◆ NOTES: The Stage window must be selecte
displays. To select the Stage window, click 
the Stage window by clicking inside the win
move images when the window is not activ
Stage menu is activated, you can not select

Displays deliberately set apart to 
account for the mullion on LCD or 
plasma screens.

Overlapping displays using 
projectors.
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, such as multiple display areas or 
art of the stage, use Stage Tiers to 

 images as well as sound. These 
s, with only minor differences 
” for more details.

 “Add Media File…” on the Media 
desired position in the Timeline or 

 the folder where it is stored, or 
HOUT Media window.
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Complex Display Arrangements If you have complex display arrangements
different sets of display showing the same p
keep them apart. See “Tier” on page 123.

MEDIA The term “media” refers to moving and still
media types are treated in very similar way
where appropriate. See Chapter 3 “Media

Adding Media To add media to your presentation, choose
menu, or simply drag the media file to the 
Stage window. Media can be dragged from
you can drag media items from the WATC

Media file dragged 
into timeline…

…appears as a cue in the time-
line as well as being displayed 
in the Stage window.



dia files in a sub-folder of the 
e. This allows WATCHOUT to 
ove the show elsewhere.

application, double-click its 
-click an associated cue in the 
ted with a cue, double-click the 

Refresh” on the Media menu to 
“Update” on the Stage menu to 
es as well.

 have added many media items 
 media references persist in the 
ctually use them. To remove 
hoose “Select Unused” on the 
u (see page 137).

sed entries from the Media 
ur hard disk.

y want to keep both the old and 
change your mind. In this case, 
s with different names. To 

window and a file, double-click 
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▲ IMPORTANT: Whenever possible, store me
folder containing the WATCHOUT show fil
use relative file paths, making it easier to m

Editing a Media File To open a media file in its designated editing 
thumbnail in the Media window, or Alt-double
Timeline. To track down the media item associa
cue and click “Locate Media”.

Refreshing Media Information After making changes to media files, choose “
load those changes into WATCHOUT. Choose 
update the display computers with these chang

Purging Unused Media After working with a show for a while, you may
that are not included in the final version. These
Media window, regardless whether any cues a
such unused media from the Media window, c
Media menu and then “Clear” on the Edit men

◆ NOTE: This operation will only remove unu
window. It will not remove any files from yo

Changing the File Association of a 
Media List Item

Sometimes, when editing a media file, you ma
the new version of the file around, in case you 
you end up with two or more similar media file
change the link between an item in the Media 
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ose another file. This will affect all 

 file of the same kind. You can not 
ile, for example.

in your presentation but can not 
appen in the following cases:

roduction computer, but you know 
ters. Perhaps the media requires a 
uter, possibly using dedicated 

 production computer.

een pre-split into multiple files (see 
).

 may for other reasons need to be 
isplay computer at a later time.

f these cases. Once a media proxy 
 used on the timeline just like other 
8 for more details.
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the file name in the Media window and cho
cues that use this media list item.

◆ NOTE: You can only relink it to another
change from an image file to a sound f

Using Media Proxies Occasionally, you may want to use media 
import it simply by dragging. This would h

• The media file isn’t recognized by the p
it can be handled by the display compu
specialized codec in the playback comp
hardware, which is not available in the

• The media file is a large movie that has b
“Pre-splitting Large Movies” on page 44

• The media may not yet be available, or
provided or replaced manually on the d

Use a media proxy to accommodate any o
has been added to the media list, it can be
media items. See “Add Proxy” on page 12



l relation of cues and effects, as 
es control the display and 
 control various aspects of the 

indow can be controlled using 
ncrease the precision by which 
r zoom out to get a better over-
to change the scale gradually. 
ehavior of the timeline or its 
0 for more details

f media cues, such as position 
 currently selected cue appear 
e tween pane. See “Tween 

an toggle between the cue and 

edia onto the timeline and drop 
wn on page 53. Cues can be 

ing relationship. Select multiple 
d dragging diagonally, starting 

me layer. Doing so may cause 
ant images to overlap in time, 
verlapping cues are indicated 
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TIMELINE The Main Timeline window shows the tempora
well as the layering of overlapping media. Cu
presentation of media, and use tween tracks to
media.

The amount of time displayed in the timeline w
the button in the lower left corner. Zoom in to i
you can position cues and set their duration, o
view. The center part of the button allows you 
Changing the time scale has no effect on the b
cues. See “Main Timeline Window” on page 9

Tween tracks are used to animate properties o
and opacity, over time. The tween tracks of the
at the bottom of the timeline window, called th
Tracks” on page 161 for more details.

◆ HINT: When tween tracks are visible, you c
tween panes using the Tab key. 

Adding Media Cues To add a media cue to the timeline, drag the m
it at the desired layer and time position, as sho
dragged along the timeline to change their tim
cues by Shift-clicking the cues, or by clicking an
from a point where there are no cues.

◆ IMPORTANT: Do not overlap cues on the sa
images to display incorrectly. When you w
always put their cues on separate layers. O
by a red warning line above the cues.

Zoom button, cue area and tween 
pane.
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o appears in the upper left corner 
. To make the image appear else-
ge window, or double-click the cue 

 images, hold down the Control key 
image one pixel at a time. Add the 

 images move, the current position 
een track’s header area. Click the 

w, it may be obscured by a larger 
e by clicking the yellow sun icon in 
view” on page 92).

e window is selected before 
ge window.
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Positioning Media on Stage When media is added to the timeline, it als
of the top/left display in the Stage window
where, drag the image’s preview in the Sta
to set the position numerically. 

◆ HINT: For precise positioning of selected
and press the Arrow keys to nudge the 
Shift key to move ten pixels at a time.

When using a Position tween track to make
of the image is shown numerically in the tw
triangle to reveal the numeric position.

If the image isn’t visible in the Stage windo
image in front. You can hide the large imag
its layer title area (see “Disabling Layer Pre

▲ IMPORTANT: Make sure that the timelin
attempting to drag the image in the Sta

Drag image in Stage window.

Stage position of the image.



llow you to control the stacking 
 an image towards the front, 
r. To move the cue without 
hile dragging. Use the 
ove layers.

e by dragging new media onto 
that cue only, while retaining all 

lex move or other effect using 
e to re-use, then replace its 
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Layering Media The horizontal layers in the timeline window a
order of images in the Stage window. To move
drag its cue up to a layer with a higher numbe
changing its time position, press the Shift key w
commands on the Timeline menu to add or rem

Changing the Media Association 
of a Cue

You can change the media association of a cu
the cue. This changes the media association of 
other relevant properties.

◆ HINT: This can be used to duplicate a comp
different media. First make a copy of the cu
media association as described above.

Click triangle to expand the layer 
to see the entire cue.

Drag to move the partition between 
the cue pane and the tween pane.

Drag to resize the tween track.
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e duration of the cue is set to the 
s to the timeline, the duration is set 

selecting the cue and dragging the 
. 

their tween points will, by default, 
line. To make the tween tracks 
he Alt key while dragging the bar.

ortening the cue. Increasing the 
he media will make a video stop at 
8 for more options.

age cue changes the starting time 
 the in-time of the movie. To change 
ange its “In-Time” value.

 align objects in time. Cues snap to 
ween points in the same cue. Cues 
ime position.

 time, first position the current time 
 Time” on the Timeline menu (see 
t time indicator as a ruler for 

 the Timeline window, you can also 
Cue Specifications dialog box. 
 the Edit menu, or simply double-
age 156 for more details.
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Changing a Cue’s Duration When adding moving images or sound, th
duration of the file. When adding still image
to a default value. Change the duration by 
vertical bar located at either end of the cue

◆ NOTE: If the cue has any tween tracks, 
remain stationary in relation to the time
contract or expand with the cue, press t

A video or sound file can be cut short by sh
cue’s duration beyond the actual length of t
its last frame. See also “Loop” on page 15

◆ NOTE: Dragging the start of a moving im
along the timeline only. It does not affect
the in-time, double click the cue and ch

Aligning Cues in Time Use the Snap command on the Edit menu to
adjacent cues. Tween points snap to other t
and tween points also snap to the current t

◆ HINT: To line up a number of objects in
indicator then de-select “Click Jumps to
page 138). You can now use the curren
aligning cues and tween points.

Cue Specifications In addition to direct manipulation of cues in
set most parameters numerically using the 
Select the cue and choose Specifications on
click the cue. See “Cue Specifications” on p



ontrol cues to the timeline by 
enu. When reached during 

e timeline to halt. This is useful 

e with the start of another cue, 
. If you don’t do this, the Control 
u may want to dedicate a layer 

managing the flow of your 
pport or other situations where 
involved. For more details, see 
trol Cue” on page 171.
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Using Control Cues In addition to media cues, you can also add c
choosing “Add Control Cue” on the Timeline m
playback, a Control cue set to Pause causes th
when cueing a presentation manually.

◆ NOTE: If you want a Control cue to coincid
then put the Control cue on a separate layer
cue may be hidden behind the other cue. Yo
for control cues only.

Control cues provide many other functions for 
presentation. This is often useful for speaker su
live elements or other forms of interaction are 
“Looping and Jumping” on page 71 and “Con

Adding a Control cue to the 
current layer of the timeline.
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 dynamically throughout the cue. 
n track to make an image fade in 
 the volume of a sound or movie 

en chose the desired type of tween 
 a tween track by de-selecting it on 

 in the tween pane at the bottom of 
see more tween tracks. Likewise, 
to see more details.
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TWEEN TRACKS Tween tracks control the behavior of media
For instance, you can use an Opacity twee
and out, or a Volume tween track to reduce
file.

Adding and Removing a Tween 
Track

To add a tween track, first select the cue th
track on the Tween menu. Likewise, remove
the Tween menu.

The tween tracks of the selected cue appear
the Timeline window. Drag the partition to 
you can adjust the height of a tween track 

Drag this partition to enlarge the 
tween pane.

Tween pane.



itself unless you use it to change 
done by adding and adjusting 
en points provide values acting 

urve in the tween track where 
alue of a tween point, drag it 
ge the tween track by dragging 
ultiple tween points to move 
g to constrain the movement of 

gged past their neighbors. To 
 dragging.

r by dragging from a position 
ints can then be edited using 
 to move complex tween tracks 
d pasting the tween points.

ng its end, you have the option 
t time positions or making them 
 was a rubber band. Press the 
 effect.

 points: corners and smooth 

 method to create smooth 
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Adding Points Adding a tween track to a cue has no effect in 
the value governed by the tween track. This is 
tween points along the tween track. These twe
as key-frames along the cue’s tween track.

To add a tween point, click anywhere on the c
there isn’t already a tween point. To edit the v
using the mouse. For better precision, first enlar
the partition between the tween tracks. Select m
them together. Press the Shift key while draggin
the tween points.

◆ NOTE: Normally, tween points can’t be dra
relax this constraint, press the Alt key while

Removing, Cutting and Pasting 
Tween Points

Select multiple tween points by Shift-clicking, o
outside all tween points. The selected tween po
commands on the Edit menu. This makes it easy
from one cue to another, by simply copying an

Stretching Tween Tracks When changing the length of a cue by draggi
of either leaving its tween points at their curren
expand and contract with the cue, as if the cue
Alt key during the drag to get the rubber band

Corners and Smooth Tween Points For simple values, there are two kinds of tween
points. 

◆ NOTE: Position tween tracks use a different
motion, as described on page 66.
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ped tween point. A sequence of 
adually, and linearly, between the 
articularly when controlling opacity 

ween point, and is added by 
 the curve by a rubber band. When 
curve, the rubber band stretches, 

lick to open its dialog box. See the 
r “Tween Tracks” on page 161 for 

rnal inputs. Those are indicated by 
e tween track. See “Controlling 
ils.
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A corner is represented by a diamond-sha
corner points causes the value to change gr
points. Often, this is the desired behavior, p
or volume.

A smooth point is represented by a round t
Control-clicking. It acts as a pin attached to
you move the smooth point away from the 
causing the curve to bend. 

Editing Tween Points Numerically To edit a tween point numerically, double-c
description of each type of tween track unde
more details.

External Control of Tween Tracks Some tween tracks can be controlled by exte
a round formula button under the title of th
Tween Tracks” on page 176 for more deta

Add a corner point by clicking the 
curve.

Add a smooth tween point by 
Control-clicking.



nd out, or to make objects semi-
another, you only need to fade 
 need to do anything to the 
e front image.

 image contains transparent or 
 visible (see “Transparency” on 
ade out the image below to 

and moving images. See 

e of sounds and movies 
ral sounds simultaneously, and 
ile fading out the other. See 

ages. This is particularly useful 
ut can also be used as an effect 
 dragging the tween point, you 
ng handle. This appears in the 
 Scale tween track. Press Shift 
 the image.

an flip or mirror the image.
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OPACITY Use an opacity tween track to fade objects in a
transparent. To cross-fade from one image to 
the opacity of the front-most image. You don’t
image behind it, as this will be obscured by th

There is one exception to the above rule. If the
semi-transparent areas, the back image will be
page 37). In this case, you may also need to f
perform a smooth cross-fade.

An opacity tween track can be applied to still 
“Opacity” on page 162 for more details.

VOLUME Use a volume tween track to control the volum
containing embedded audio. You can play seve
cross fade between them by fading up one wh
“Volume” on page 162 for more details.

SCALE Use a scale tween track to change the size of im
for playing video material at full screen size, b
for both still and moving images. In addition to
can also adjust the scale by dragging the scali
lower right corner of the image after adding a
while dragging to maintain the aspect ratio of

◆ HINT: By using negative scale values, you c

See “Scale” on page 163 for more details.

Scaling handle.
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le of images, or to make an image 
ing the rotation handle or the rota-
s as well as by number of revolu-
otation” on page 165.

en underneath the anchor point. If 
cribed below, or drag the tween 

point. The anchor point is indicated 
see illustration above). To change 
change the values under “Anchor 
tions” on page 156 and “Anchor 

ging a 
n point.
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ROTATION Use a rotation tween track to control the ang
rotate over time. Rotate the image by dragg
tion tween point. You can rotate by degree
tions (or a combination of the two). See “R

◆ NOTE: The rotation handle may be hidd
so, either move the anchor point as des
point to adjust the angle.

ANCHOR POINT Images scale and rotate around the anchor 
by a white crosshair in the Stage window (
the anchor point, double-click the cue and 
Position within Image”. See “Cue Specifica
Position” on page 160 for more details.

Rotate by dragging 
the rotation handle…

…or by drag
rotation twee

Anchor 
point.



ge on stage, or to make an 
al images on stage, then drag 
 an arrow key while holding 
es one pixel at a time. Press the 

ts.

changed numerically inside the 
ue that has a motion path, the 
mmand on the Edit menu to 

ng their cues (see page 117).

cation at a particular time, first 
sition the image in the Stage 

already existing tween point, 
point before moving the image. 
ead. To ensure that the timeline 
t all tween points, then click the 
cted on the Timeline menu.

 to the motion path in the Stage 
oint to type in the desired stage 
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POSITION Use the position tween track to position an ima
image move along a path. Select one or sever
them in the Stage window. Alternatively, press
down the Control key to move the selected imag
Shift key as well to move in 10 pixel incremen

◆ HINT: The initial stage position can also be 
cue’s dialog box. If you change this for a c
entire motion path moves. Use the Move co
move multiple images together after selecti

Editing Position Points To make an image arrive at a specific stage lo
add a tween point at the desired time, then po
window as described above. 

◆ NOTE: To change the stage position of an 
make sure the timeline is positioned at that 
If not, a new tween point will be added inst
is positioned at a tween point, first de-selec
tween point with “Click Jumps to Time” sele

Alternatively, drag one of the handles attached
window, or double-click the handle or tween p
position of the image.
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t add a tween point by clicking at 
ack, then drag the image to the 
 indicates the image’s motion path 
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Moving Along a Path To make the image move along a path, firs
the desired time position along the tween tr
desired position in the Stage window. A line
in the Stage window.

Controlling the Speed of Motion Double-click a position tween 
point to change its incoming or 
outgoing speed. A value of 1 
indicates nominal speed, with 
smaller values being slower 
and greater values being 
faster. The speed is indicated 
by the white dots along the 
motion path, with dots spaced 
farther apart indicating faster 
motion.



rner along the motion path. To 
e point and select Smooth. You 
nt independently. Selecting the 
e, controlling the path of motion 
 and drag the direction handle 
th points have been set to move 

m the point increases the curva-
he path’s shape.

g, so that it always points along 
elect “Auto-orient along Motion 
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Moving Along a Curved Path By default, a Position tween point acts as a co
move smoothly through a point, double-click th
can control the incoming and outgoing segme
Smooth option reveals a yellow direction handl
into or out form that point. Close the dialog box
to create a curve. In the illustration below, smoo
the image along an S-shaped curve.

Dragging the direction handle farther away fro
ture. Add tween points for better control over t

◆ HINT: To make an image rotate while movin
the motion path, double-click the cue and s
Path” (see page 160).

Direction handleSpeed handle
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5

TCHOUT presentation from your 
uters, and run the presentation. It 

resentation can be used and 

tion and display computers, 
e display software on each display 
tage menu. This causes the produc-
puters and transfer all required 

 progress bar indicates the transfer 

indicated by an error icon in the 
 the WATCHOUT display software 
ble-check the network configura-
ly (see “Network” on page 18 and 
firm that the IP address of the 
 Display Specifications dialog box 

).

nnecting to the display computers 
ATCHOUT and/or on the display 

 Alt-F4 on the display computer.
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5 PRESENTATION

This chapter tells you how to take your WA
production computer onto the display comp
discusses the various ways in which your p
controlled.

CONNECTING TO THE DISPLAY 
COMPUTERS

After installing and configuring the produc
producing the presentation, and starting th
computer, you can select “Online” on the S
tion computer to connect to the display com
information to them, ready for playback. A
of files to each display computer.

Failure to connect to a display computer is 
Stage window. If you get a error icon, quit
on the offending display computer and dou
tion to ensure that it has been set up proper
“Computer Settings” on page 24). Also con
display computer matches the settings in the
(see “Display Specifications” on page 144

Any further problems encountered after co
will be reported in the Message window in W
computer’s screen.

Quitting the Display Software To quit the display software, press Ctrl-X or

Unable to 
connect to this 
computer.

Progress bar 
shown during 
transfer of files.



eck to make sure that all 
the display computers. 
 required on the individual 
UT will detect this and transfer 

splay computer, a progress bar 
ow, as well as on the display 

ATCHOUT while files are 
urther update or access the 
d.

by deselecting “Online” on the 
urrent file has been transferred.

lay computer will remain there 
 show is stored in a folder with 

ws” folder in the same folder as 

 you may want to clean up the 
sh and emptying the trash 

w. This stops old shows from 

ache” folder, then remember to 
le is used to keep track of what’s 
oblems displaying certain 
 folder and the “CachedFiles” 
next time you open the show.
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Downloading Media Whenever you go online, WATCHOUT will ch
required media files have been transferred to 
WATCHOUT will only transfer the files actually
computer. If you modify a media file, WATCHO
the updated file.

While media files are being transferred to a di
will be shown in that display in the Stage wind
computer itself. You may continue working in W
being transferred, but you will not be able to f
display until the previous update has complete

◆ HINT: You can stop an update in progress 
Stage menu. The transfer will stop once the c

Note that all media files transferred to the disp
until removed manually. The media related to a
the name of the show. This is located in a “Sho
the WATCHOUT display software application.

After using a display computer to run a show,
Shows folder by putting its contents into the tra
before using that computer to run another sho
occupying hard disk space unnecessarily.

◆ NOTE: If you for any reason remove the “C
remove the “CachedFiles” file as well. This fi
in the “Cache” folder. If you experience pr
images, you may try removing the “Cache”
file. WATCHOUT will re-create this file the 

The “Shows” folder contains a folder 
related to each show that has been 
transferred to the display computer.
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line, transfer them to the display 
n the Stage menu. This includes 

 display computers, the 
s will disappear. You are now 
ick the play button in the lower left 
 spacebar.

e by clicking in the time ruler at the 
line Settings” on page 139).

trolled presentations, add Control 
T performs the instructions 

 or jumps to another position along 
n page 71).

o to any location in your presenta-
f the function keys on your 
 “F1”), then press that function key 
e Control Cue” on page 138.

he timeline (see “Add Play / Pause 
ue” on page 171). By combining 
 and the Standby command 
r jump to other sections of the 
Chapter 5     Presentation

Updating the Stage If you make changes to your show while on
computers using the “Update” command o
adding new media or cues.

RUNNING THE PRESENTATION Once all media has been transferred to the
WATCHOUT logo on the display computer
ready to run your presentation. To run it, cl
corner of the Timeline window, or press the

You can jump to any point along the timelin
top of the Timeline window (see also “Time

Manual Control For speaker support, or other manually con
cues to the timeline. When run, WATCHOU
embedded in the cue – for example, pauses
the timeline (see “Looping and Jumping” o

You can also use Control cues to instantly g
tion. Give the cue the same name as one o
computer’s keyboard (for example, name if
to jump straight to it. See “Add Play / Paus

Looping and Jumping Use a Control cue to loop any segment of t
Control Cue” on page 138 and “Control C
this with the QuickFind feature (page 119)
(page 124), you can gracefully exit loops o
presentation. 



ntrol system to remotely control 
resentation environment. Since 

col, it can communicate with 

ut capabilities, WATCHOUT 
eak those industry-standard 

s where personalized or multi-
OUT together with Dataton 
tation, and acts as a remote 

isplay clusters, use the Dataton 
o your Ethernet network. In 
KUP it also controls your 
ed features such as synchro-
nguage selection between 
lling the conditional layers in 
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External Control You can use a touch panel or other external co
your WATCHOUT presentation, as well as the p
WATCHOUT uses the ubiquitous TCP/IP proto
virtually any computer system or device.

Furthermore, using the MIDI and DMX-512 inp
can be controlled using any device that can sp
communications languages.

Personalized or Multi-lingual Audio For museums, visitor centers, and similar place
lingual audio is desired, you can use WATCH
PICKUP. PICKUP plays the audio of the presen
control for starting the presentation.

http://www.dataton.com/pickup/

To integrate PICKUP with your WATCHOUT d
NETWORK TRANSPONDER, which connects t
addition to acting as an IR transponder for PIC
WATCHOUT presentations. It provides advanc
nized audio playback. It can also match the la
PICKUP and WATCHOUT by means of contro
WATCHOUT (see “Condition” on page 93).

DMX512

http://www.dataton.com/pickup/
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ant to integrate WATCHOUT with 
ished by means of external control 
twork.

t the external controller to the 
rt in the Preferences dialog box.

twork protocol, and allows 
 panel or from another computer 
.

Chapter 5     Presentation

EXTERNAL CONTROL For more complex applications, you may w
other control systems. This can be accompl
of your WATCHOUT system through the ne

To control the production computer, connec
network and activate the TCP/IP control po

Network control is based on the TCP/IP ne
WATCHOUT to be controlled from a touch
anywhere on your network (see page 219)

Activates external control through 
the network port on the produc-
tion computer.



tion software, as discussed 
display computers directly. This 
uring playback. Please see 
tails.

 signal for controlling the main 
 uses the LTC format according 
ol either the production 

“Timecode Control of Main 
 (as seen on the previous page). 
be applied. Connect the time-
ion computer. Starting the time-
t the position specified by the 

und input port is selected in the 
 that the input volume is turned 
ctive recording device.

lication (see next page) on the 
ode issues. 

e Status window to view the 
us Window” on page 101.
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Display Cluster Control Instead of controlling the WATCHOUT produc
above, you may choose to control a cluster of 
removes the need for a production computer d
“Display Cluster Protocol” on page 223 for de

TIMECODE CONTROL WATCHOUT can accept a standard timecode
timeline. This timecode synchronization feature
to the EBU or SMPTE standards. You can contr
computer or the display cluster.

Controlling the Production Computer To control the production computer, select the 
Timeline” checkbox under Preferences, Control
Specify the timecode format and any offset to 
code signal to Line In connector of the product
code feed should now start the main timeline a
timecode.

▲ IMPORTANT: Make sure that the correct so
Sound Control Panel shown to the left, and
up, indicated by the green bar next to the a

You can use the separate Timecode Tester app
production computer to troubleshoot any timec

◆ HINT: Add a “Timecode Position” item to th
current timecode being received. See “Stat
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e primary display computer and 
 timecodeMode command, as 

conjunction with the WATCHOUT 
ion software goes online, it tempo-
 cluster.

ster application on the primary 
code reception, quality and signal 
e In connector. Choose the appro-
p-up menu or using the Sound 
ge. This setting remains in effect 
by WATCHOUT.

 Panel to adjust the input level, if 
-wide. Changing it through this 
affect the ability of WATCHOUT to 

not leave it running when starting 
ins its own timecode reader.
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Controlling the Display Cluster Connect the timecode signal to Line In of th
activate timecode synchronization using the
described on page 233.

◆ NOTE: This method can not be used in 
production software. When the product
rarily disables any timecode input to the

Use the separate WATCHOUT Timecode Te
computer in the cluster to verify proper time
level. Connect the timecode signal to the Lin
priate input on the “Sound Mixer Input” po
Control Panel, as shown on the previous pa
after closing the window, and will be used 

◆ HINT: Use the Windows Sound Control
required. Note that this setting is system
control panel or other applications may 
read timecode.

Quit the Timecode Tester after using it. Do 
WATCHOUT display software, which conta

The WATCHOUT Timecode 
Tester application, used to 
troubleshoot timecode problems.
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S 6

 cues together on their own sub-
elines similar to how you can play 

use or re-arrange show sections or 
ly the same effect to a group of 
 scale a set of images together.

ements, such as still images and 
m where you can drag it onto any 
n any number of times – you can 
on at the same time.

 duration and may contain motion. 
n WATCHOUT, there’s no 
changing it. A composition can be 
 to create motion of indefinite dura-

me to a video clip, and then make 
 scaling it up at the same time. 
motion and the scaling to the video 
 hard to make the two move 
n add both elements to a composi-
ng to the individual elements. Then 
 timeline, applying the motion and 
Chapter 6     Using Compositions

6 USING COMPOSITION

A composition allows you to group a set of
timeline. This can then be used from other tim
a video. A composition makes it easy to re-
short snippets. It also makes it easier to app
media elements – for instance, to move and

A composition behaves like other media el
video clips. It lives in the Media window, fro
timeline to use it. You can use a compositio
even play multiple instances of a compositi

Similar to a video clip, a composition has a
However, as a composition is created withi
rendering time or other delays involved in 
looped and/or free running, making it easy
tion within WATCHOUT.

A Basic Example For example, assume you want to add a fra
the video clip move across the screen while
Although you could do this by applying the 
and the frame image individually, it’s often
together in a cohesive way. Instead, you ca
tion without applying any motion and scali
use the resulting composition from the main
scaling to the composition as a whole.



edia menu. Give the composi-
“Reference Frame” field. In this 
ame just slightly larger than the 
nce frame will be used later 
e from the main timeline. See 
tails.
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CREATING A COMPOSITION Start by choosing “Add Composition” on the M
tion a name, and type a suitable size into the 
case, it is a good idea to make the reference fr
still image frame around the video. This refere
when manipulating the composition as a whol
“Add Composition” on page 131 for more de

Moving and scaling a video 
together with a surrounding still 
image frame.
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y double-clicking the newly added 

 changes when the composition 
isplay rectangles, it now shows the 
editing a composition, its preview 
replacing the preview of the 
usual state, select the main timeline 

or any other composition setting, 
menu while the composition’s 
Chapter 6     Using Compositions

Open the composition’s timeline window b
composition item in the Media window.

Notice that the content of the Stage window
window appears. Instead of showing the d
reference frame of the composition. While 
appears in the Stage window, temporarily 
displays. To restore the Stage window to its 
window.

To change the size of the reference frame, 
choose “Timeline Settings” on the Timeline 
window is active.

The timeline window of a new 
composition.



y as you do to other timelines. 
image frame on top. Drag those 
review will appear in the Stage 

tion, close its timeline window. 
review mode.
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ADDING CUES You add cues to a composition in the same wa
In this example, we will add a video with a still 
images onto the composition’s timeline. Their p
window.

When you’ve added the media to the composi
This restores the Stage window to its normal p

Composition preview mode.

Stage window content temporarily 
replaced to show a preview of the 
composition.

This rectangle represents the 
composition’s reference frame.

Media added to the composition’s 
timeline.
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a whole, simply drag it from the 

 window from the Main Timeline, 
ion cue.
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USING THE COMPOSITION To use your newly created composition as 
Media window onto the main timeline.

◆ HINT: To open a composition’s timeline
press Alt then double-click the composit

Drag a composition from the Media 
window onto the Main Timeline.

The yellow selection rectangle 
around the composition corre-
sponds to its reference frame.

A composition cue appears on the 
Main Timeline.

Add tween tracks to move and scale 
the entire composition.



ositions. This can be applied in 
tions one step at a time. This 
r as a composition, starting by 
s.
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NESTING COMPOSITIONS A composition may be used inside other comp
a hierarchical fashion to build complex anima
example shows how to build a four cylinder ca
creating a single cylinder from still image part

Still image components.

Preview of the PistonLoop 
composition.

Composition timeline to make one 
full revolution of the engine.

◆ NOTE: Select “Lock Duration” in 
the “Timeline Settings” dialog box 
of the composition, and set its 
duration to one second (see “Lock 
Duration” on page 141).
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works as desired, go ahead and 
 it “Four Cylinders”. Add four 
ion by dragging them from the 
meline window.

gine revolution only, you need to 
ur Cylinders” timeline to loop. This 

e specifications dialog box, shown 

ut one minute to give enough 
Chapter 6     Using Compositions

Once the single “Piston Loop” composition 
create the next, outer composition, naming
copies of the “Piston Loop” to this composit
Media Window into the “Four Cylinders” ti

Since the “Piston Loop” contains a single en
set each of the “Piston Loop” cues on the “Fo
behavior is selected in the Composition Cu
by double-clicking the cues.

Drag out the tail end of all four cues to abo
running time to play with at the next level.

Add four instances of the “Piston 
Loop” composition. Scale down all 
but the frontmost instance by incre-
ments of 10% each, and offset their 
positions as shown.

Stage window preview of the 
resulting “Four Cylinders” 
composition.



reate the next outer level. This 
ar. While we could have done 

et another composition makes it 
ch as driving it off stage.

rom the Media window onto the 
ke the car (including its engine) 

hown above, is included on the 
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Once the complete engine works as desired, c
level puts the complete cylinder engine into a c
this last step on the main timeline, doing it as y
easier to do things with the car as a whole, su

Finally, drag the “Car w Engine” composition f
main timeline. Add a Position tween track to ma
drive off the stage after a while.

◆ NOTE: The complete engine animation, as s
WATCHOUT DVD-ROM disk.

Create a “Car w Engine” 
composition.

Add a cue for the “Four Cylinders” 
sub-composition.

Fade up an image of a car.

Use Position and Scale tween tracks 
to put the engine into the car.
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7
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7 WINDOWS

Stage window, 
showing the display 
areas and a preview of 
the presentation.

Main Timeline window, 
showing the layers, cues 
and tween tracks.

Media window, listing 
all media used in your 
presentation.

Other windows are 
described later in this 
chapter.



top window, with a menu bar 
op window by dragging any of 
mize it using the buttons in the 
uivalent to choosing Quit on the 

 title bar. Resize a window by 
inimize and maximize a 

rner. 

w menu. Hence, if you acciden-
ee “Window Menu” on 
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Manipulating Windows All WATCHOUT windows reside inside a desk
running along its top. You can resize the deskt
its outer borders or corners. Minimize or maxi
upper right corner. Clicking the close box is eq
File menu.

Move a WATCHOUT window by dragging its
dragging any of its corners or outer borders. M
window using the buttons in the upper right co

Opening Windows Most windows are opened through the Windo
tally close a window, look here to re-open it. S
page 142.

Minimize, maximize or close the 
WATCHOUT desktop.

Use the Window menu to open 
most windows.

Minimize, maximize or close the 
window.

Drag border or corner to resize.

Minimized windows. 
Click to restore.
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nge the display areas used in the 
your presentation as you move 
media on stage.

se Add Display on the Stage menu. 
age 51 as well as “Displays” on 

es using the Scale command on the 
ively set the scale by clicking in the 
trol key. This displays a magnifying 
ed location. Drag with the magni-
trol-Shift-Click to zoom out.

ng it to the desired location in the 
e added to the timeline window at 
n. To remove the media from the 
ue from the timeline.

Control-Alt-drag to 
scroll the window using 
the hand cursor.
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STAGE WINDOW The Stage window is used to add and arra
presentation. It also provides a preview of 
along the timeline, and lets you to position 

Adding Displays To add a display to the Stage window, choo
See “Adding and Removing Displays” on p
page 143 for more details.

Setting the Stage Scale Set the viewing scale for displays and imag
Stage menu. Alternatively, you can interact
Stage window while holding down the Con
glass that allows you to zoom in at the click
fying glass to zoom to a specific area. Con

Adding Media Add media to your presentation by draggi
Stage window. A corresponding cue will b
the currently selected layer and time positio
stage window, remove the corresponding c

On/Off line indicator, corre-
sponding to the “Online” 
Stage menu item.

Displays added to the Stage 
window.

Selected display.



ts preview in the Stage window. 
 drag the image in the Stage 
ve. See “Positioning Media on 
individual Position tween point 
ge Position” on page 159 and 

oint, first click the tween point 
e image. If you don’t go to the 

e added instead.

s to the stage, as described on 
owever, more complex display 

 display layout consisting of a 
ed) projectors, plus one 
 high-resolution plasma display 
sma display could be placed 
detached projection screens on 
used as part of the main show, 
augment the center screen.
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Positioning Media on Stage You can position media on stage by dragging i
To do so, first select the timeline window, then
window. Press the Shift key to constrain the mo
Stage” on page 57. Double-click a Cue or an 
to edit the position numerically (see “Initial Sta
“Position” on page 164).

▲ IMPORTANT: To change a position tween p
to go to its exact time position, then move th
tween point first, a new tween point may b

Using Stage Tiers for Complex 
Display Arrangements

The straightforward method of adding display
the previous page, works fine in most cases. H
arrangements call for a different approach.

Assume, for example, that you want to make a
main area with three overlapping (edge blend
detached projector on either side, and finally a
showing the center part of the screen. This pla
outside the theater, as a preview display. The 
either side of the center area will generally be 
but will occasionally show different images to 

Desired display layout:

Side displays (yellow)

Center area (red, green, blue)

Larger, separate plasma (purple).
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will not work as desired for the 

e three projectors in the center will 
lend all these four displays (over-

dge-blend gradient).

large center area, or on the side 
 on the adjacent display areas. 
 as a single, large canvas, but 
s independently.

g each set of displays on their own 
amed levels on the stage. Edge 
e same tier. Furthermore, timeline 
only, preventing their images from 

d” on the Stage menu (see 
r, first select that tier on the Tier 
 timeline layer with a stage tier, see 
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Merely adding all six displays to the stage 
following reasons:

• The large plasma display overlapping th
cause WATCHOUT to attempt to edge b
lapping displays automatically get an e

• Panning large images sideways on the 
screens, will make those images intrude
That’s OK while using all five projectors
undesirable when using the side display

You can overcome these problems by placin
stage tier. Stage tiers act as independent, n
blending occurs only among displays on th
layers can be associated with specific tiers 
spilling onto displays on other tiers.

To create additional tiers, choose “Tier: Ad
page 123). To add displays to a specific tie
sub-menu of the Stage menu. To associate a
“Stage Tiers” on page 94.

Tier “Main” with the three over-
lapped projectors.

Tier “Sides”.

Tier “Plasma” with the single 
plasma display.



up your presentation. Cues are 
o-front stacking order of images 
mage closer to the front.

ls windows vertically. The scroll 
difier keys in the timeline 

0.1 second increments.

ion in 1 second increments.

ical line through the Timeline 
 Time” mode (see page 138).

Jump button.

Time ruler.

Layer.

Tween pane.

Time scale button.
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MAIN TIMELINE WINDOW The timeline window holds the cues that make 
arranged along layers, representing the back-t
on stage. Increasing layer numbers move the i

Using the Scroll Wheel By default, the scroll wheel on the mouse scrol
wheel can be combined with the following mo
window:

• Shift: Scrolls the timeline horizontally.

• Control: Moves the current time position in 

• Control+Shift: Moves the current time posit

Time Position Indicator The current time position is indicated by a vert
window. Its color indicates the “Click Jumps to

Current time position and indicator.

Currently selected layer.

Lock layer.

Collapsed layer.

Layer attributes.

Disabled layer preview.

Play button.
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n. To set the time numerically, 
menu. To go to the beginning of a 
 Jumps to Time” selected on the 
n page 138).

 scale button to zoom in and out by 
ys on the numeric keypad has the 
o change the scale gradually.

f the time ruler, to jump to the 
r to jump back to the previous start 

ric keypad has the same effect.

ack. If the stage is online, this also 
acebar is equivalent to clicking the 
ad starts playback, Esc stops play-

isk or the Media window to a time-
for more details on cues.

y selected layer. When pasting an 
nt time and layer. Likewise, when 
indow, a new cue will appear at 

 restore the layer height. Shift-click 
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Setting the Current Time Position Click the time ruler to jump to a time positio
choose “Timeline Settings” on the Timeline 
cue, or to a tween point, click it with “Click
Timeline menu (see “Click Jumps to Time” o

Adjusting the Time Scale Click the magnifying glass areas of the time
a fixed amount. Pressing the ‘+’ and ‘–’ ke
same effect. Drag the center of the button t

The Jump Button Click the jump button, located to the right o
current time position if scrolled out of view, o
time. Pressing the asterisk key on the nume

Starting and Stopping Click the play button to start and stop playb
controls playback on screen. Pressing the sp
play button. Pressing 0 on the numeric keyp
back.

Adding Cues To add a cue, drag media from your hard d
line or the Stage window. See Chapter 10 

Selecting the Current Layer Click a layer’s name to make it the currentl
individual cue, it will be pasted at the curre
adding media by dragging into the Stage w
the currently selected time and layer.

Changing Layer Height Click the collapse triangle to minimize and
to collapse/expand all layers.



using the corresponding 

ow, click the layer preview 
le all layers. Disabling a layer 

window that otherwise would 
 a layer’s preview has no effect 

s on locked layers can’t be 
es to a locked layer.

yer, first select the layer then 

cks the layer.

isables layer preview.

or conditional layers, enter a 
yer condition number here. 
et to zero for a normal 
nconditional) layer.
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Adding and Removing Layers Layers can be added, removed and renamed 
commands on the Timeline menu (page 92).

Disabling Layer Preview To disable the layer preview in the Stage wind
symbol to turn it off. Shift-click to disable/enab
allows you to manipulate images in the Stage 
have been covered by other images. Disabling
on its playback on screen.

Locking a Layer To lock a layer, click the padlock symbol. Cue
selected or changed. Nor can you add new cu

Layer Name and Attributes To change the name or other attributes of a la
choose “Layer Settings” on the Timeline menu.

Layer name.

Images and other media on this 
layer are displayed when in 
Standby mode only.

Lo

D

F
la
S
(u
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symbol in the layer’s header pane. 
 being changed or deleted.

symbol in the layer’s header pane. 
.

r media on this layer will perform 
u to keep, for example, a back-
 time, thereby avoiding going to a 
ode (see “Standby” on page 124).

w media controlled from such 
 the “Preview Standby Layers” 
 Standby Layers” on page 126).

 the Standby command at any time, 
essor and memory resources even 
le standby layers at the same time 

ntent on standby layers. Generally, 
age at a time.

l layer will perform only when that 
og box (see “Enabled Layer Condi-
ep, for example, multiple language 
g the desired language version to 
dition.
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Lock all Cues on this Layer This checkbox is equivalent to the padlock 
Selecting it prevents cues on this layer from

Hide Layer in Stage Window This checkbox is equivalent to the sunshine 
See “Disabling Layer Preview” on page 92

Perform Normal/In Standby By selecting “In Standby”, images and othe
only when in Standby mode. This allows yo
ground image ready to be displayed at any
black screen when activating the standby m

Normally, the Stage window doesn’t previe
standby layers. You can override this using
command on the Stage menu (see “Preview

▲ IMPORTANT: In order to be available to
media on standby layers consume proc
while not in standby. Avoid using multip
or playing video or other heavy-duty co
use only a single, large background im

Condition Media associated with cues on a conditiona
condition is enabled in the Preferences dial
tions” on page 115). This can be used to ke
versions of a show in the same file, allowin
be activated by enabling its associated con



n enabled conditional layers 
 Options” on the Stage menu 
on page 126).

y layer is shown in italics in the 

 this layer to a specific stage tier 
lex Display Arrangements” on 

lick here to restrict cues on this 
yer to specific tiers only…

then select the desired set of 
rs in this list.
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Normally, the Stage window previews media o
only. You can override this using the “Preview
(see “No / All / Enabled Conditional Layers” 

◆ NOTE: The name of a conditional or standb
Timeline window.

Stage Tiers Click the “Stage Tiers” tab to constrain cues on
or set of tiers (see “Using Stage Tiers for Comp
page 88 for an overview of stage tiers).

Normally, cues appear on displays 
on all stage tiers.

◆ NOTE: You must add tiers to the 
Stage window before you can 
assign layers to specific tiers (see 
page 123).

C
la

…
tie
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meline is very similar to the main 

is is indicated by a red Stop button 
it doesn’t contribute to the stage.

d by double-clicking its name in the 
ne by choosing “Timeline Settings” 
y timeline’s window is active.

d Auxiliary Timeline” from the 
sk Window” on page 100). For 
age 186.

 resembles the main timeline 
 its purpose is quite different. Unlike 
s output doesn’t appear directly on 
m another timeline similar to 
 Compositions” for details.

mposition” on the Media menu. A 
a window. To open the timeline 
ame in the Media window. Use the 
ne menu to change the name or 
its reference frame).

s preview will temporarily replace 
. This doesn’t affect the image 
the composition to restore the Stage 
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AUXILIARY TIMELINE WINDOW The window associated with an auxiliary ti
timeline window. The main differences are:

• An auxiliary timeline can be stopped. Th
in its lower left corner. When stopped, 

• The auxiliary timeline’s window is opene
Task window. Name the auxiliary timeli
on the Timeline menu while the auxiliar

To create an auxiliary timeline, choose “Ad
window menu of the Task window (see “Ta
more details, see “Auxiliary Timeline” on p

COMPOSITION WINDOW The window associated with a composition
window in the way it is operated. However,
the main timeline and auxiliary timelines, it
stage. Instead, you use the composition fro
playing a video clip. See Chapter 6 “Using

Create a composition by choosing “Add Co
new composition item appears in the Medi
window of a composition, double-click its n
“Timeline Settings” command on the Timeli
other properties of a composition (such as 

◆ NOTE: When opening a composition, it
the normal content of the Stage window
shown by any display computers. Close 
window.



ve been added to the presen-
 item, along with a description 

information, as appropriate for 

rd disk into the Media window, 
ia menu. Files dragged directly 

atically added to the Media 
presentation will only appear 
 many times it is being used.

m and choosing “Clear” on the 
m the Media window by first 
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MEDIA WINDOW The Media window lists all media items that ha
tation. It provides a thumbnail preview of each
of its name, type, file location, size and other 
each kind of media.

Adding Media Add new media by dragging files from your ha
or by choosing “Add Media File…” on the Med
into the Timeline or Stage windows are autom
window as well. Each media file used in your 
once in the Media window, regardless of how

Removing Media Remove individual media items by selecting the
Edit menu. Remove all unused media items fro

Drag to change column width.

Thumbnail and description of each 
media item.

Double-click thumbnail to open 
media file in its associated 
application.

Double-click name to edit the 
media specification.

Group media items into folders.

Double-click to open 
Composition’s timeline.
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nu. It is not possible to remove 
tion. Removing media list items in 

your computer’s hard disk.

eline window to track down media 
m.

the file is located in or under the 
ed, the path to the file will be rela-
bsolute path, beginning with a ‘/’-

es in a sub-folder of the folder con-
lows the use of relative path names. 
resentation to another folder, disk 

 names may cause problems if the 
moving the presentation.

g file locations, you may move the 
 example, to a folder under the 
n use the Find/Replace command 
dow accordingly. See “Find/

articular media list item by double-
. This will affect all cues associated 
ce a media file with another of the 
Chapter 7     Windows

choosing “Select Unused” on the Media me
media that’s currently in use in the presenta
this way does not affect the files stored on 

◆ HINT: Use the Find command in the Tim
references by the name of the media ite

File Location Indicates the location of each media file. If 
folder in which the presentation itself is sav
tive to this folder. Otherwise, it will be an a
character.

▲ IMPORTANT: If possible, store media fil
taining the presentation file, since this al
Doing so allows you to move the entire p
or computer intact. Using absolute path
specified location is not available after 

◆ HINT: If you change you mind concernin
files to a more appropriate location (for
folder containing the show file), and the
to update the locations in the Media win
Replace” on page 118.

Changing the File Association You can change the file associated with a p
clicking its name and choosing another file
with this media list item. You can only repla
same type.



ion, double-click its thumbnail. 
 in order to view or edit it. 

p properly in order to associate 
tion.

ciated with a cue by Alt-double-

in WATCHOUT accordingly by 
efresh” on page 136 for more 

se “New Folder” on the Media 
media items onto the folder. 
ick the triangle to show or hide 

o relation to folders on your 
y to organize items in the Media 
 the Media window will not 

 disk.

ragged into the Media list (see 
 add a proxy item to the Media 
he Media menu. See “Add 
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Editing the Media File To open a media file in its associated applicat
This provides convenient access to a media file

◆ NOTE: Your computer must have been set u
each file type with the appropriate applica

◆ HINT: You can also open the media file asso
clicking the cue on its timeline.

Refreshing Media Information After editing media files, update the Media list 
choosing “Refresh” on the Media menu. See “R
details.

Grouping Media Items into Folders Media items can be arranged into groups. Cho
menu to create a folder then drag the desired 
Double-click the folder’s name to change it. Cl
the content of the folder.

◆ NOTE: Folders in the media window have n
computer’s hard disk. They are merely a wa
window. Creating or removing folders from
create or remove any folders on your hard

Adding a Media Proxy In some cases, media files can not simply be d
page 55 for some examples). Instead, you can
window using the “Add Proxy” command on t
Proxy” on page 128 for more details.
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able for use in expressions. Expres-
eters and to trigger tasks. 

e page 173. For more on Expres-

ou to control external devices using 
e output onto a timeline. See 
Chapter 7     Windows

INPUT WINDOW The Input Window lists external inputs avail
sions are used to control tween track param

For details on the various kinds of inputs se
sions, see page 188.

OUTPUT WINDOW The Output Window lists outputs allowing y
cues. To create a cue for an output, drag th
“Outputs” on page 179 for more details.

Click to add more inputs.

Name and description of each 
input.

Current input value.

Drag to simulate a change in 
value.

Click to add more outputs.

Name and description of each 
output.

Current output value.

Drag to change the value 
manually.



s of your presentation, along 

lumn. An auxiliary timeline can 
 two buttons (see illustration 
 on the stage..

of the following events:

symbol in the Task list.

ession (see page 188).

t to target the auxiliary timeline.

age 186 and “Control Cue” on 

 of the main timeline on stage. 
t the same time, their front-to-
heir order in the Task window. 

Click to add more tasks.

Task’s triggering expression.

Timeline’s time position.

Drag tasks vertically in list to 
re-arrange their front-to-back 
ordering on stage.
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TASK WINDOW The Task window lists all the auxiliary timeline
with their status and triggering expression.

The status of each task is shown in the Status co
be in either of three states, as indicated by the
above). While stopped, its cues have no effect

An auxiliary timeline can be started by either 

• Manually, for instance by clicking the Play 

• By external inputs, using its triggering expr

• By another timeline, using a Control cue se

For more details see “Auxiliary Timeline” on p
page 171.

Changing the Stacking Order An auxiliary timeline always performs in front
When multiple auxiliary timelines are active a
back stacking order is typically controlled by t

Double-click to open the timeline.

Paused timeline.

Playing timeline.

Stopped timeline.



101

ront, drag it towards the top of the 

 in the Timeline Settings dialog box 
hoose that it always starts out as 
e Task window (see “Auxiliary 

able set of status items that can be 

 the Status window then change its 
). To remove a status item, select it 
 Edit menu.
Chapter 7     Windows

To move an auxiliary timeline closer to the f
Task window.

◆ NOTE: This behavior can be overridden
of an auxiliary timeline. Here you can c
frontmost, regardless of its position in th
Timeline Settings” on page 139).

STATUS WINDOW The status window provides a user-configur
sized as desired. 

To configure a status item, double-click it in
settings (such as color and other properties
with the mouse then choose “Clear” on the

Click to add status items.

Double-click an item to change its 
settings, such as color.

Drag divider to re-size the item.



 you by WATCHOUT. Such 
oftware or from the display 
tive while others indicate errors 

matically when a message is 
the side instead of closing it.

ift-clicking or by choosing 
ear” on the Edit menu.
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MESSAGE WINDOW The Message window lists the messages sent to
messages may originate from the production s
computers. Some messages are merely informa
requiring your attention.

◆ NOTE: The Message window appears auto
posted. To avoid this, move the window to 

Removing Messages To remove messages, select them (either by Sh
“Select All” on the Edit menu) then choose “Cl

An error message from a media list 
item telling you that it can’t find its 
associated media file.

An information message reporting 
the result of the Refresh command.
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anager” command on the Window 
 license keys. This list is stored as a 
 application on the production 

 WATCHOUT license key.

y this license key.

ve not yet been stored in their 
nect the key with the specified 
s”. When successfully stored in the 

 the Pending to the Version column.

which had this key connected. This 
ctly to the production computer.

production computer and (option-
ound will be added/updated in the 
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LICENSE WINDOW This window is opened using the “License M
menu. It displays a list of your WATCHOUT
file in the same folder as your WATCHOUT
computer.

License A unique license number stored inside each

Version The version(s) of WATCHOUT supported b

Pending Shows upgrades you have acquired that ha
license keys. To update the license key, con
license number and press “Scan License Key
key, the version number is transferred from

Location The address of the latest display computer 
field is empty if the key was connected dire

Scan License Keys Searches for license keys connected to the 
ally) any on-line display computers. Those f

Supported WATCHOUT versions.

Acquired update not yet stored into 
the license key.

Where this license key was last 
encountered.



ding upgrade, this will be trans-
o the Version column.

 on-line display computers will 
ense keys.

the clipboard as text. This infor-
 license keys (see “Upgrading 
 can copy the information from 
 those in the list (Control or 

osing Copy on the Edit menu.

ys either to the production 
en click “Scan License Keys”. 

ng them and choosing Clear on 
104 Chapter 7     Windows

list. If any key found during the scan has a pen
ferred to the key and the entry will be moved t

Scan Online Displays Too Controls whether license keys connected to any
be included when looking for or upgrading lic

Copy All as Text Selects all licenses and copies their content to 
mation is needed when ordering upgrades for
your Licenses” on page 105). Alternatively, you
specific license keys only by manually selecting
Shift-click to select multiple keys) and then cho

Adding and Removing Licenses Add new licenses by connecting the license ke
computer or to any online display computer, th
Licenses can be removed from the list by selecti
the Edit menu.
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 is introduced, old license keys must 
n. This section outlines the proce-

uire license key upgrades. Minor 
 to version 4.1) do not require an 

u want to upgrade are listed in the 
e outlined on the preceding pages 

to a license key with that specific li-
sted match those to be upgraded.

list, click “Copy All as Text” to copy 
ternatively, manually select the 
 on the Edit menu.

r from your Dataton reseller or 
er your upgrade through your 
ller including your ordering infor-
icense keys in the previous step. 
tails.

 to

ber of upgrades to order. Provide 
nager when prompted to do so. 
will receive an e-mail with your 
Chapter 7     Windows

Upgrading your Licenses When a major new version of WATCHOUT
be upgraded in order to use the new versio
dure used to upgrade license keys.

◆ NOTE: Only major version changes req
changes (for example, from version 4.0
upgrade.

Obtaining the Information Start by making sure that all the licenses yo
License window. If not, follow the procedur
for adding your licenses to the list.

▲ IMPORTANT: An upgrade applies only 
cense number. Make sure the licenses li

Once all licenses to upgrade appear in the 
the license information to the clipboard. Al
licenses to be upgraded, then choose Copy

Ordering the Upgrade You can order your license upgrades eithe
directly from the Dataton web shop. To ord
Dataton reseller, send an e-mail to the rese
mation as well as the text copied from the l
Contact your Dataton reseller for further de

To order through the Dataton web shop, go

http://www.dataton.com/

Log into the store and select the desired num
the information copied from the License Ma
Once your order has been processed, you 

http://www.dataton.com/


ail and paste it into the “License 
n will appear in the “Pending” 
an License Keys” to transfer the 
en successfully stored in the 
 the Pending column to the 
 used with both your original 
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upgrade information. Select all text in that e-m
Manager” window. The new license informatio
column. Connect the license keys and click “Sc
pending information into the license keys. Wh
license key, the information is transferred from
Version column. Upgraded license keys can be
version and the new version of WATCHOUT.
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8

to the entire presentation, such as 
 ones.

 name and location of the 

 arrangements and cues, simply 
n paste them in the new one.
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8 COMMANDS

FILE MENU The File menu provides commands related 
Opening old presentations or creating new

New Creates a new presentation, specifying the
WATCHOUT presentation.

◆ HINT: To re-use objects such as display
copy them from the old presentation the

Navigate to the desired folder 
using this control and by double-
clicking folders in the list.

Type the name of the show here, 
then click Save.



s. Choosing an item from the 

ly open. This is useful for saving 
he current presentation.

out changing it back to its orig-
 be downloaded to all display 
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Open Opens an existing WATCHOUT presentation.

Open Recent Provides a list of recently opened presentation
sub-menu opens the selected presentation.

Save Saves the presentation that is currently open. 

Save a Copy As Saves a copy of the presentation that is current
backup copies without changing the name of t

◆ NOTE: Opening and using such a copy with
inal name will cause a new set of media to
computers under the new show name.

Navigate to the containing folder.

Select the desired show then click 
Open.
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luding all actively used media files, 
onsolidate all the relevant files in 
on onto a DVD.

using media files stored on servers 
 out unused media files intermixed 

a files, this command also updates 
window, and stores this updated 
ated folder. When using Move, the 

 an empty folder for your consoli-
with the dialog box shown below, 
 move the media files.

tation, leaving the current media 
his is the safest option, but may 
Chapter 8     Commands

Consolidate To Moves or copies the entire presentation, inc
to a folder. You can use this command to c
preparation prior to burning the presentati

This command is also useful if you’ve been 
or removable disks, or if you want to weed
with files actually used in the presentation.

In addition to collecting actively used medi
the access paths accordingly in the Media 
copy of the presentation file in the consolid
old presentation file is not affected.

When you give this command, first choose
dated presentation. You’re then presented 
allowing you to choose whether to copy or

Copy. Creates a new copy of your presen
files and the presentation file as they are. T



pace, since it entails making 
 the presentation.

sentation is copied. Unused 
moved from the Media window 
used media files are left in their 
.

ll actively used media files that 
This is much faster and requires 
ed on the target volume. Media 
rs will be copied, however. The 
matically.

 media files away from the 
ion, you will no longer be able 
fers to has been moved. A new 
e consolidated folder with the 

uickTime movie. The movie file 
 to a web site, or similar.

up the Stage window to define 
 displays currently visible in the 
 used to export a smaller portion 
lays that are currently visible in 

ed out in the resulting file. Also, 
 desired set of layer conditions 
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require a significant amount of time and disk s
new copies of every media file actively used in

◆ NOTE: Only media actively used in the pre
media items (including compositions) are re
in the consolidated version of the show. Un
old locations, and are not copied or moved

Move. Instead of copying them, this moves a
reside on the same volume as the target folder. 
no additional disk space for files already locat
files residing on other disks, partitions or serve
consolidated presentation is then opened auto

▲ IMPORTANT: Since the Move option moves
locations specified in the original presentat
to use the old presentation file as media it re
copy of the presentation file is created in th
updated media file references.

Export Movie Exports the main timeline of your show as a Q
can then be sent off for client approval, posted

◆ NOTE: Before choosing this command, set 
the scale and area to be exported. Only the
Stage window will be exported. This can be
of a very large stage. Areas outside the disp
the Stage window will be cropped or blank
if your show uses conditional layers, set the
in the Preferences box before exporting.
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and, a Save dialog will be shown, 
le. This dialog box also allows you 
 and to control the compression 
y depending on the version of 

m the main timeline of your show, 
r exporting audio to PICKUP. The 
nto iTunes, which converts it into 

nguages controlled by conditional 
d set of conditional layers before 

any changes.
Chapter 8     Commands

When you choose the “Export Movie” comm
allowing you to name the resulting movie fi
to limit which part of the timeline to export,
being used. The formats available may var
Quicktime you have installed.

Export Audio Exports a stereo mix-down of the audio fro
as a Wave-file. This is particularly useful fo
resulting WAVE file can then be imported i
MP3 format for PICKUP.

◆ NOTE: If your show contains multiple la
layers, make sure you enable the desire
exporting the sound track.

Quit Quits WATCHOUT after optionally saving 

Navigate to the desired folder.

Name of the new movie.

Portion of timeline to save.

How to compress the movie.



 the presentation.

lly only differ in the last few 
 the common initial part in this 
igits into the specifications 
dress” on page 144).

t separates the last two groups 
de by simply concatenating the 
ld with the contents of the dis-

Enter the common 
part of your display 
computer’s IP 
addresses.

Determines the fade 
rates for the Standby 
command.
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Preferences Allows you to specify miscellaneous settings of

Display Address Prefix The IP addresses assigned to the displays usua
digits (see illustration on page 26). By entering
field, you then only have to enter the last few d
dialog box of each individual display (see “Ad

▲ IMPORTANT: You must enter the period tha
of digits here. The complete IP address is ma
contents of the “Display Address Prefix” fie
play’s Address field.

Sets the frame rate to be used 
by your display computers.

Default anchor position for 
new image cues.
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 computers. This setting lets 
 the frame rate of any video being 

ay devices. Your display computers 
ge 29 for more information).

the standby command (page 124).

igned with the center of the image 
e Stage window. See “Anchor Posi-

d curve. Although it is possible to 
lly not required. The same curve is 
rresponds to the outer (dark) edge 
st be online for you to see the effect 

st the edge blend curve, make sure 
page 215). If not, it may be impos-

lue numerically, or to change its 
 the edge blend curve from one 

ecision in adjusting the curve.
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Display Framerate Specifies the frame rate used by the display
WATCHOUT optimize its behavior to match
used in the presentation, as well as the displ
should use a matching refresh rate (see pa

Standby Rates Specifies the fade out and fade in rates for 

Center Anchor Automatically When checked, the anchor point will be al
when you drag an image to a timeline or th
tion” on page 160.

Edge Blend Drag the round dot to adjust the edge blen
add more points to the curve, this is genera
applied to all edges. The left of the curve co
of the gradient. Your display computers mu
of the edge blend curve while changing it.

▲ IMPORTANT: Before attempting to adju
your projectors are set up properly (see 
sible to get a proper edge blend.

Double-click a point to view and edit its va
type. This also allows you to precisely copy
presentation to another.

◆ HINT: Enlarge the window for better pr



g the WATCHOUT production 

ts” on page 173.

, WATCHOUT will automati-
rs when opening this show.

omputer. Activates external 
e. This allows you to control 
anel or other computers and 
sions for positioning, starting 
r miscellaneous functions. See 
.

used with the display cluster 
. While they both perform 
n computer and the other 
out the need for any production 

ables synchronization of the 
external timecode signal. When 
 timecode as well as any offset 

 match up with the timeline. Use 
fies a later time position. See 
ils.

rotocol “universe” number to be 
is relates to the DMX-512 Input 
re details on how to use DMX-
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Control This tab provides various options for controllin
software from the outside. 

◆ NOTE: For more control options, see “Inpu

Go Online Automatically. When selected
cally attempt to connect to the display compute

Accept TCP/IP Control of Production C
control of the WATCHOUT production softwar
your WATCHOUT presentation from a touch p
control systems. The control protocol has provi
and stopping the presentation, as well as othe
“Production Computer Protocol” on page 219

◆ NOTE: This control feature is not to be conf
control capability, described in Appendix E
similar functions, one controls the productio
controls the display computers directly, with
computer being present during playback.

Timecode Control of Main Timeline. En
main timeline of the production software by an 
selected, also specify the format of the expected
to be added to the external timecode to make it
a negative offset if the external timecode speci
“Timecode Control” on page 74 for more deta

DMX-512 Universe. Specifies the Artnet p
used to receive and transmit DMX-512 data. Th
and Output respectively. See page 176 for mo
512.
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bled. Each layer in the Timeline 
 (see “Condition” on page 93), in 
pear when the corresponding 

combination of conditions.

ther with external control of display 
Personalized or Multi-lingual 

ol means (see Appendix E “Display 
nabled layers in WATCHOUT can 
ICKUP; matching texts and other 
ation.

views media from enabled layers 
Preview Options” sub-menu on the 

ion computer with video input 
 Video” media (see “Live Video” on 
o in the production computer, if 
roduction computer as the “Video 

illustration under “Add Live Video” 

ferences dialog box apply only to 
omputer has its own, independent 
llows you to have different configu-
omputers.

e production computer’s Stage 
view mode in the “Live Video” 
 Doing so still allows you to assign 
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Enabled Layer Conditions Specifies which layer conditions will be ena
window can be associated with a condition
which case media on that layer will only ap
condition is enabled. You can specify any 

Layer conditions are particularly useful toge
clusters, either using Dataton PICKUP (see “
Audio” on page 72) or other external contr
Cluster Protocol”). For instance, the set of e
be governed by the language selection in P
language-dependent images in the present

◆ NOTE: The Stage window normally pre
only. This behavior is governed by the “
Stage menu.

Video In Associates video input cards in the product
device numbers, subsequently used in “Live
page 49). This allows you to view live vide
desired. It serves the same purpose in the p
In” menu does in the display software (see 
on page 133).

◆ NOTE: The “Video In” settings in the Pre
the production computer. Each display c
assignment of video input devices. This a
rations of capture cards in the various c

If you don’t want to preview live video in th
window, choose the “Thumbnail” stage pre
media item (see “Live Video” on page 49).



lay computers, while disre-
o input device number in the 
re the settings in the “Video In” 

 the current window or currently 
r tween points).

sentation.

wing them to be pasted in else-
another position along the 

ing the copies to be pasted in 
isplay configurations or cues 

esentations in this way, any 
er along with the cues, and will 
ow in the target presentation.

nto the current window.

ontents of the clipboard.
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video input device numbers for use in the disp
garding any setting for the corresponding vide
production software. In this case, you can igno
section of the Preferences dialog box.

EDIT MENU The Edit menu contains commands applying to
selected objects (for example, displays, cues o

Undo/Redo Reverts recent changes you’ve made to the pre

Cut Transfers selected objects to the clipboard, allo
where. Use this, for example, to move cues to 
timeline, or to another presentations.

Copy Copies selected objects to the clipboard, allow
elsewhere. Use this, for example, to transfer d
between presentations. 

◆ NOTE: When transferring cues between pr
media associated with these cues will transf
be automatically added to the Media wind

Paste Pastes the most recently cut or copied objects i

Clear Removes selected objects without altering the c

Select All Selects all objects in the current window.
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s from the current time position and 

 selected object. This is equivalent 
 the object.

and “Cue Specifications” on 
y items, see page 128.

oves the selected objects by a 
pecified number of pixels. Applies 
 cues and displays. When applied 
 cues, it moves the stage positions 
f media displayed by the cues.
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Select to End Applies to timeline windows. Selects all cue
forward.

Specifications Opens the Specifications dialog box for the
to pressing the Enter key or double-clicking

See “Display Specifications” on page 144 
page 156 for more details. For media prox

Move M
s
to
to
o

Example specifications dialog 
box for a still image.



hen applied to the Media 
 by specifying the name of the 
ommand operates on the infor-
 the Media window, indicating 

 path to media files after they 
r instance, if you start out with 
 early stage of production, you 
b-folder of the folder containing 
, use the Find/Replace 
ath name (beginning with a ‘/’ 
 the name of a folder located in 

re stored in a folder named 
ork volume named “E:” during 

Replacement text.

Finds/replaces one at a 
time or all at once.

Searches currently 
selected items only.
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Find/Replace Finds and optionally replaces specified text. W
window, this allows you to locate media items
media file, or any part of its path name. The c
mation shown in the “File Location” column of
the relative or absolute path to the media file.

You can use the Replace function to update the
have been moved to another disk or folder. Fo
your media files on a shared server during the
may later want to move all media files into a su
the presentation file. After transferring the files
command to change the absolute part of the p
character) to a relative (that is, beginning with
the same folder as your presentation).

As an example, assume that the media files we
“WATCHOUT/Production1/Media” on a netw

Search text.

Check this box to replace the 
found text.

Distinguishes “Mike” from “mike”.
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s into a folder named “Media” 
UT presentation file. You would 
/Replace dialog box to update all 

line windows. In this case, it allows 
media cues by the name of their 
ing cues using a particular media 
ard direction from the current time 
ckwards.

traight to a Control cue by pressing 
ply name the cues F1, F2, F3, etc, 
key. See “Using Find and Quick-

mand.

No leading ‘/’ char-
acter indicates a folder 
relative to the folder 
containing the presen-
tation file.
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production. You have now copied these file
located in the same folder as the WATCHO
then enter the following values into the Find
relevant media paths accordingly.

Finding Cues The Find command can also be used in time
you to search for Control cues by name or 
associated media. The latter is useful in find
item. The timeline is first searched in the forw
position. If not found, it is then searched ba

Using QuickFind The QuickFind feature allows you to jump s
a single function key on the keyboard. Sim
and then press the corresponding function 
Find” on page 172 for more details.

Find/Replace Again Repeats the most recent Find/Replace com

A leading ‘/’ character indicates 
an absolute path.

Check to replace.

Choose “All at Once” to change 
all matching items, or “One at a 
Time” to review each change 
before proceeding.



ther as they are dragged with 
akes it easier to align images, 

es will snap to the edge, center 

ged in a timeline window.

thin the same cue, as well as to 

time position. For this to work, 
imeline menu.

indow, it may be hard to see 
the area of interest (see “Setting 
the preview of layers that get in 
 page 92).
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Snap When enabled, objects exert gravity on each o
the mouse, making them snap together. This m
cues and tween points.

• When dragged in the Stage window, imag
or corner of displays and other images.

• Cues will snap to adjacent cues when drag

• Tween points snap to other tween points wi
the beginning and end of the cue.

• Cues and tween points snap to the current 
first turn off “Click Jumps to Time” on the T

◆ HINT: When working in a crowded stage w
what’s snapping to what. If so, zoom in on 
the Stage Scale” on page 87) and disable 
the way (see “Disabling Layer Preview” on
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ontents of the Stage window.

 the Stage window. After adding a 
to enter its specifications (see 

d while Online is selected on the 

on display sizes as shortcuts. You 
’s dialog box as long as it is 
interface card in the display 

t stage tier (see “Using Stage Tiers 
 page 88). Move displays between 

 A larger preview gives you greater 
es using the mouse.

tors, you can zoom to any area of 
own the Control key (see “Setting 

u to operate the display computers 
cularly useful if the display 
nected.

esktop of displays selected in the 
UT display software has to be 
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STAGE MENU The Stage menu applies specifically to the c

Add Display Adds a new display of the specified size to
display, open its specifications dialog box 
“Display Specifications” on page 144). 

▲ IMPORTANT: Displays can not be adde
Stage menu.

The secondary menu provides some comm
can, however, enter any size in the display
supported by the physical display and the 
computer.

◆ NOTE: Displays are added to the curren
for Complex Display Arrangements” on
tiers using the Cut and Paste commands

Scale Sets the viewing scale of the Stage window.
precision in positioning displays and imag

◆ HINT: In addition to these fixed scale fac
interest using the mouse while holding d
the Stage Scale” on page 87).

Manage Display Computer The commands on this sub-menu allows yo
from the production computer. This is parti
computers have no mouse or keyboard con

Remote Access Opens a remote access window onto the d
Stage window. For this to work, WATCHO



OUT display software will be 
see the desktop of the display 
t directly with the display 
nt hard drives or similar house-

uses the display software to 
te access session.

esktop window of the display 
e restored to its full screen mode 

omputers. This quits 
dows and turns off the 
HOUT production software also 
puters, which can then be used 

twork to selected or all display 
er up the computer(s) as if their 
tcut to the WATCHOUT display 
omputer to make it launch 

 for this command to work:

e on LAN” (sometimes referred 
found under the “Power 
rk Connection’s Properties 

ngs.
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running on the display computer. The WATCH
reduced to its window mode, allowing you to 
computer. While in this mode, you can interac
computer, for instance to delete files, defragme
keeping chores.

◆ NOTE: Take care not to do anything that ca
close, as doing so also terminates the remo

End the remote access session by closing the d
computer. WATCHOUT display software will b
by the Online command.

Power Down Turns off the power of selected or all display c
WATCHOUT display software, terminates Win
computer. As part of this procedure, the WATC
learns the hardware address of the display com
by the Power Up command.

Power Up Sends a “Wake on LAN” command via the ne
computers. If properly configured, this will pow
power switch had just been pressed. Put a shor
software into the Startup folder of the display c
WATCHOUT automatically.

▲ IMPORTANT: There are a two prerequisites

• The computer must be configured to “Wak
to as “Magic Packet”). This setting may be 
Management” tab of the Local Area Netwo
dialog box, or in the computer’s BIOS setti
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point have given the Power Down 
wing it to learn the computers 

uilding elaborate display arrange-
 Display Arrangements” on page 

at least one stage tier. Any addi-
” on this sub-menu.

isplays, you must first select their 
displays are shown with a dotted 
ll text will appear when you point 
it resides on.

it as the current tier. Any displays 
.

ently selected stage tier.

splay computers. Once connected, 
u jump around on the timeline and 

 displays in the Stage window. You 
 any changes in the Stage window.

dow indicates failed connection to 
the Display Computers” on page 
ge window.
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• The production computer must at some 
command to that display computer, allo
network card hardware address.

Tier Manages stage tiers, which are useful for b
ments (see “Using Stage Tiers for Complex
88).

Main Selects the main stage tier. There’s always 
tional stage tiers will be listed below “Main

◆ NOTE: In order to add or manipulate d
stage tier using this menu. Inaccessible 
outline in the Stage window, and a sma
at such a display, telling you which tier 

Add Adds another tier to the stage, and selects 
you add or paste will now go onto this tier

Rename Allows you to change the name of the curr

Online Connects the production computer to the di
the display computers will follow you as yo
start/stop the presentation.

◆ NOTE: Choosing “Online” also locks all
must deselect “Online” in order to make

A stop sign inside a display in the Stage win
that display computer (see “Connecting to 
69). Other errors are reported in the Messa



ny changes you’ve made to the 
dified media files to the display 

or to the image of any standby 
age 93). Also fades the audio. 
oth way – possibly to jump to 
ommand again to restore 
 mode, an indicator is shown at 

ed to the Status window (see 

 command are set in the 

es shown in the Stage window. 
puters or what appears on their 

e preview in the Stage window 
eline window. While this is the 
et in your way if you want to 
d behind another image. In this 
corresponding to the image to 
indow.
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Update Updates all connected display computers with a
presentation, including transferring new or mo
computers.

Standby Causes all display computers to fade to black, 
layer (see “Perform Normal/In Standby” on p
Useful if you want to pause the show in a smo
another position along the timeline. Give the c
normal image display. While online in standby
the top of the stage window. 

◆ HINT: A standby indicator can also be add
page 101).

The fade-out and fade-in times for the Standby
Preferences dialog box (page 112).

PREVIEW MENU The items on this menu control the preview of cu
These commands do not affect the display com
outputs.

Click Selects Frontmost Image When this option is selected, clicking an imag
always selects the corresponding cue in the Tim
most natural behavior in many cases, it may g
move an image that appears partially obscure
case, uncheck this menu option, select the cue 
be moved, then drag the image in the Stage w
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es in the Stage window using the 

s with the name of the media item, 
times useful when trying to position 
 by other images.

ails of images and video for the 
uality in this mode is very low, its 
aling with numerous, very large 

tion thumbnails as video preview. 
e many large video clips playing at 

w of all cues except those explicitly 
).

al thumbnail preview for images or 
eview as thumbnails by selecting 
up menu in each cue.

ys. This provides a more accurate 
 the display computers. However, it 
n, since images positioned outside 

y tween track, it may become hard 
. Selecting this option causes a thin 
, making them easier to see.
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Preview Quality Control the overall preview quality of imag
following four commands.

Wireframe. Displays all images as boxe
rather than showing the image. This is some
images, or to track down images obscured

Thumbnails. Uses low resolution thumbn
Stage window preview. While the image q
performance is high – particularly when de
images.

Video as Thumbnails. Uses low resolu
Speeds up editing of presentations that hav
the same time.

Best Quality. Renders high quality previe
set to “Stage Preview: Reduced” (page 159

◆ HINT: As an alternative to selecting glob
video, you can set individual cues to pr
“Reduced” on the “Stage Preview” pop-

Masked by Displays. Masks images to the areas inside the displa
representation of what is actually shown by
also makes it harder to edit the presentatio
the displays disappear.

Outline Dimmed Images When an image is dimmed using an opacit
to see and manipulate in the Stage window
frame to be displayed around such images



o cues for all displays. You can 
ereby reducing the processing 

he same images as the display 
 images from standby layers –
3). This allows you to edit such 

o see the normal images in the 
 order to preview and possibly 
e standby images. This can be 
ndby Layers” menu item.

images originating from condi-
e “Condition” on page 93 and 
ore information on conditional 
g from enabled layers only to 
lished by choosing “Enabled 
ll conditional layers, regardless 
rences dialog box, select “All 

able/disable their cues (as 
 layers can also be associated 
 appear on displays on those 
e Preview menu control what’s 

lecting “All Stage Tiers”, the 
their stage tier association. 
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Play Audio Media By default, the production computer plays audi
turn off this behavior using this menu option, th
overhead associated with audio playback.

Preview Standby Layers When activated, the Stage window will show t
computers while in standby mode (that is, any
 see “Perform Normal/In Standby” on page 9
images through the Stage window.

However, in most cases, you probably prefer t
Stage window even while in standby mode, in
edit those while the display computers show th
accomplished by un-checking the “Preview Sta

No / All / Enabled Conditional 
Layers

These three menu items control to what extent 
tional layers appear in the Stage window. (Se
“Enabled Layer Conditions” on page 115 for m
layers.) Generally, you want images originatin
appear in the Stage window, which is accomp
Conditional Layers”. To preview images from a
of whether or not they are enabled in the Prefe
Conditional Layers”.

All / Active / Specific Stage Tiers Just as timeline layers can use conditions to en
described in the previous paragraph), timeline
with stage tiers. Cues on such a layer will only
specific tiers. The commands in this group of th
shown in the Stage window in this case. By se
Stage window will preview cues regardless of 
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n layers associated with the tier 
ting “Specific Tiers” brings up a 
tion of stage tiers to preview.

eir Timeline Layer Settings dialog 
ded in the preview, regardless of 
enu options.

ow. If your source material is hard 
en change to another color.
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Select “Active Stage Tier” to preview cues o
specified on the Stage Tier sub-menu. Selec
dialog box where you choose any combina

◆ NOTE: Layers set to All Stage Tiers in th
box (see page 138) will always be inclu
the preview mode chosen using these m

Background Color Sets the background color of the Stage wind
to see on the default (black) background, th



tents of the Media window.

file to be added to the Media 
 the Media, Stage or Timeline 

. Use a proxy to handle media 
 the Media window, as 
ge 55. 

roxy being added.
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MEDIA MENU The Media menu applies specifically to the con

Add Media File Opens a dialog box where you can choose a 
window. Alternatively, simply drag the file into
window.

Add Proxy Adds a proxy media item of the kind specified
that can not be added simply by dragging into
described under “Using Media Proxies” on pa

Available options vary based on the kind of p
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eck this if you have pre-split a large 
rge Movies” on page 44. In this 
 folder specified in the File/Folder 
isplay intersecting the movie, each 

ovie called “LargeMovie.mpg” that 
and “Display 2”. You would then 
e files “Display 1” and “Display 2” 
ie.mpg”. Finally, specify that folder 

r Windows Media files, always 
name of the folder containing the 
bove. This is needed to ensure that 
 used. Note, however, that the indi-
e corresponding displays – and 
ended. By default, Windows may 

w file extensions, choose “Folder 
s Explorer, click the View tab, and 
 types”.

lit or Multiple Displays” is selected, 
ecify the file or folder associated 
ose” button next to the field to 
 Transfer” to “Manual”, you would 
e that may not exist on the produc-
lly to the display computer.

 manually or automatically from the 
ers. Normally, you would choose 
Chapter 8     Commands

Pre-split for Multiple Displays This option applies to video media only. Ch
movie, as described under “Pre-splitting La
case, the resulting files must be placed in a
field. This folder must contain one file per d
file named after its target display.

As an example, assume you have a large m
intersects two displays named “Display 1” 
pre-split the movie into two files. Name thos
and put them in a folder named “LargeMov
in the File/Folder field of the video proxy.

◆ IMPORTANT: When using MPEG, AVI o
append the proper file extension to the 
pre-split files, as shown in the example a
the correct video playback mechanism is
vidual files must be named exactly as th
must not have a file name extension app
not display filename extensions. To sho
Options” on the Tools menu in Window
uncheck “Hide extensions for known file

File/Folder The title of this field reads “Folder” if “Pre-sp
otherwise it reads “File”. In this field you sp
with the media item. You can use the “Cho
choose an existing file/folder. If you set “File
instead type the fictive, relative path to a fil
tion computer, but will be provided manua

File Transfer Specifies whether the file will be transferred
production computer to the display comput

◆ NOTE: Pre-split movies 
don’t preview in the Stage 
window. A placeholder 
thumbnail is displayed 
instead.



 file is to be provided later, 
 not yet available. 

OUT will make sure that the file/
closing the dialog box. If you 
ibility to provide the file, and 

ith this proxy will be transferred 
 Stage Update command, 
ommand.

ia files must maintain their orig-
y making the original larger 

nges.

to moving images (video) and 

present the proxy in the Media 
 preview. If not specified, a 

and moving images. 

ns transparent areas, as well as 
TCHOUT determines this from 
g a proxy, you must specify this 
 image to display without trans-
g images.

HOUT includes:
130 Chapter 8     Commands

“Automatic”. You may choose “Manual” if the
directly to the display computer, or if the file is

◆ NOTE: If you choose “Automatic”, WATCH
folder you specified actually exists prior to 
choose “Manual”, it becomes your respons
WATCHOUT will not verify its existence.

Auto-Refresh on Update If selected, an updated media file associated w
to the display computers whenever you use the
without first having to use the Media Refresh c

▲ IMPORTANT: When using this feature, med
inal size. If required, you can plan ahead b
than necessary to accommodate future cha

Duration Enter the duration of the media here. Applies 
sound only. 

Thumbnail Allows you to choose a thumbnail image to re
window, inside cues and in the Stage window
default icon will be displayed.

Dimension Specifies the size of the image. Applies to still 

Transparency Allows you to specify whether the image contai
the form of transparency used. Normally, WA
the information in the media file, but when usin
manually. Setting this incorrectly may cause the
parency or not at all. Applies to still and movin

The types of transparency supported by WATC
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 channel.

ation affects the alpha channel of 

ency affects both the alpha channel 
ixels in fully transparent areas are 
duced for printing purposes.

ncy affects both the alpha channel 
ixels in fully transparent areas are 
duced for video compositing 

A composition allows you to group 
ks) in a way that can subsequently 
. See Chapter 6 “Using Composi-

or a description of the fields in the 

e image of a computer screen into 
cel graphics, Powerpoint slides, a 
ions, as part of your presentation.

er’s screen is sent continuously via 
mputers, where WATCHOUT 
le, you can put a plain Powerpoint 
on background, thereby enhancing 
abilities of WATCHOUT.
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• None. The image or video has no alpha

• Straight Alpha. The transparency inform
the image only.

• Pre-multiplied with White. The transpar
and the pixels in the image so that the p
white. This is often used in material pro

• Pre-multiplied with Black. The transpare
and the pixels in the image so that the p
black. This is often used in material pro
purposes.

Add Composition Add a Composition to the Media window. 
images together (including their tween trac
be used as a media item on other timelines
tions” for some examples.

See “Composition Settings” on page 141 f
dialog box shown by this command.

Add Computer Screen This feature allows you to incorporate a liv
WATCHOUT. This can be used to show Ex
Web browser, or similar software applicat

The image displayed on the source comput
the network to the WATCHOUT display co
composites it with other media. For examp
presentation on top of a large, high-resoluti
it with all the high-quality presentation cap



ur presentation, follow these 

oftware on the remote computer 

Media list using this command 
ed below.

edia list onto the Stage, and 
element.

n images as any other images. 
le and opacity. Since the 
y computers, you can show the 
uters.

ter Screen dialog box, type the 
ress field, and the VNC pass-

o the size of the display of the 
ove performance).

erally be set to zero. It may be 
r software which support 

eview the Computer Screen in 
Otherwise, set this to “Thumb-
iew only – not what’s shown by 
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To incorporate such a computer screen into yo
steps:

• Install, activate and configure VNC server s
(see “VNC Server Software” on page 22).

• Add a Computer Screen media item to the 
on the Media menu. Configure it as describ

• Drag the computer screen object from the M
program it using cues as any other image 

The same capabilities apply to computer scree
For instance, you can program its position, sca
images are sent across the network to all displa
computer display across multiple display comp

Computer Screen Settings. In the Compu
IP number of the remote computer into the Add
word into the Password field. Set Dimensions t
VNC server (reducing the resolution may impr

The Screen field is rarely used, and should gen
used with some implementations of VNC serve
multiple screens or work-spaces.

Set “Stage Preview” to “Live” if you want to pr
the Stage window of the production software. 
nail”. This setting affects the Stage window prev
the display computers.

◆ NOTE: The remote computer 
does not require a 
WATCHOUT license key.
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, such as a camera feed, as part of 
eo feed must be connected to each 
t. For instance, if you want to show 
nal must be fed to both display 

ion amplifier). See “Live Video 
 details.

ese steps:

the display computer.

.

t your video input device is 
ber.

ut. 
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Add Live Video This feature allows you to display live video
your WATCHOUT presentation. The live vid
display computer that is expected to show i
live video across two displays, the video sig
computers (typically using a video distribut
Input” on page 194 and page 20 for more

To activate the Live Video feature, follow th

• Start WATCHOUT display software on 

• Press Ctrl-W to switch to window mode

• On the “Video In” menu, make sure tha
associated with the desired device num

• Connect a video source to the video inp

Associate a video input device 
number with your video input(s).

Video inputs available on the 
display computer appear here.



ollows:

 list using the command on the 
elow. 

list onto the Stage or a timeline, 

deo played from disk, allowing 
 opacity. 

u must connect the video signal 
re, this video signal must be 
h display computer that is to 
for more details.

 Device” to the device number 
llustration on page 133. Set the 
priate for your video connection 
ultiple inputs for the same kind 
 field to the right if the “Signal 

t FireWire inputs, this kind of 
eWire video feed introduces a 
s well as reducing performance 
pression.

 video cameras uses an inter-
esenting such a video signal on 
o projector or other display 
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To use Live Video in your presentation, do as f

• Add a Live Video media item to the Media
Media menu, configuring it as described b

• Drag the Live Video object from the Media 
just like any other media object.

Live Video supports the same capabilities as vi
you to program its position, scale, rotation and

To show live video across multiple displays, yo
to each of those display computers. Furthermo
associated with the same input number on eac
display it. See “Live Video Input” on page 20 

Live Video Settings
In the Live Video Media dialog box, set “Input
selected on the “Video In” menu shown in the i
“Signal Input” and “Video Standard” as appro
and source. If your video input interface has m
of signal, enter the desired input number in the
Input” pop-up menu.

◆ NOTE: Although WATCHOUT does suppor
signal is generally not recommended. A Fir
significant delay in the video processing, a
and image quality due to the DV data com

Deinterlacing. Video originating from most
laced signal, just like a PAL or NTSC TV set. Pr
a non-interlaced display device, such as a vide
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, results in visual artifacts often 
 of moving objects. Use the Deinter-
 or “Best Quality” to rectify this 

ess necessary. Some video material 
“progressive scan” mode do not 
duce the image quality.

nt to preview the Live Video in the 
Otherwise, set this to “Thumbnail”. 
w only – not what’s shown by the 

the Stage window of the production 
appropriate video capture capabil-
et the input associations for the 
 “Video In” on page 115).

l sometimes contain noise. These 
 of the edges of the video image to 

he dimensions are fixed by the 
” on the “Video Standard” pop-up 
dimensions. Use this, for example, 
ht into WATCHOUT using a DVI or 

ny edge trimming. For example, if 
ou trim 10 pixels at each edge, the 
0.
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device designed to be used with computers
referred to as “combing” around the edges
lacing pop-up menu, set to “Good Quality”
problem when required. 

▲ IMPORTANT: Do not use this feature unl
and some cameras that can be set to a 
need deinterlacing, and using it may re

Stage Preview.  Set to “Live” if you wa
Stage window of the production computer. 
This setting affects the Stage window previe
display computers.

◆ NOTE: In order to preview Live Video in 
computer, this computer must have the 
ities, and the video signal to preview. S
production computer in Preferences (see

Trim Edges. The fringes of a video signa
four fields allow you to selectively trim each
remove such noise.

Dimensions. For most video standards, t
standard. However, when selecting “Other
menu, you can manually enter the desired 
to enter the size of a computer signal broug
VGA capture card (see page 194).

◆ NOTE: The dimensions shown are after a
the original image is 640 by 480 and y
resulting dimensions become 620 by 46



devices. The number of video 
pends on your computer hard-

ors – often for different kinds of 
ideo). You specify which one to 
ore Live Video media objects to 
nerally, you can only display 
thermore, it’s generally not 
om one signal to another on the 
 of seconds between the end of 
 of the cue displaying the other.

ing you to group related media 
window is independent of the 
s a means to organize items in 

 window. This gives a better 
r of items visible in the list.

edia window is also affected by 
his column wider to see wide 

their information from the 
llowing you to refresh media 

s of the file’s last modified time-
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Using Multiple Video Inputs WATCHOUT supports up to eight video input 
inputs that can be displayed simultaneously de
ware, type of video input device, etc.

Most video input devices have multiple connect
video signals (for example, Composite and S-V
use in the Live Video media dialog box. Add m
access different inputs on the same device. Ge
one input at a time from any given device. Fur
possible to make a clean switch back-to-back fr
same input device. You need to leave a couple
the cue displaying one input and the beginning

New Folder Adds a new folder to the Media window, allow
items. Any such group of media in the Media 
folders on your hard disk, and serves merely a
the Media window.

Large Thumbnails Displays larger thumbnail images in the Media
preview of each image, but reduces the numbe

◆ NOTE: The size of wide thumbnails in the M
the width of the Thumbnail column. Make t
thumbnails.

Refresh Refreshes items in the Media list by reloading 
associated media files. A dialog is displayed a
that has been changed or all media regardles
stamp.
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w. After reviewing the selection, 
remove the unused media items.

 or indirectly associated with cues 
timeline, are considered as being 
compositions are only considered 
g used. Hence, you can prevent a 
onsidered unused by adding it to 
Chapter 8     Commands

Select Unused Selects all unused items in the Media windo
you can choose Clear on the Edit menu to 

▲ IMPORTANT: Only media items directly
on the Main Timeline, or any auxiliary 
used. Specifically, media items used in 
used when the composition itself is bein
composition and its media from being c
an auxiliary timeline.



ntents of timeline windows. It is 
cted.

tationary while manipulating 
is reflected by the color of the 

t time indicator as a ruler for 
” on page 120 for more details.

ected layer. When reached 
rammed action. See “Control 

 layer rather than mixing them 
find and prevents them from 

the timeline, or choose “Insert 
yer. Choose “Delete Layer” to 

es can not be deleted.

 the layer as well as set various 
s” on page 92 for more details.
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TIMELINE MENU The Timeline menu applies specifically to the co
only available when a timeline window is sele

Click Jumps to Time Deselect this option to keep the time position s
cues and tween points. The state of this mode 
current time indicator.

◆ HINT: Turn off this option to use the curren
aligning cues and tween points. See “Snap

Add Play / Pause Control Cue Adds a Control cue at the current time and sel
during playback, the cue will perform its prog
Cue” on page 171 for full details.

◆ HINT: When using Control cues, dedicate a
with other cues. This makes them easier to 
getting obscured by other cues.

Adding and Removing Layers Choose “Append Layer” to append a layer to 
Layer” to insert a layer in front of the current la
delete the current layer. A layer containing cu

Layer Settings Opens a dialog box that allows you to rename
layer attributes. See “Layer Name and Attribute
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eline Window is active will display 
e.

ition” field jumps to that time. This 
ck a specific time in the time ruler.

 displays the settings for an active 

Rendering order in relation to 
other auxiliary timelines.
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Timeline Settings Choosing this command while the Main Tim
the settings associated with the main timelin

◆ HINT: Typing a value into the “Time Pos
is often more accurate than trying to cli

Auxiliary Timeline Settings Choose the “Timeline Settings” command to
auxiliary timeline window.

Jump to specified time position.

Total duration of the timeline. 
Extended automatically as more 
cues are appended.

The name of the auxiliary time-
line (shown in the Task window).

Jump to specified time position.

Total duration of the timeline. 
Extended automatically as more 
cues are appended.



 multiple active auxiliary time-
 they are listed in the Task 
ng tasks up or down in the Task 
 and overlapping auxiliary 

its images on top of all other 
lways on Top” when activated. 

roup of mutually exclusive time-
supersede the previous one.

p the previous auxiliary timeline 
nes” on page 172.

its images on top of all other 
e blend will be applied to its 

ne-up you want to see the full 
ure that the image fits precisely 

play partially intersecting other 
deo input. Putting this live video 
r above the edge blend avoids 
 applied to the intersecting 
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Stacking Order; Task List Order This is the default stacking order. In this mode,
lines render their images in the order in which
window. You can change this order by draggi
window, thereby affecting how multiple, active
timelines interact on screen.

Always on Top In this mode, the auxiliary timeline will render 
auxiliary timelines set to “Task List Order” or “A
This is useful, for example, when you have a g
lines, where each new timeline started should 

◆ HINT: You can then use a Control cue to sto
in the group. See “Controlling Other Timeli

Above Edge Blend In this mode, the auxiliary timeline will render 
timelines when activated. Furthermore, no edg
images. This is useful in two specific cases:

• When displaying line-up images. During li
image all the way out to the edge to make s
onto the display chip in the projector.

• When showing a live video image on a dis
displays lacking capture cards for this live vi
image on an auxiliary timeline set to rende
the feathered edge that would otherwise be
areas.



141

ttings” while a composition’s time-

ed to be looped. Often such a loop 
ind, set as the duration of the 

to avoid having the duration 
or edited.

se all displays on the current stage 
an set the reference frame to any 
ea to make it about the same size 
ray rectangle in the Stage window 
active. Furthermore, it is also used 

The reference frame is displayed 
as a gray, dotted rectangle in the 
Stage window while editing the 
composition. It is also used to 
manipulate the composition 
when subsequently used from 
other timelines.
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Composition Settings To displays its settings, choose “Timeline Se
line window is active .

Lock Duration This option is useful for compositions design
is designed with a particular cycle time in m
composition. In this case, check this option 
extended automatically as cues are added 

Reference Frame By default, the reference frame is set to enclo
tier when the composition is created. You c
size you want, but it is generally a good id
as its content. This frame is displayed as a g
while the composition’s timeline window is 

The name of the composition 
(shown in the Media window).

Jump to specified time position.

Duration of the composition. 

When selected, the composi-
tion’s duration will not be auto-
matically extended.



whole when used as a media 

in or clip the content of the 
e reference frame if desired.

 is selected. It allows you to add 
can be removed by unchecking 

enu vary depending on the 
weening is only available for 

acks on page 161.

ows, such as Stage, Media, 
omposition and Auxiliary Time-
open, providing a quick way to 

mposition window, double-click 
edia windows respectively. A 
y Alt-double-clicking a cue for 

ides necessary information for 
 released (see page 103).

HOUT User’s Guide and the 
t version. 
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to select and manipulate the composition as a 
item on other timelines.

◆ NOTE: The reference frame doesn’t constra
composition. Images may extend outside th

TWEEN MENU The Tween menu is available when a media cue
tween tracks to the cue. Likewise, tween tracks 
the corresponding item on the Tween menu.

◆ NOTE: The items available on the Tween m
selected media cue. For instance, Volume t
sounds and movies – not for still images.

Read more about the various kinds of tween tr

WINDOW MENU This menu provides access to all standard wind
Main Timeline, etc. Other windows, such as C
line windows are appended to this menu while 
switch among them.

◆ NOTE: To open an Auxiliary Timeline or Co
the corresponding entry in the Task and M
Composition window can also be opened b
that composition.

License Manager Displays your WATCHOUT licenses, and prov
upgrading them when new major versions are

HELP MENU This menu provides quick access to the WATC
release notes with the latest news on the curren
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9

 wall cubes and plasma screens. 
isplays properly, as described on 
y technologies on page 207. 

ose “Add Display” on the Stage 
splay sizes. The size can be altered 
s” dialog box (page 144).

ge tiers. When using multiple tiers, 
ier. Likewise, you must select the 
ts displays. See “Using Stage Tiers 
 page 88 for more details.

ct multiple displays. Alternatively, 
e the selection rectangle. To de-
 in the Stage window.

ow before you can select displays. 
le bar. Displays can not be manipu-
ctive.

g the mouse. Press the Shift key 
to horizontal or vertical only. For 
g the “Display Specifications” 
Chapter 9     Displays

9 DISPLAYS

Displays include projectors, monitors, video
Make sure you install and configure your d
page 19. Read more about different displa

Adding Displays To add a display to the Stage window, cho
menu. This menu includes most standard di
afterwards using the “Display Specification

◆ NOTE: Displays can be grouped into sta
new displays are added to the current t
proper tier before you can manipulate i
for Complex Display Arrangements” on

Selecting Displays Click a display to select it. Shift-click to sele
drag from a point outside all displays to us
select all displays, click outside all displays

◆ NOTE: You must activate the Stage wind
To activate the Stage window, click its tit
lated if “Online” on the Stage menu is a

Positioning Displays Drag a display to the desired position usin
while dragging to constrain the movement 
best precision, enter the exact position usin
dialog box (page 144). 



 “Cut” or “Clear” on the Edit 
 paste the duplicate back into 
ep in mind that the duplicate 
 Stage window as the original 
ation and change its name and 

, first select the display in the 
 the Edit menu, or simply 

 can select displays. To activate 
an not be manipulated if 

ntify pre-split movie files, as de-
on page 44. Thus, if you use 
e the name of the display after 
ame the movies accordingly.

lay computer that manages this 
f the display. However, if the 
ans of a Domain Name Server), 
ad.

are on the same subnet, which 
is identical, and only the last 
ation on page 26). In this case, 
rt of the address in Preferences 
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Removing and Duplicating Displays To remove a display, first select it, then choose
menu. To duplicate it, first choose “Copy” then
the Stage window. When pasting a display, ke
initially occupies the exact same location in the
did. You must move the duplicate to another loc
address before using it.

DISPLAY SPECIFICATIONS To open the Display Specifications dialog box
Stage window then choose “Specifications” on
double-click the display.

You must activate the Stage window before you
the Stage window, click its title bar. Displays c
“Online” on the Stage menu is active.

Name. Specifies the name of the display. 

▲ IMPORTANT: This name is also used to ide
scribed under “Pre-splitting Large Movies” 
such pre-split movies, you should not chang
creating those movies, or you’ll have to ren

Address. Specifies the IP address of the disp
display. This is typically the numeric address o
display computer is accessible by name (by me
you may enter the DNS name in this field inste

◆ HINT: In most cases, all display computers 
means that the first part of their IP address 
group of digits differ (as shown in the illustr
it’s more convenient to enter the common pa
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112), and then enter only the last 
ons dialog box. For instance, if the 
u would put “192.168.0.” into the 
nces (note the trailing period), and 
isplay Specifications”. Any such 
ield (as shown in the example).

he on-line status of the associated 
nection” button to verify the ability 

er. This can be useful when trouble-

ge the color of the display’s outline 
 for overlapping displays makes it 

 used by the display computer for 
y device. WATCHOUT allows you 
wable settings are ultimately deter-
card in each display computer. 
uter will ensure that it’s set to the 
e of any discrepancies.

the position and dimension of the 
e dimension here matches the phys-
ide this by deselecting “Width and 
ng you to enter different values. 
image to match the resolution. 

ave to play a show made for a 
’t handle that resolution.
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(see “Display Address Prefix” on page 
group of digits in the Display Specificati
complete address is “192.168.0.51”, yo
“Display Address Prefix” field in Prefere
then put 51 into the Address field in “D
prefix is indicated next to the Address f

Peer and Test Connection. Indicates t
display computer. You can use the “Test Con
to connect to that particular display comput
shooting a system.

Color and Change. Allows you to chan
in the Status window. Using different colors
easier to tell them apart.

Display Resolution. Physical resolution
the signal fed to its projector or other displa
to specify any resolution. However, the allo
mined by the display device and graphics 
When using the system, each display comp
specified size, displaying a message in cas

Stage Position and Size. Determines 
display in the Stage Window. Normally, th
ical resolution of the display. You can overr
Height same as Display Resolution”, allowi
Doing so will make WATCHOUT scale the 

◆ HINT: This is particularly useful if you h
specific resolution on projectors that can



 angle. This allows you to use a 
e display arrangements as 
play Layouts” on page 10.

ly between displays that are on 
ngle and stage size.

field is similar to the Left and 
ld above, but indicates the 
rner. The center is often more 
trary angle.

 errors caused by projection off-
inor optical distortion.

 a flat surface always gives the 
hen absolutely necessary.

ox show values corresponding 
 buttons next to each numeric 
y.

y dialog box to see the changes 

 corners, allowing you to 
associated with wide-angle 

ich points can be moved to keep 
esn’t allow points to be moved 
eckbox for increased flexibility.
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Rotation. Rotates the display to an arbitrary
vertical display format, as well as other creativ
shown in the illustration under “Alternative Dis

◆ NOTE: Edge blending will only work proper
the same stage tier with the same rotation a

Stage Position of Display Center. This 
Top fields in the “Stage Position of Display” fie
center of the display rather than the top left co
relevant when the display is rotated to an arbi

GEOMETRY CORRECTION These settings allow you to compensate for any
axis (perspective), on a curved surface or for m

◆ NOTE: Projecting straight from the front on
best image. Use geometry correction only w

The numeric fields at the bottom of the dialog b
to the currently selected point and handle. The
field adjust the value with single pixel accurac

◆ HINT: Go online before opening the Displa
on screen as you make them.

Corner Shapes. Adds bezier handles to the
compensate for minor optical distortion, often 
lenses (as exemplified on page 218).

Constrain Points. Limits the freedom by wh
them within realistic bounds. For example, it do
outside the active display area. Deselect this ch
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 keeping all tangents straight. 
e independently of each other.

age caused by off-axis projection, 
p menu and drag the corners of the 
n screen.

Enable “Corner Shapes” to 
compensate for optical 
distortion.
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Smooth. Avoids abrupt kinks in points by
Uncheck to allow opposing handles to mov

Perspective Correction To compensate for the keystone-shaped im
choose Perspective on the Correction pop-u
grid until the image appears rectangular o

The location of the selected point 
can be adjusted numerically.

Used to transfer the geometry 
settings to other displays.

Drag a corner point to adjust the 
perspective.



right sides, allowing you to 
.

er of the screen, select the 
ether. You may need to uncheck 

Examples of 
screens requiring 
horizontal and 
vertical correction 
respectively.
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Horizontal or Vertical Correction Adds bezier handles to the top/bottom or left/
compensate for projection on a curved surface

◆ HINT: If projecting from a plane at the cent
mirroring checkbox to adjust both sides tog
this checkbox for the final adjustments.

Adjust the curvature by dragging 
the yellow handles.

Mirrors adjustments vertically.

Sets the curvature numerically.
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ou to compensate for projection on 

White circles indicate 
mirrored adjustments of 
points.

Selects one of the handles 
attached to each point.
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Full Correction Adds bezier handles to all sides, allowing y
spherical surfaces.

Rectangular handles control 
the distribution of grid lines.

Sets distribution of grid lines 
numerically.

Drag a corner of the dialog 
box to enlarge it for better 
precision.

Examples of spherical 
surfaces requiring full 
correction.



oints to the grid by Control 
ed to handle geometry adjust-
en surfaces, such as a three 

For maximum flexibility in 
adjusting points, deselect 
Constrain and Smooth.
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Adding Correction Points In Full correction mode, you can add control p
clicking at the desired location. This can be us
ments when projecting on asymmetric or unev
dimensional map.

Control-click in grid to add 
points.

To delete such a point, select 
it and press the Delete key.

Drag a corner of the dialog 
box to enlarge it for better 
precision.
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 properly color matched. However, 
ctors with different lamp life or 
ATCHOUT lets you adjust the color 
erall image look more uniform.

line for you to see the changes as 
Chapter 9     Displays

COLOR CORRECTION Ideally, all projectors in a system should be
sometimes you may have to deal with proje
other minor discrepancies. In such cases, W
balance of a display device, making the ov

◆ NOTE: Display computers need to be on
you move the sliders.

Select the Color tab to make 
minor adjustments to the color 
balance of a display device.

Use a test image showing gray 
bars to adjust the color balance.
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10

. They control when media appear 
r such as positioning and opacity. 
he layers determine the stacking 

w, drag a Media window item, or 
ow. Media files can be dragged 

all media used in a presentation in 
 show file. Doing so allows 
relative path specification, making 
ll its media references intact.

ow, the cue will appear on the 
d line under the layer’s name) and 
 into the timeline, the cue appears 

ultiple cues. Alternatively, drag 
ction rectangle. Use “Select All” on 
. To de-select all cues, click in the 
ndow.
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10 CUES

Cues are the active objects of WATCHOUT
on stage, as well as more dynamic behavio
Cues exist on layers in timeline windows. T
order of media on stage.

Adding Cues To add a cue to a layer in a timeline windo
a media file, to the layer or the Stage wind
directly from your hard disk.

▲ IMPORTANT: Whenever possible, keep 
a sub-folder of the folder containing the
WATCHOUT to refer to the file using a 
it easier to move the presentation with a

When you drag media into the Stage wind
currently selected layer (as indicated by a re
at the current time position. When dragging
at the layer and time you drag it to.

Selecting and Positioning Cues Click a cue to select it. Shift-click to select m
from a point outside all cues to use the sele
the Edit menu to select all cues on all layers
white space of any layer in the Timeline wi



w image in the Stage window. 
ponds to a particular image on 

mouse. To drag cues to another 
s the Shift key while dragging. 

, go to the desired time position 
39), then paste it. Alternatively, 
ns” on page 156).

rd to select the next or previous 
 Shift key as well selects the next 
and down arrow keys changes 

ove or copy cues within a 
lipboard. When transferring 
dia associated with those cues 
ntation.

lipboard, select the cues then 

ill appear on stage. To change 

w. You can change the stage 
y first selecting those cues. 
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You can also select a cue by clicking its previe
This allows you to determine which cue corres
stage.

To position selected cues, drag them using the 
layer without altering their time positions, pres

If you want to position a cue numerically, cut it
using the Timeline Settings dialog box (page 1
use the cue’s dialog box (see “Cue Specificatio

Selecting Cues using the Arrow Keys Press the right or left arrow keys on the keyboa
cue on the currently selected layer. Pressing the
or previous cue on any layer. Pressing the up 
the currently selected layer.

Cutting, Pasting and Deleting Cues Use Cut, Copy and Paste on the Edit menu to m
presentation or to other presentations via the c
cues to other presentations in this way, any me
will automatically be added to the target prese

To delete cues without altering the content of c
choose “Clear” on the Edit menu.

Changing a Cue’s Media Position 
On Stage

Cues contain information on where the media w
the stage position, do one of the following:

• Drag the preview image in the Stage windo
position of multiple cues at the same time b
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rrow. Add the Shift key for greater 

al Stage Position”. If the cue has a 
e entire motion path.

een points.

en track, click the desired tween 
mage using the mouse or the arrow 
tly at the tween point, a new point 

ps to Time” is selected on the Time-

of multiple cues using the Move 
ly useful when merging cues from 
.

wn numerically in its Position tween 
age” on page 57. 

ag the bar at either end of a cue. If 
tationary in relation to the timeline. 
ess the Alt key while dragging the 

 the current time position if “Snap” 
or this to work, you must first 
meline menu.
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• For precise adjustments press Control-a
increments. 

• Double-click a cue and change its “Initi
Position tween track, this will relocate th

• Double-click one of the cue’s Position tw

▲ IMPORTANT: If a cue has a Position twe
point to go to its time before moving the i
keys. If the timeline isn’t positioned exac
will be added. This assumes “Click Jum
line menu.

◆ HINT: You can move the stage position 
command (page 117). This is particular
shows having different display positions

The stage position of the anchor point is sho
track, if any. See “Positioning Media on St

Changing a Cue’s Duration To change the duration of selected cues, dr
the cue has tween points, they will remain s
To stretch the tween points with the cue, pr
end of the cue. 

◆ HINT: Either end of the cue will snap to
is selected (see “Snap” on page 120). F
deselect “Click Jumps to Time” on the Ti

Drag either end to change the 
duration of all selected cues.



duration into the cue’s dialog 

e beyond its natural duration, it 
tively, you can make the movie 

Loop” behavior in the cue (see 

g new media onto the cue. You 
, or a new media file from your 

f a certain media file, you can 
e Media window instead, as 
tion” on page 97. Doing so will 
em.

tions available vary with the 
open a cue’s specifications 
cations” on the Edit menu, or 
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To set the duration precisely, type the desired 
box (see “Cue Specifications” on page 156).

◆ NOTE: If you extend the duration of a movi
will by default stop at the last frame. Alterna
run repeatedly in a loop by choosing the “
“Loop” on page 158).

Replacing a Cue’s Media To change the media associated with a cue, dra
can drag either an item from the Media window
hard disk.

◆ HINT: If you want to replace all instances o
change the file association of the item in th
described under “Changing the File Associa
affect all cues associated with that media it

CUE SPECIFICATIONS Specifies the settings of the current cue. The op
kind of media that is controlled by the cue. To 
dialog box, select the cue and choose “Specifi
simply double-click the cue.
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How long the media remains 
visible on stage.

Media will be pre-rolled auto-
matically (uncheck to specify 
pre-roll time manually).

Loop sound or movie when 
cue is extended past media’s 
natural duration.

Locates associated item in the 
Media window.

Calculates top-left or center 
position for anchor point.

Rotates image automatically 
as it moves along a motion 
path.
Chapter 10     Cues

The time when the media will 
appear on stage.

Starting offset into sound or movie.

Continue to play even if timeline 
stops.

Controls the stage window 
preview quality of this cue.

Position of anchor point within 
image, relative to image’s top left 
corner.

Stage position of anchor point at 
the start of the cue.



. For example, a certain movie 
. To skip those ten seconds, set 

rom its beginning) when played 
hort, cyclical animations, where 

e duration of the cue must be 
, or made free-running.

continue to play even if the time-
aker support or conference situ-
manually. While waiting at a 
ng moving on stage.

rs can be combined to create 
tion. 

 few seconds ahead of its 
e is calculated automatically. 

sive computer resources when 
already visible, moving media. 
to reduce the impact by moving 
wards to a more appropriate 
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In-Time Specifies a starting offset for a sound or movie
may have ten seconds of black at the beginning
the in-time to 10.

Loop Causes sound or movie media to loop (re-start f
past its duration. This is particularly useful for s
the movie then contains only a single cycle.

◆ NOTE: To see the effect of this behavior, th
extended past the media’s natural duration

Free Running Causes sound, movie or composition media to 
line is paused. This is particularly useful in spe
ations, where you may be cueing the timeline 
pause cue, you may still want to have somethi

◆ HINT: The Free Running and Loop behavio
continuous playback of undetermined dura

Pre-Roll Video needs to be pre-loaded and prepared a
appearance. When set to “Automatic”, this tim
This is the appropriate setting in most cases.

However, certain video files may require exten
prepared. This may have an adverse effect on 
Although this is unavoidable, you may be able 
the moment when the preparation occurs back
time.
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, a pre-roll indicator appears in the 
 dragging the start of this indicator.

iew quality. Set to “Reduced” to 
to “None” to suppress preview 
Best Quality”, the name of the cue 

 constrained by the setting on the 
n page 125). The cue setting speci-
ue will be previewed.

indow, automatically opening any 

ield controls its media position on 
first tween point. Changing this 
y.

aths of a set of cues, first select the 
u.
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When specifying the pre-roll time manually
timeline window. Adjust the pre-roll time by

Stage Preview Controls the maximum Stage window prev
preview the image using its thumbnail. Set 
altogether. When set to anything besides “
is shown in italics to indicate this.

◆ NOTE: The preview quality is ultimately
Preview menu (see “Preview Quality” o
fies the maximum quality by which the c

Locate Media Locates the associated item in the Media w
folder it may be stored in.

Initial Stage Position If the cue has no Position tween track, this f
stage. Otherwise, this is the position of the 
position moves the entire motion path, if an

◆ HINT: To move the position and motion p
cues, then choose Move on the Edit men

Pre-roll indicator. Drag to change 
pre-roll time.



ion direction at any given time. 
uld always point along the path 
 on page 68).

lative to the upper left corner of 
layed as a crossed circle in the 
age, the anchor specifies the 

low shows the behavior of an 
or point.

 box determines the initial posi-
“Center Anchor Automatically” 
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Auto-orient along Motion Path Causes an image to rotate according to its mot
This is useful when animating an object that sho
of motion, such as an airplane (see illustration

Anchor Position Determines the position of the image anchor, re
the image. The anchor of a selected cue is disp
Stage window. When scaling or rotating an im
point that remains stationary. The example be
image transformed relative to a centered anch

◆ HINT: A checkbox in the Preferences dialog
tion of the anchor point for new cues. See 
on page 113.

Scaling and rotating an 
image around its anchor 
point.
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dia on stage over time. Depending 
e, you can add one or more tween 
rop, Color and Tint apply to 
io media. Most tween tracks also 

tween track. See also “Tween 
w to use tween tracks in general.

rnal inputs, or by a combination of 
dicated by a round formula button, 
ntrolling Tween Tracks” on page 
Chapter 10     Cues

TWEEN TRACKS Tween tracks control the appearance of me
on the type of media associated with the cu
tracks. Opacity, Position, Scale, Rotation, C
images. Volume applies to movies and aud
apply to composition cues.

The following pages describe each kind of 
Tracks” on page 61 for more details on ho

External Control of Tween Tracks Some parameters can be controlled by exte
tween track and external input. Those are in
as shown in the illustration above. See “Co
176 for more details.

To add or remove a tween track, 
first select the cue then choose the 
desired type on the Tween menu.

Tween tracks of the selected cue 
appear in the tween pane.

Formula button linking the tween 
track to an external control input.



e. To change the opacity, either 
ck, or double-click it to change 
4 for more details.

of the tween point along the 
an occupied by the cue. 

 a corner point into a smooth 

n the cue’s body, allowing you 

 video containing audio. Its 
en point, described above. See 

 the body of a cue assigned to 
e curve even when the cue isn’t 
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Opacity Controls the opacity (transparency) of an imag
drag the tween point vertically in the tween tra
its value numerically. See “Opacity” on page 6

The “Time Position” field specifies the position 
timeline. This must be a time within the time sp

The “Smooth” checkbox allows you to change
point, and vice versa. 

◆ HINT: The opacity curve is also displayed i
to see it even when the cue isn’t selected.

Volume Controls the audio volume of audio media and
behavior is identical to that of the Opacity twe
“Volume” on page 64 for more details.

◆ HINT: The volume curve is also displayed in
an audio media item, allowing you to see th
selected.
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sition (see “Anchor Position” on 

tive to the image’s natural size), or 
gative values flip the image.

track to reduce the size of large im-
isplay). Use an image editing ap-

tead. Using WATCHOUT’s scaling 
impair performance.

alues, first uncheck the “Maintain 
Chapter 10     Cues

Scale Scales an image in relation to its anchor po
page 160).

You can specify either the scale factor (rela
the desired size of the image on stage. Ne

▲ IMPORTANT: Do not use a Scale tween 
ages (significantly larger than a single d
plication, such as Adobe Photoshop, ins
capability to reduce large images may 

To scale the width and height by different v
Proportions” checkbox.

As an alternative to the Scale 
dialog box, simply drag the 
scaling handle. Press Shift to 
maintain the image’s propor-
tions as you drag.

Non-uniform scaling results in a 
split scale curve, allowing you to 
adjust horizontal and vertical 
scaling independently.



sition, drag the image or one of 
indow when the cue is selected. 
e Position tween point and type 
e “Location” field.

 select all the Position tween 
ve command on the Edit menu. 

 into or out from the point. A 
 to move linearly to the next 
r and greater values go faster. 
 motion path (see below), and 
 (visible only for smooth points).

curved motion paths, as shown 
 68. When selected, a direction 
ng the direction of motion into 
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Position Positions an image on stage. To change the po
the motion path handles shown in the Stage w
To set the position numerically, double-click th
the desired position of the anchor point into th

◆ HINT: To move the entire motion path, first
points, then drag the image. Or use the Mo

The “Speed” fields control the speed of motion
value of 1 results in the normal speed required
point. Smaller values make the image go slowe
The speed is indicated by white dots along the
can also be controlled using the speed handles

Moving along a Path The “Smooth” checkboxes allow you to create 
under “Moving Along a Curved Path” on page
handle appears attached to the point, controlli
or out from the point.

Smooth Position tween points 
create a curved path.

White dots along the motion path 
indicate the speed of motion.

Speed control handle.
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see “Anchor Position” on page 
ied number of revolutions or 
example, to rotate 2.5 times, set 

e Stage window or the Rotation 

ate automatically to orient itself 
age 160.

indow may be hidden underneath 
nchor point (see “Anchor Position” 
to adjust the angle instead.
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Rotation Rotates an image around its anchor point (
160). You can rotate the image by a specif
degrees, or a combination of the two. (For 
Revolutions to 2 and Degrees to 180.)

Alternatively, drag the rotation handle in th
tween point in the tween pane.

◆ HINT: You can also make an image rot
along a motion path, as described on p

◆ NOTE: The rotation handle in the Stage w
the anchor point. If so, either move the a
on page 160), or drag the tween point 

Rotate by dragging the handle… …or a rotation tween point.

Anchor 
point.



n image inwards. You can use 
as a creative effect to make text 
example shown below.

 decreasing manner, revealing 

lick a tween point and enter the 
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Crop Use a Crop tween track to move the edges of a
this to remove unwanted parts of an image, or 
or other elements appear gradually, as in the 

Here the right edge of the image is cropped in a
the logo as a wipe effect, from left to right.

◆ HINT: To specify a precise amount, double-c
value as a percentage or in pixels.

Adjust the cropping by dragging 
the tween point corresponding to 
the desired edge, or double-click 
the point to set its value numerically.
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all color of an image. The colors in 
 choose. You can think of the Color 
minating the image. Normally, the 
ing the brightness or color of this 
rightness or color of the image.

line and choosing “Color” on the 
fault color is white, as indicated by 
ck name. Click this swatch to 

 specify the color. Choose among 

icking a hue (a specific color) and 
olor) and brightness of the color. 
any artists and painters.
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Color Use a Color tween track to specify the over
the image will be multiplied by the color you
tween track as the color of a light source illu
color of this light source is white. By chang
light source, you can influence the overall b

Start by selecting an image cue on the time
Tween menu to add the tween track. The de
the small color swatch next to the tween tra
change the color.

This brings up a dialog box allowing you to
the following color models:

• HSB Sliders specifies the color by first p
then the saturation (the amount of that c
This intuitive color model is familiar to m

Click this button to change the 
color.



ditive method based on the 
een and Blue. This color model 
puter background.

tractive method, where you 
t of Cyan, Magenta and Yellow 

 you come from a lighting back-
trol the color of a light.

methods you use to specify the 
ar to you.
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• RGB Sliders specifies the color using an ad
amount of the three primary colors Red, Gr
is often familiar to users with a web or com

• CMY Sliders specifies the color using a sub
specify the filter density of an imaginative se
filters. This model may be familiar to you if
ground, where filters are often used to con

◆ NOTE: It doesn’t matter which of the three 
color. Use the method that feels most famili

Choose a color model.

Specify the color with the sliders, or 
numerically in the text fields.

This swatch indicates the resulting 
color.
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ly changing the Hue has no effect 
ightness greater than zero. Watch 
e sliders to see the resulting color. 

e color as applied to the image.

s to open the Color tween track to 

its value numerically. As the hue is 
an use this method to create 
rough several revolutions.

◆ NOTE: The sub-
tracks always use 
the HSB color 
model. 
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When using the HSB model, note that mere
unless you also specify a saturation and br
the “Resulting Color” swatch as you drag th
The preview in the Status window shows th

An alternative way of specifying the color i
reveal its sub-tracks.

◆ HINT: Double-click a tween point to set 
specified by its color wheel angle, you c
rainbow cycles by making the hue go th

Click to reveal the sub-tracks.

Set the color by manipulating the 
individual sub-tracks.

This method provides more 
precise control over the color.



. You can think of the Tint tween 
y paint added to the image. 

t no color is added.

 tween tracks is to say that the 
reas of the image, while the Tint 

t on the same image.

ethods as described above for 
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Tint Use a Tint tween track to add color to an image
track as specifying the color of translucent spra
Normally, the Tint color is black, meaning tha

Another way of contrasting the Color and Tint
Color tween track primarily affects the bright a
tween track mainly affects the dark areas. 

◆ HINT: You can combine both Color and Tin

Specify the color to be added using the same m
the Color tween track.
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elines. The cue is performed when 
 be used to make a timeline pause, 
name). To create a Control cue, 
 menu (see page 138).

 loops – causing a section of the 
u have the option of automatically 
 case, it is often a good idea to 
 the display computers to catch up 
p-to-Run Delay” field.

Name of auxiliary 
timeline to control.

Makes timeline jump to a 
time position or a named 
Control cue.

Jumps backwards only 
when jumping to a 
named cue.

Introduces a delay 
between the jump and the 
restart.
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CONTROL CUE The Control cue governs the behavior of tim
the timeline runs past it. The Control cue can
or jump to another position (by time or by 
choose “Add Control Cue” on the Timeline

Creating Loops You can use the “Jump to” option to create
timeline to be repeated. When jumping, yo
restarting the timeline after the jump. In this
introduce a delay of a second or so to allow
before starting. This is done using the “Jum

Cue name. Used to jump to a 
named position. Name cues F1 
through F12 to use function keys.

Control the enclosing timeline or 
another, specified timeline.

Time position or Control cue 
name to jump to.

Makes the timeline stop, pause or 
run (possibly after jumping). 



described below, possibly in 
Standby” on page 124).

ee-running and looping compo-
ter control over the loop exit. To 

Chapter 10). 

81).

 make the composition loop.

oop. 

oping composition cue.

nd position auxiliary timelines. 
cue, then enter the name of an 

se “Timeline Settings” while its 
e name of an auxiliary timeline 
ou will break the connection.

 command to locate a position 
re allows you to instantly jump 
. To use this feature, simply 
 example on the previous page.

 is case sensitive. When using 
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To exit such a loop, use the QuickFind feature 
conjunction with the Standby command (see “

Another option for creating loops is to use a fr
sition. While slightly more complex, it gives bet
use that method, proceed as follows:

• Put the entire loop into a composition (see 

• Start it using a composition cue (see page 

• Select Loop and Free Running in the cue to

• Make the Main Timeline pause during the l

• To continue after the pause, fade out the lo

Controlling Other Timelines A Control cue can also be used to start, stop a
To do so, select “Tell Timeline: Named” in the 
auxiliary timeline into the field.

◆ HINT: To name an auxiliary timeline, choo
timeline window is open. Do not change th
after creating control cues targeting it, or y

Using Find and QuickFind Named Control cues can be used with the Find
along the timeline by name. A QuickFind featu
to positions using the computer’s function keys
name the Control cues “F1”, “F2”, etc, as in the

▲ IMPORTANT: The Control cue’s name field
function key names, type an upper case F.
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S 11

n WATCHOUT and other external 
 such as DMX-512, MIDI, TCP/IP 
teract with the presentation envi-

d. Those signals can then be used 
TCHOUT by starting and stopping 
rameters.

ow using the Window menu, then 
ted in the upper right corner of the 
put chosen, this displays a dialog 
 See the following sections for 

r other suitable MIDI interface) on 
any newer devices come with a 
 often use a standard 5-pin DIN 
o-USB adaptor, or other Windows-

 MIDI interface and devices to your 
UT production software.
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11 INPUTS AND OUTPUT

Inputs and outputs act as gateways betwee
devices. Using industry-standard protocols,
and Serial data communication, you can in
ronment in many creative ways.

INPUTS Inputs receive signals from the outside worl
to control and influence the behavior of WA
timelines and by controlling various cue pa

To create an input, first open the Input wind
choose “Add...” from the pop-up menu loca
Input window. Depending on the type of in
box allowing you to enter its specifications.
details on the various kinds of inputs.

Connecting a MIDI device Connect your MIDI device to a USB port (o
your WATCHOUT production computer. M
direct USB connection. Older MIDI devices
connector, in which case you need a MIDI-t
compatible MIDI interface.

▲ IMPORTANT: Turn on and connect your
computer before starting the WATCHO

Click this button to add an input.

MIDI-to-USB 
adaptor.



er from a keyboard, or similar 
are. This type of MIDI data is 
ler”,  “Control Change” or “CC” 

number to use, if you know 
ller.

DI protocol is often not the same 
ice. Furthermore, many devices 
al controller number may vary 

ow for a fact that the controller 
e resolution being used, 
 a number in the range 0 

Value column.

” and move the 
 pick up the channel and 
mbers automatically.
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MIDI Controller Input A MIDI Controller Input brings in a knob or slid
signal from a MIDI-compatible device or softw
sometimes referred to as a “Continuous Control
message.

Enter the MIDI channel number and controller 
them. If not, click “Learn” and move the contro

◆ NOTE: The controller number used in the MI
as any number next to the knob on the dev
have programmable controllers, so the actu
depending on the device’s configuration.

Do not select “Resolution: High” unless you kn
transmits high resolution data. Regardless of th
WATCHOUT normalizes all controller inputs to
through 1, as indicated in the Input window’s 

The name used to refer to 
this input in expressions.

Channel used for the message.

MIDI controller number.

Data resolution for the controller 
(usually 7 bits).

Click “Learn
controller to
controller nu

A MIDI device with controller 
knobs and note keys.
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r dialog box. Verify proper opera-
nd observing the bar graph in the 

 messages, often referred to as 

og box, Verify proper operation of 
 the bar graph in the Input window. 
velocity is indicated by the magni-

Indicates the current 
controller input value.

arn” and press the key to 
the channel and note 
 automatically.
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When done, click OK in the MIDI Controlle
tion of the input by moving the controller a
Input window.

MIDI Note Input A MIDI Note Input brings in MIDI keyboard
“Note On/Note Off” messages.

When done, click OK in the MIDI Note dial
the input by pressing the key and observing
If the keyboard has velocity sensitivity, the 
tude of the value.

The name used to refer to 
this input in expressions.

Channel the message is sent on.

MIDI note number.
Click “Le
pick up 
numbers



X channel. DMX-512 is a 
ers, moving lights and other 

eive DMX data using the Artnet 
). Many modern lighting 

ork. In other cases, a DMX-to-
you need to know the DMX 
, as well as the Artnet Universe 

t specific Artnet Universe 
the Preferences dialog box (see 

When done, click OK in the 
peration of the input by moving 
ing the bar graph in the Input 
 to a number in the range 0 
Value column.

d by the WATCHOUT 

 of cues, similar to the way 
ontrol over the Opacity, 
use this capability, first add the 
k the formula button located in 
eed to click the triangle in the 
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DMX-512 Input A DMX-512 Input brings in the value of a DM
protocol used by most lighting consoles, dimm
similar devices.

WATCHOUT uses the computer network to rec
protocol (see http://www.artisticlicence.com/
consoles can send Artnet over an Ethernet netw
Ethernet adapter must be used. In either case, 
channel number(s) to be used for WATCHOUT
number used to send those channels.

You must configure WATCHOUT to receive tha
number. This is done under the Control tab in 
“DMX-512 Universe” on page 114).

Add a “DMX-512 Input” to the Input window. 
DMX Channel dialog box, and verify proper o
the fader for the specified channel and observ
window. WATCHOUT normalizes DMX values
through 1, as indicated in the Input window’s 

◆ NOTE: DMX-512 communication is handle
production software.

Controlling Tween Tracks Inputs can be used to control some parameters
tween tracks are used. This provides external c
Volume, Fade, Color and Tint parameters. To 
desired type of tween track to the cue, then clic
the header area of the tween track. You may n

DMX-to-Ethernet adapters from 
Enttec and Kissbox.

http://www.artisticlicence.com/
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utton. Some tween tracks have 

log box allowing you to enter the 
sists only of the TweenValue item. 

elf. To control the parameter using 
t instead.

A red tween track 
curve indicates that 
the parameter is over-
ridden by a formula.
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tween track header to reveal the formula b
multiple controllable parameters. 

Clicking the formula button brings up a dia
control formula. By default, the formula con
This identifier represents the tween track its
an input, simply enter the name of the inpu

The formula button allows you 
to control a parameter using 
an input. The button turns 
yellow to indicate that such 
control is in effect.

Enter the name of an input to 
control the parameter using that 
input. This example uses a MIDI 
controller, as shown on 
page 174. Or enter a formula 
combining inputs, numerical 
constants, operators and the 
original TweenValue. See 
“Expression” on page 188 for 
more details.



ine by entering the name of the 
.

ll be started whenever the value 
ecomes non-zero. You can 
tering a more complex formula 
d operators. See “Expression” 

time to prepare before they will 
enerally a good idea not to put 
ary timeline. Leave about a sec-
eline.

task – not to stop it. To stop a 
ining a control cue that targets 
nd task using the desired condi-
page 172 for more details.

A red border around the 
field indicates an error in 
the formula.
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Triggering Tasks You can use an input to start an auxiliary timel
input in the Trigger column of the Task window

Press Enter to complete the formula. The task wi
of the formula entered in the Trigger column b
create more elaborate starting conditions by en
including multiple inputs, numeric constants an
on page 188 for more details.

▲ IMPORTANT: Most media cues need some 
appear properly on stage. Therefore, it is g
such cues at the very beginning of an auxili
ond or so empty at the beginning of the tim

◆ HINT: You can only use a trigger to start a 
task, use another task with a timeline conta
the timeline to be stopped. Trigger this seco
tion. See “Controlling Other Timelines” on 

Click in the Trigger column of a 
task to enter its starting condition.
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nd systems from WATCHOUT. To 
e upper right corner of the Output 

 Window” on page 99).

e a cue for an output, drag the 
line.
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OUTPUTS Use Outputs to send data to other devices a
create an output, click the menu button in th
window and choose “Add...” (see “Output

Creating Output Cues Outputs are controlled using cues. To creat
output from the Output window onto a time

Drag an output to a timeline to 
create a cue for it.



 other devices which accept the 
umber to use in the dialog box, 
criptive name.

mit DMX data on the Artnet 
ntrolled. This is done under the 
“DMX-512 Universe” on page 
ust be in the same Artnet 

thernet connector accepting the 
 interface, as shown under 

 cue, created by dragging the 
his cue contains a single tween 

olled while the cue is active. 
n Fade cues will not change the 
duration of a timeline, the Fade 
eline.

he same output at the same time 
hest value will be chosen.
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DMX-512 Output Use a DMX-512 Output to control lighting and
DMX-512 protocol. Specify the DMX channel n
as shown to the left, and give the output a des

You must also configure WATCHOUT to trans
Universe number used by the device(s) to be co
Control tab in the Preferences dialog box (see 
114). All devices controlled by WATCHOUT m
universe.

If the devices being controlled don’t have an E
Artnet protocol, you need an Ethernet-to-DMX
“DMX-512 Input” on page 176.

A DMX-512 Output is controlled using a Fade
output onto a timeline, as seen on page 179. T
track, allowing you to control the DMX output.

◆ IMPORTANT: The DMX output is only contr
Jumping to positions on the timeline betwee
output. To control an output over the entire 
cue must have the same duration as the tim

◆ NOTE: If you have multiple cues controlling t
(for example on separate timelines), the hig
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ccepts text strings or other discrete 
ort. For example, you can tell a 
mmand through a serial port on its 

 the IP number (or DNS name) and 
 You must also specify a protocol 
y many simple devices, while TCP 
s. When using the TCP protocol, 

ot already open), send the data 
ut a minute of inactivity.

The settings in this part of the 
String Output dialog box are 
specific for the kind of port 
selected on the menu above.
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String Output Use a String Output to control devices that a
data packets through a serial or Ethernet p
projector to power down by sending it a co
display computer.

Using a Network Port When using a network port, you must know
port number of the device to be controlled.
type. UDP is a rudimentary protocol used b
is more common on computer-based system
WATCHOUT will open the connection (if n
packet, and close the connection after abo

Select the kind of data port to use 
on this menu.

For a network port, enter its IP 
address and port number here.

Select the desired IP protocol.



COM1 port on any display 
 the pop-up menu in the String 
rity mode according to the 

 and wiring, see

ect a display computer that has 
erial port available, and set its 
munications parameters 
ording to the specifications of 
 device to be controlled.
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Using a Serial Port To use a serial port, connect the device to the 
computer, and select that display computer on
Output dialog box. Select the data rate and pa
specifications of the device being controlled.

For more details on serial data communication

http://en.wikipedia.org/wiki/Serial_port

http://www.airborn.com.au/rs232.html

Sel
a s
com
acc
the

http://en.wikipedia.org/wiki/Serial_port
http://www.airborn.com.au/rs232.html
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 Cue, created by dragging the 
ut Cues” on page 179).

eline plays across the cue. It is not 
Chapter 11     Inputs and Outputs

Sending a Data String A String Output is controlled using a String
output onto a timeline (see “Creating Outp

◆ NOTE: The data is sent only when the tim
sent when jumping to or past the cue.

Name the cue to state its purpose.

Enter the data to send to the device 
here. This can be plain text, hexa-
decimal data bytes, or a combina-
tion of both. Prefix each two-digit 
hexadecimal byte with a $-sign.
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IONS 12

iple auxiliary timelines, and to 
ressions. Auxiliary timelines 

ut can be started and stopped 

stage, those images will appear on 
in timeline. You can control the 
rrent auxiliary timelines interact by 
he Task window.

Click to add more tasks.

Task’s triggering expression.
Chapter 12     Tasks and Expressions

12 TASKS AND EXPRESS

The Task window allows you to create mult
specify their triggering conditions using exp
behave very much like the main timeline, b
independently.

If an auxiliary timeline displays images on 
top of any images originating from the ma
order in which images from multiple, concu
dragging the tasks to the desired order in t

Drag a task towards the top of the 
Task list to make its images appear 
in front of other tasks’ images.

See “Task Window” on page 100 
for more information.



ts associated auxiliary timeline.

ist by first opening the auxiliary 
gs” on the Timeline menu.

:

 this mode, the timeline doesn’t 

is mode, the time isn’t moving, 
es contribute to the stage.

ng the buttons either in the Task 
auxiliary timeline window.

 timeline to run it. Just click its 
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AUXILIARY TIMELINE Double-clicking an item in the Task list opens i

◆ HINT: Change the name shown in the Task l
timeline and then choosing “Timeline Settin

Starting and Stopping Manually An auxiliary timeline has three primary modes

• Stopped (red stop button is illuminated). In
contribute to the stage.

• Paused (neither button is illuminated). In th
but any cues at the current time position do

• Playing (green play button is illuminated).

You can control these modes manually by clicki
window or in the lower left corner of an open 

◆ NOTE: You don’t need to open an auxiliary
play button in the Task window.

Double-click the task name to open 
its timeline.

Click here to start, stop or pause 
the auxiliary timeline…

…or click here after opening its 
timeline window.
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timeline using an external signal, 
. For details on how to configure 
 page 178 describes how you use 
tarted when the value of the trig-
expression may combine multiple 
Expression” on page 188). For 
es above 50%, enter an expression 

en the value of the expression goes 
rder to trigger the task again, the 

 stop or pause an auxiliary timeline 
er Timelines” on page 172.

eline from an auxiliary timeline. 
 can control the Main Timeline.
Chapter 12     Tasks and Expressions

Starting from an Input Alternatively, you can trigger an auxiliary 
brought in as an input in the Input window
inputs see page 173. “Triggering Tasks” on
an input to trigger a task. The task will be s
gering expression becomes non-zero. This 
inputs and constants using operators (see “
example, to trigger a task when the input go
such as this one:

ModWheel > 0.5

◆ NOTE: The task will be triggered only wh
from being zero to being non-zero. In o
value must first return to zero.

Starting from Another Timeline You can use a Control cue to position, start,
from another timeline. See “Controlling Oth

◆ NOTE: You can not control the Main Tim
Only Control cues on the Main Timeline

To see the current value of an 
expression, point at the expression 
using the mouse.



ter playing to its end.

e using the Timeline Settings 
uxiliary timeline’s window is 

meline itself, or on another time-
isappear from the stage.

la, combining values such as 
in a way that yields a numeric 

 under “Triggering Tasks” on 

en Tracks” on page 176).

 a single value, such as an input 
ame “ModWheel” exists in the 
 page 174):

f the Task window, that task will 
es non-zero (that is, when the 
is moved from its zero position).

 for an Opacity tween track, the 
n wheel (that is, the value of the 
188 Chapter 12     Tasks and Expressions

Stopping an Auxiliary Timeline An auxiliary timeline will stop automatically af

◆ HINT: Set the length of an auxiliary timelin
command on the Timeline menu while the a
active.

Alternatively, use a Control cue (either on the ti
line) to stop it. When stopped, its images will d

EXPRESSION An expression is a simple mathematical formu
inputs and numeric constants using operators 
result. Expressions are used to:

• Start tasks, as described on page 187 and
page 178.

• Influence tween tacks (see “Controlling Twe

In its most basic form, an expression consists of
(this example assumes that an input with the n
Input window – see “MIDI Controller Input” on

ModWheel

If this expression is used in the Trigger column o
be started when the ModWheel’s value becom
modulation wheel on the attached MIDI device 

Likewise, if this expression is used as a formula
opacity will be controlled only by the modulatio
tween track itself will have no effect).
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ultiple values. For instance, in the 
ression so that the modulation 
city tween track by entering the 
 box:

odWheel input with the value 
 the TweenValue identifier, which 
t value. Since both values are in the 
 way will work as desired.

 two values so that the opacity can 
e modulation wheel. This can be 

ge if the tween track or the external 
ack and the input are at their 
n will be 2. However, the opacity 
Chapter 12     Tasks and Expressions

Using Numeric Operators In some cases, you may want to combine m
previous example, you may change the exp
wheel modulates the value of the cue’s Opa
following expression into its formula dialog

This expression combines the value of the M
coming from the tween track itself by using
provides the enclosing tween track’s curren
range 0 through 1, multiplying them in this

Alternatively, you may want to combine the
be controlled by either the tween track or th
accomplished by changing the formula to

TweenValue + ModWheel

Now the resulting image will appear on sta
input says so. Note that if both the tween tr
maximum value, the result of the expressio

Enter an expression for a tween 
track by clicking its formula 
button (see page 177).



gh 1 (as the image can’t be 
ost parameters work in this 

e, as it allows the color wheel to 

ten useful to specify a threshold 
s own, the task will be triggered 
the input to exceed a certain 
o test for this:

 on the left hand side is greater 
e its value is 0. Likewise, if you 
es zero (rather than when it 

e value on the left is the same 

mplex triggering conditions, 
 only be triggered when all 
 using the “and” operator:

wheel is above 50% and the 
iddleC is a MIDI Note input).
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value is effectively clipped to the range 0 throu
more than fully opaque or fully transparent). M
way, with the notable exception of the color hu
be rotated multiple revolutions.

Using Relational Operators When using expressions to trigger tasks, it is of
for the triggering value. If the input is used on it
as soon as the input leaves zero. If you prefer 
value, you can use a “greater than” operator t

ModWheel > 0.5

This operator yields a value that is 1 if the value
than the value on the right hand side, otherwis
want to trigger the task when the value becom
leaves zero), you can write:

ModWheel = 0

This uses the “equals” operator, yielding 1 if th
as the value on the right, else it yields 0.

Using Logical Operators Occasionally you may want to create more co
combining multiple inputs, so that the task will
conditions are met. That can be accomplished

ModWheel > 0.5 && MiddleC

This will trigger the task when the modulation 
MiddleC key is pressed (assuming here that M



191

WATCHOUT, shown in their order 

ulo operator yields the remainder 
erators yield results with fractional 
a) yield 1 if the relation is true, 0 if 
eld 1 for true and 0 for false.

ub-expressions.

Modulo.

l To, Greater Than, Greater Than 
al.
Chapter 12     Tasks and Expressions

List of Operators This is a list of the operators supported by 
of precedence.

Most operators work as expected. The Mod
of an integer division. All other numeric op
digits. All relational operators (<, >, etceter
it is false. Likewise, the logical operators yi

Operator Description

( ) Parenthesis. Used to group s

- Unary Minus.

* / % Multiplication, Division and 

+ - Addition and Subtraction.

< <= > 
>= = !=

Less Than, Less Than or Equa
or Equal To, Equal, Not Equ

&& Logical And.

|| Logical Or.
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NTS A

 to install WATCHOUT on a PC.

 minimum system requirements:

 AMD processor).

s Vista).

slot.

rting DMA transfers.

ve hard disk interface.

ke on LAN”.

with 128 MB of video memory.

/interface.

s Vista Home Basic

nd most recent XP versions).

to mix different kinds of computers 
.

Appendix A     System requirements

A SYSTEM REQUIREME

This appendix lists what you need in order

COMPUTER A WATCHOUT computer has the following

• Intel Pentium 4 at 2 GHz (or equivalent

• USB port.

• 1 GB of RAM (2 GB if running Window

• AGP 4x or PCI Express 16x video card 

• IDE or SATA hard disk interface, suppo

• 100 GB hard disk fully utilizing the abo

• 100 MBit Ethernet port supporting “Wa

• A modern ATI or nVidia graphics card 

• High quality audio output or sound card

• Windows XP Home Edition or Window

• DirectX 9 (included in Windows Vista a

◆ NOTE: It is generally not recommended 
or graphics cards in one display cluster

▲ IMPORTANT: These are mini-
mum system requirements. 
Faster processor, faster mem-
ory, faster hard disk with 
cache memory, faster graph-
ics card with more video 
memory, etc, will enhance 
performance. Some functions 
(for example, live video inte-
gration) require additional 
hardware.



 display computer used to show 
eo input, and its driver software 

ultiple Composite and S-Video 
eo signal standards.

nd Intensity, supporting SDI and 
ndards.

us cards providing basic video 

ter signal inputs. 

 connected using a TCP/IP 

k ports on all computers and a 
number of ports to connect the 
hernet, although this will slow 
does not, however, have any 
ystem.

not recommended for reliability 
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LIVE VIDEO INPUT To integrate live video into WATCHOUT, each
live video must be equipped with a suitable vid
must be installed. Some capture cards support m
inputs, while some support more advanced vid

Suitable video input solutions include:

• Black Magic Design DeckLink HD Extreme a
HDMI signals, including High Definition sta

http://blackmagic-design.com/

• Viewcast Osprey 1xx and 2xx series PCI-b
input capabilities.

http://www.viewcast.com/

• Datapath VisionRGB cards provide compu

http://www.datapath.co.uk/

NETWORK The production and display computers must be
compatible network.

A typical system has 100 MBit Ethernet networ
high-quality Ethernet switch with the required 
computers. It is also possible to use 10 MBit Et
down media file transfers. The network speed 
impact on the runtime timing precision of the s

A wireless network may work, but is generally 
reasons.

http://blackmagic-design.com/
http://www.viewcast.com/pages.asp?page=osprey
http://www.datapath.co.uk/rgbcapturecards.html
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B

y computer outlined in Chapter 2 
me computers require additional 
 This section provides some general 

 a WATCHOUT display computer, 
rd disk and then install only 
TCHOUT. This avoids many prob-
that are often pre-installed on 
over time.

r hard disk in order to use 
edure that helps in obtaining the 
ply all other adjustments described 
 to dedicate the computer to 

ake sure that the hard disk doesn’t 
uld perform a backup if you’re 
hen start the computer from the 
n-screen instructions. Early on in 
 where to install Windows. As part 
e the existing partitions and create 
Appendix B     Computer Issues

B COMPUTER ISSUES

While the basic configuration of the displa
“Installation” is sufficient in many cases, so
work to achieve best possible performance.
hints and pointers on how to proceed.

DEDICATED COMPUTER If you intend to use a computer primarily as
it probably makes sense to re-format the ha
Windows, required device drivers and WA
lems caused by various pieces of software 
computers, or that may have accumulated 

◆ NOTE: You don’t have to re-format you
WATCHOUT. This is an advanced proc
best possible performance. You can ap
in this appendix even if you choose not
WATCHOUT.

Formatting the Disk and Installing 
Windows

To prepare your computer in this way, first m
contain any important information. You sho
unsure about the content of the hard disk. T
Windows installation disk, and follow the o
the installation procedure, you will be asked
of this, you will get the opportunity to remov
new ones, which you should do.



aller (50 GB or so) partition for 
y want to install. This partition 
of the disk unformatted for now.

 created, small partition. Once 
phics or sound card drivers, 
entioned in this appendix.

mat the remaining space of the 
strative Tools > Computer 
the list.

 Partition Wizard”, choose the 
ize” of 32K. Generally, it is OK 
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For best performance, you should create a sm
Windows, and any other applications you ma
will become the C: drive. Leave the remainder 

Proceed with installing Windows on the newly
that’s done, install required device drivers (gra
etc), and perform any additional adjustments m

Installing WATCHOUT Before installing WATCHOUT, you need to for
hard disk. Choose Start > Programs > Admini
Management, then click Disk Management in 

▲ IMPORTANT: On the last page of the “New
NTFS file system with an “Allocation Unit S
to also select “Perform a Quick Format”.

Right-click on the Unallocated 
space and choose “New Parti-
tion”. Proceed with creating a 
primary partition of the maximum 
size.
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ze greatly reduces the tendency of 
ount of wasted disk space. Given 

tend to be rather large, this should 

artition will appear as the D: disk 
isk, and install WATCHOUT to this 
e 17. When given the opportunity 
se the newly created WATCHOUT 

 by numerous small programs and 
rograms consume considerable 
se on a WATCHOUT display 
y identifying and removing, or 

lications or services, first close all 
 choose Programs > Accessories > 
Software Environment, Running 
ht displays all currently running 

ok specifically for tasks whose path 

lly started, choose “Software 
o the left.
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Specifying a larger than usual allocation si
disk fragmentation, at the cost of a small am
the fact that most WATCHOUT media files 
not have any practical disadvantages.

Once the formatting is complete, the new p
drive. Create a WATCHOUT folder on this d
disk using the Installer, as described on pag
to specify where to install WATCHOUT, cho
folder on the D: drive.

GENERAL PERFORMANCE The performance of a PC is often degraded
services running in the background. Such p
system resources, and may serve no purpo
computer. You can enhance performance b
disabling, such programs.

Identifying Background Programs To identify any unwanted background app
open windows then click the Start button and
System Tools > System Information. Select “
Tasks” in the list to the left. The list to the rig
programs (see illustration on page 198). Lo
is anything but “c:\windows\system...”.

To see which programs that are automatica
Environment, Startup Programs” in the list t



s and Startup Programs lists are 
 with a particular program. In 
 program’s file can provide a 
is installed under “c:\Program 
 by looking inside its installation 
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◆ HINT: The names listed in the Running Task
often cryptic, and may be hard to associate
this case, looking at the path leading to the
valuable hint. In particular, if the program 
Files\...”, you should be able to learn more
folder.
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ckground programs, you should 
 you won’t need a background 

 and Features” control panel, 
 Follow the subsequent instructions 
.

gram, or if the program doesn’t 
trol panel, you may instead choose 
ith configuration options in the 

this capability, forcing you to either 
her means.

elves by an icon on the taskbar, in 
lick such an icon to open its menu. 
“Close” or “Do Not Load” item. It 
erties” items that allow you to set 
ding of the program at start-up. 

art the computer to verify that the 
s only allow you to disable them 

ext time you start the computer. 
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Removing Background Programs Once you have identified any undesired ba
either remove or disable them. If you know
program, remove it from the computer.

To remove a program, open the “Programs
choose the program, and click “Uninstall”.
on how to remove or uninstall the program

If you’re uncertain about removing the pro
appear in the “Programs and Features” con
to disable it. This can sometimes be done w
program itself. Other programs don’t offer 
uninstall the program or disable it using ot

Background programs often identify thems
the lower right corner of the screen. Right-c
Sometimes the menu includes a “Disable”, 
may include “Open”, “Configure” or “Prop
various options, including the automatic loa
After disabling a program in this way, rest
program is no longer active. Some program
temporarily, and will then load again the n



grams is by using the System 
e Start button and choose Run. 
 the “Startup” tab. You can turn 
ts checkbox.
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Another way to locate and disable startup pro
Configuration utility. To open this utility, click th
Enter “msconfig” into the Run dialog box. Click
off any undesired startup item by unchecking i
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egular programs, but as System 
services by clicking the Services tab 
ious page). This also indicates the 
o not disable services by 
ystem Configuration utility. Instead, 
ools > Services.

ch service. Select a service in the 
ervices, many of which are not 
g WATCHOUT display software. 
ted as “Started”. To disable a 
ype” to Disabled.

ervices do, and which ones you 
of the many web sites dedicated to 
.
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System Services Most background activities are not run as r
Services. You can view the installed system 
in the System Configuration utility (see prev
manufacturer of each service. In general, d
unchecking them in the Services tab of the S
choose Start > Programs > Administrative T

This list provides detailed information on ea
list for a description. There are numerous s
needed on a computer dedicated to runnin
Not all services are running – only those lis
service, double-click it and set its “Startup T

For more information on what the various s
may disable (or set to “Manual”), visit one 
tweaking Windows for better performance

◆ NOTE: If the “Administrative 
Tools” are unavailable, right-click 
the task bar and choose Properties 
to display the “Taskbar and Start 
Menu Properties”. Click the “Start 
Menu” tab. Click the “Customize” 
button. In the list, make sure that 
“System Administrative Tools” (or 
“Display Administrative Tools” if 
using the Classic Start menu) is 
enabled.



g and removing media or other 
 fragmented hard disk signifi-

access and display images and 
optimal working condition. To 
s > Accessories > System Tools 
 analyze your disks, then click 

cation unit size, as described 
6, greatly reduces the tendency 

ons, you should defragment 
e disk into a Windows and a 
should not need to be defrag-
e much.

 disk, do so before you defrag-

e set to run automatically on a 
 feature on a dedicated 
ecide to enable this feature, 
likely to be using your 
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Defragmenting the Disk After using WATCHOUT for some time, addin
files, the hard disk may become fragmented. A
cantly increases the time and effort required to 
video. Defragmenting the disk restores it to its 
defragment your disk, choose Start > Program
> Disk Defragmenter. Wait for the program to
“Defragment Now”.

◆ NOTE: Formatting the disk with a large allo
under “Installing WATCHOUT” on page 19
of fragmentation, but doesn’t eliminate it.

If your computer has additional disks or partiti
those as well. However, if you’ve partitioned th
WATCHOUT partition, the Windows partition 
mented very often, since it really doesn’t chang

If you also want to remove old shows from the
ment the disk (see page 70).

▲ IMPORTANT: The Disk Defragmenter can b
schedule. In general, you shouldn’t use this
WATCHOUT display computer. If you do d
make sure it runs at a time where you’re un
WATCHOUT system.
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ogy in computers and graphics 
omputer and the graphics card 

 One of the more useful utilities 
 of the graphics card is PowerStrip:

rom:
Appendix B     Computer Issues

DISPLAY PERFORMANCE WATCHOUT is based on the latest technol
cards. For this to work optimally, both the c
must be properly installed and configured.
available to verify and control the operation

PowerStrip is shareware, and is available f

http://www.entechtaiwan.net/

http://www.entechtaiwan.net/


y refresh rate of your computer 
 in WATCHOUT (see “Display 

d, driver software and display 
e to you in Windows. In some 
s typically happens if the 
lls the display card that it 

ow you to set other refresh rates 
ws Display control panel. One 
vious page.

tor from telling the display card 
ange of allowable settings. This 
 signal) in the standard, analog, 
y displays. Use a VGA male-to-
ove pin 12 in either end of the 

lays using the DVI connector.

rs, it’s often a good idea to look 
card’s manufacturer or the 
). WATCHOUT also requires 
 Vista. You can download the 
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Display Refresh Rate Settings For optimal results, it is important that the displa
is set at an even multiple of the frame rate used
Framerate” on page 113). Certain display car
combinations may restrict the choices availabl
cases, you may not have any choice at all. Thi
display/projector connected to the computer te
prefers one particular frequency.

Some control panels or utility programs may all
than the ones provided by the standard Windo
such program is PowerStrip, shown on the pre

Another option is to prevent the display/projec
about its capabilities, and thereby limiting the r
can be done by disconnecting pin 12 (the DDC
15-pin, VGA-style cable, used to connect man
female extension cable and disconnect or rem
cable.

◆ NOTE: This method is not available for disp

Display Drivers and DirectX If you run into display problems or system erro
for an updated display driver, either from the 
chipset manufacturer (i.e., ATI/AMD or nVidia
DirectX 9 or later – a standard part of Window
latest version of DirectX from:

http://www.microsoft.com/directx

15
10 6

15 11

Female VGA-style connector.

http://www.microsoft.com/directx
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 cause problems from time to time.

ed with graphics cards or DVD 
ATCHOUT to play back video 
ts). To solve this problem, uninstall 

ponents.

er for the sound card installed in 
ur computer, operating system or 
uld check the sound card manufac-
latest driver version installed – 
layback-related problems.

ver software, avoid installing other 
 often provided that will run as 
 check for and remove such soft-
 drivers (see “Removing Back-

be caused by defect software 
nose. More often than not, it’s 
 the hard disk and re-installing 
 (see “Formatting the Disk and 
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OTHER ISSUES This section lists some other issues known to

MPEG2 Playback Some DVD player programs – often includ
drives – may interfere with the ability of W
content (including some related audio forma
the DVD player application and all its com

Sound Playback You need to install the proper software driv
your computer. The driver received with yo
sound card is usually sufficient, but you sho
turer’s web site to make sure you have the 
particularly if you’re experiencing sound p

When installing or updating sound card dri
associated software. Additional software is
background applications. You may have to
ware after installing/upgrading sound card
ground Programs” on page 199).

Defect Drivers Performance and reliability problems may 
drivers. Such problems can be hard to diag
easier to start from scratch by re-formatting
Windows and required device drivers only
Installing Windows” on page 195).



identical playback computers. 
ing operations on multiple 
ne display computer working 
hers. This, of course, assumes 
ation.

ard disk is to use True Image, 

 to another computer either 

e copies everything on the hard 
OS) or similar upgrade auto-
otherboard upgrades manually 
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CLONING A COMPUTER A WATCHOUT system typically uses multiple, 
Performing the above trouble-shooting and tun
computers is tedious. An alternative is to get o
properly, and then clone its hard disk to the ot
that they all have the same hardware configur

A fast and convenient method for cloning the h
from Acronis:

http://www.acronis.com/

Using this program, you can clone a hard disk
across a network or using a CD-ROM. 

▲ IMPORTANT: While the cloning procedur
drive, it does not perform any firmware (BI
matically. You may need to perform any m
after cloning the disk.

http://www.acronis.com/
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C

y technologies, including CRT, DLP 
, video wall cubes and plasma 
y device that’s compatible with the 

ys on adjacent or overlapping 
ir image reproduction. As the light 
jectors may degrade over time, try 

ghly the same number of hours.

 of display technologies, with 
TCHOUT.

 of being able to reproduce a true 
vironment, such as a planetarium, 
t into WATCHOUT. Without a true 
ray banding of the screen in the 

ors and wall cubes may, however, 
by a professional installer in order 
rgence and image uniformity. Their 
bility.
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C DISPLAY ISSUES

WATCHOUT can be used with most displa
and LCD projectors, LCD and CRT monitors
screens. Generally, you can use any displa
display card in the display computer.

Avoid mixing brands and models of displa
areas, since they most likely will differ in the
intensity and color temperature of many pro
to use projectors that have been in use rou

DISPLAY TECHNOLOGIES The following sections provide an overview
special emphasis on aspects related to WA

CRT-based Displays CRT projectors have the unique advantage
black. This is important in a totally dark en
when using the smooth edge-blending buil
black level, it is often impossible to avoid g
overlap areas.

CRT monitors and CRT-based video project
need extensive adjustment and calibration 
to obtain acceptable color matching, conve
analog nature may also affect long-term sta



c mirror chip to modulate the 
technology has the advantage 
ng-term image stability and reli-
puter connection, such as DVI 

 true black. The poor black level 
ray banding in overlapping 
a totally dark room, and, 
, for example, a shopping mall, 
lem is magnified when using 
 using stronger projectors than 
hting conditions.

me. Modern DLP projectors, 
 Instruments DLP technology, 
tter. 

ith projectors, you get the 
Hence, good contrast and color 
rightness. Hence, choosing a 
n “office grade” projector due 

e level of the former.

el of projector, always perform 
ting conditions. Details vary 
dels, and are not always stated 

ctor may be one of the many 
jectorcentral.com/.
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DLP Projectors DLP (Digital Light Processor) uses a microscopi
light (see http://www.dlp.com/). This display 
of being 100% digital, resulting in excellent, lo
ability – particularly when using a digital com
(see “DVI Connector” on page 211).

An issue with some DLP projectors is the lack of
produced by some projectors often results in g
image areas. This is particularly noticeable in 
conversely, is less of an issue in installations at
a trade-show or similar environment. This prob
very bright projectors on a small screen. Avoid
necessary for your screen size and ambient lig

The contrast ratio has greatly improved over ti
utilizing second generation “black chip” Texas
often provide a contrast ratio of 3000:1 or be

Keep in mind that when using WATCHOUT w
combined brightness from multiple projectors. 
saturation is often more important than high b
“home cinema” projector may be better than a
to the better color fidelity and often lower nois

To determine the suitability of a particular mod
proper tests under realistic screen size and ligh
widely among manufacturers and projector mo
on specification sheets. 

A good starting point when looking for a proje
dedicated web sites, such as: http://www.pro

http://www.dlp.com/
http://www.projectorcentral.com/
http://www.projectorcentral.com/
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in many ways similar to DLP projec-
ges and disadvantages. Instead of 
ojector uses a pass-through “filter” 
ure of this technology means some 
nt than DLP projectors, and exhibit 

ck level. The problem is often even 
DLP projectors, and there’s a wider 
f LCD chip manufacturers. Always 

en size and ambient lighting condi-
use in the final presentation. Some 
ors, checkerboards and gradients 
tors (see page 214).

very good color matching, bright-
hen using a DVI cable. However, 

arger display areas, bear in mind 

l image quality when viewed from 
you move off-center. Often, the 
ntally than when moving vertically 

le, landscape-oriented, LCD 
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LCD Projectors LCD (Liquid Crystal Display) projectors are 
tors, and share many of the same advanta
bouncing the image off a mirror, an LCD pr
to modulate the light. The more analog nat
LCD projectors may require more adjustme
less long-term stability.

Many LCD projectors suffer from a poor bla
more noticeable on LCD projectors than on 
span of variation due to the large number o
make realistic tests under the expected scre
tions. Use images of the kind you intend to 
test images with white, black, saturated col
are often useful too when evaluating projec

LCD Display Panels Modern LCD display panels typically have 
ness and long-term stability – particularly w
when using multiple LCD displays to build l
the sometimes limited viewing angle.

Many LCD displays are designed for optima
the front, with image quality degrading as 
viewing angle is better when moving horizo
(as would be the case when placing multip
displays in a column).



mputer, keep the following in 

e, place the display computer 
e same outlet.

u use high-grade extension 

nalog 15-pin, VGA-style 
er possible, use DVI to connect 
s many of the analog-to-digital 

-style interface. If required, DVI 
le from Gefen (http://
.com/) and others.

s a common way of interfacing 
 referred to as a “VGA 

solution displays, such as XGA. 

 and distribute the signal, using 
As) available from many manu-

o susceptible to hum and noise 
on artefacts. This can result in 
ome of this may be reduced by 
 device and/or display card.
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WIRING When connecting the display to the display co
mind:

• Keep analog (VGA) cables short. If possibl
close to the display, powering both from th

• If you must extend the cable, make sure yo
cables and distribution amplifiers.

Usually, the display is connected by using an a
connector or a digital DVI connector. Whenev
the display computer to the projector. This avoid
conversion problems associated with the VGA
cables can be extended using products availab
www.gefen.com/), Extron (http://www.extron

15-pin Mini D-sub Connector The 15-pin mini D-sub connector (page 204) i
a computer to a display device. Although often
connector”, it is also used to connect higher re

Advantages include the ability to easily extend
extension cables and distribution amplifiers (D
facturers. 

Due to the analog nature of the signal, it is als
as well as signal interpretation and digitalizati
pixel jitter and poor or varying color fidelity. S
careful adjustment and tweaking of the display

http://www.gefen.com/
http://www.gefen.com/
http://www.extron.com/
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w.ddwg.org/) connector is 
o projectors. As the data to be 
little sense to convert the signal to 
ctor, and then convert it back to 
e DVI connector solves this by 
 the way.

, no pixel jitter and best possible 
rovided with little, or no, need for 
mage consistency and stability.

 difficult to run long cables or to 
ices. Extension nd distribution solu-
bers are available from numerous 
efen.com/).

nnector in many ways, but is gener-
lutions (for example, 1280 x 720 
u can connect a DVI output to a 

splay or projector used has a major 
vides additional guidance on deter-
isplay related problems.

t of your display computer to deter-
splay technology or by the display 
you see unwanted phenomena in 
T monitor (assuming you can find 
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DVI Connector The DVI (Digital Visual Interface; http://ww
popular on LCD displays and modern vide
displayed is digital to begin with, it makes 
analog, pass it through a VGA-style conne
digital form again in the display device. Th
keeping the signal in the digital domain all

The advantages include a rock-solid image
image and color precision. This is usually p
manual adjustment, resulting in improved i

The high speed digital signal makes it more
distribute the signal to multiple display dev
tions based on CAT-5 cables and optical fi
manufacturers (for example, http://www.g

HDMI Connector The HDMI connector is similar to the DVI co
ally limited to carrying video standard reso
or 1920 x 1080 pixels). In some cases, yo
HDMI input using a simple adaptor cable.

GENERAL TROUBLESHOOTING Just like the display computer, the kind of di
influence on the end result. This section pro
mining the cause and possible remedy of d

Before You Begin Connect a regular CRT monitor to the outpu
mine if the problem is introduced by the di
computer. This is a good advice whenever 
the displayed image – always plug in a CR

Digital Visual Interface 
connector.

http://www.ddwg.org/
http://www.gefen.com/


 caused by your display or 
ppendix. If the problem shows 
ead focus on the display 
).

 move smoothly across the 
ther the display computer or the 
 when you view the output from 
 determined that the jerkiness is 
sing.

ou should preferably use a CRT 
ality LCD monitor. Some digital 

own. Also, you may want to un-
e test display while the display 

ay computer, it may sense that 
nge its behavior (for example, 
m you’re troubleshooting to 

ack of synchronization between 
al operation. This is sometimes 
ch as LCD and DLP. It is not a 
nce they’re generally driven 

equencies, it may work best at 
 setting both the display card 
using video optimized for other 
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one). If the problem goes away, it’s most likely
projector, in which case you should read this a
up on the CRT monitor as well, you should inst
computer (see “Computer Issues” on page 195

JERKY MOVEMENTS An image moved using a Position track should
displays. Jerky movement may be caused by ei
display device itself. If the problem goes away
the display computer on a CRT display, you’ve
introduced by the display or projector you’re u

▲ IMPORTANT: When making these tests, y
monitor. If this is not possible, use a good qu
display devices introduce artefacts of their 
plug the problematic display and connect th
computer is running. If you restart the displ
you’ve plugged in another display and cha
its refresh rate), thereby causing the proble
change or disappear.

The most common reason for such artefacts is l
the video signal fed to the display and its intern
a problem with digital display technologies, su
problem with CRT-based computer displays, si
directly by the incoming analog video signal.

Even if your display device supports multiple fr
one particular frequency. You may want to try
and WATCHOUT to 60 Hz/fps even if you’re 
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 frequency of many projectors and 

imal frequency of digital display 
 all capable of synchronizing its 
ncoming video signal. Often, 
tes for moves and other effects can 
 may also try connecting the 
 other means, for example using a 

A.

y device can affect the smoothness 
ATCHOUT, it may have a similar 
resentation. This is often particu-

r in objects moving across.

 makes the video playback look 
xperiencing synchronization prob-
 (see above).
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frame rates, since this is the optimal display
other display devices.

It is sometimes difficult to determine the opt
devices, or whether the display device is at
internal operation to the frame rate of the i
changing the programming to use other ra
make artefacts less obvious. If possible, you
display computer to the display device using
digital DVI cable instead of the analog VG

Dropped Video Frames Just as lack of synchronization in the displa
of positioning and other effects created in W
impact on the video material used in your p
larly noticeable in slow zooms and pans, o

If using a CRT or known good LCD display
considerably smoother, you’re most likely e
lems introduced by the display or projector



s, either within a static image or 

nd gradients, limited resolution 
ar. A good way of testing this is 
example shown to the left. Such 
s such as Adobe Illustrator or 
ages with vertical or radial 

onitor, while exhibiting 
resolution of the display device 
radient. Such problems are typi-
jectors. Often, using a digital 
ce it circumvents the analog-to-
 the loss of definition (see “DVI 

rly near the edges of images – 
e display directly to the 
s has any effect. If so, inserting 
“DA”) may solve the problem. 
 http://www.extron.com/, 
ltinex.com/.

caused by the screen material. 
t projection screens. Such 
ves with you as you walk along 
214 Appendix C     Display Issues

BANDING This section deals with banding in smooth area
in the overlap area of projected images.

Gradients When displaying images with smooth areas a
in the display may cause visible bands to appe
to display a smooth grayscale ramp, as in the 
an image can easily be created in application
Photoshop. You may also want to create test im
gradients.

If such test images appear smooth on a good m
banding using your display device, the signal 
is insufficient to reproduce all the steps in the g
cally associated with low end, office grade pro
interface may avoid or solve such problems sin
digital conversion step, which may be causing
Connector” on page 211).

Another possible cause for banding – particula
is long or faulty VGA cables. Try connecting th
computer using a short VGA cable to see if thi
a VGA distribution amplifier (often called just 
Such devices are available from, for example,
http://www.inlineinc.com/ and http://www.a

Rear Projection When using rear projection, banding may be 
This may also occur when using high-gain fron
banding can be identified by the fact that it mo
the screen.

http://www.extron.com/
http://www.inline.com/
http://www.altinex.com/
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s is to use a different screen mate-
t and rear projection are available 
rs (for example, “Aeroview 100” 
//www.stewartfilm.com/).

 the overlap areas of edge-blended 
 problems:

p. It may be difficult to obtain a 
 types. You may have to locate a 
 your presentation and tweak the 

best possible result (see “Edge 

CD and DLP projectors have a 
of standard curves to choose from. 
htness, such projectors often come 

e. While such a gamma curve may 
linear nature tends to interfere with 
. Furthermore, it also results in 
trast. To avoid this problem, chose 

Photographic” or “Video”.

gray bars (as seen in the test image 
iated with a non-linear gamma. 
r gradient, or a clear distinction 

 the poor contrast ratio of some 
s in the overlaps of black, or very 
 can minimize the effect by 
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The only way to avoid or solve such problem
rial. Suitable low-gain screens for both fron
from most professional screen manufacture
from Stewart Filmscreen Corporation; http:

Edge Blend Areas Banding and other artefacts may appear in
images. There are essentially three kinds of

Too Dark, Bright or Uneven Overla
perfectly invisible edge blend for all image
typical or particularly problematic image in
edge blend curve using that image for the 
Blend” on page 113).

Non-linear Gamma Settings. Most L
gamma curve setting, often with a number 
In order to achieve maximum perceived brig
preset to some high brightness gamma curv
provide some additional brightness, its non-
the ability to achieve a smooth edge blend
washed-out colors and a general lack of con
a more linear gamma curve, often called “

Projecting a grayscale gradient, or a set of 
on page 151) often reveals problems assoc
Attempt to find a setting that shows a linea
between each gray bar.

Gray Boxes in Dark Images. Due to
LCD and DLP based projectors, lighter area
dark images are sometimes inevitable. You



nstance, by switching to a “low 
sing the ambient lighting in the 
void large, dark areas in the 

ge-blend area is often the result 
ctor. 

VI or HDMI interfaces, as those 
d often provide no control over 

ite edge. Put the image on an 
e blend. Adjust the projector so 
ve the horizontal position of the 
t disappears, then move it back 
 to make the right edge of the 
ave to repeat the position and 
nging one may affect the other.

ge shows the top and bottom 
r the image height, but if there 
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reducing the light output of the projectors (for i
brightness” or “economy” mode), or by increa
room. Often, however, the best solution is to a
presentation altogether.

Thin, Dark or Bright Slivers A slightly darker or brighter sliver along the ed
of under or over-shooting the chip in the proje

◆ NOTE: This problem is unusual when using D
interfaces allow direct pixel addressing, an
the image width or position.

Create a test image with a one or two pixel wh
auxiliary timeline set to perform above the edg
that the image exactly fills the image area. Mo
image to the left so the leftmost row of pixels jus
so they reappear. Now adjust the image width
image fit the image area precisely. You may h
width adjustments a couple of times, since cha

Also ensure that the vertical position of the ima
row of pixels. There’s usually no adjustment fo
is, you may want to check that also.



217

center of front or rear-projected 
cross the screen, these bright areas 
ected image. The only way to solve 
erial. Suitable low-gain screens for 
n are available from most profes-
r Projection” on page 214).

s see shades or ridges creeping 
se artefacts are somewhat reminis-
ith slide projectors. They are gener-
he description under “Banding” on 

to use a set of test images with hori-
such an image slowly and look for 
n the same test with a known good 
 same as outlined above under 
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HOT-SPOTS Hot-spots appear as bright areas near the 
images. As you move your vantage point a
tend to move with you in relation to the proj
such problems is to use another screen mat
both front and rear edge-blended projectio
sional screen manufacturers (see also “Rea

CREEPING SHADES When fading an image, you may sometime
across or around smooth image areas. The
cent of the Newton rings sometimes seen w
ally caused by lack of resolution, similar to t
page 214.

The best way to diagnose these problems is 
zontal, vertical and radial gradients. Fade 
bands or rings moving across the image. Ru
display. The solution for this problem is the
“Banding” on page 214.



ptical linearity is important. 
or pin-cushion distortion. This 
hort-throw, wide angle lenses 

e projectors with high-grade 
erly matched for the desired 

be able to obtain better linearity 
he projector accordingly.

re built into WATCHOUT 
ome projectors have similar 
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OPTICAL LINEARITY When using multiple overlapping projectors, o
Deficiencies in optics often show up as barrel 
may be particularly troublesome when using s
(often desirable for rear-projection).

The best way to avoid this problem is to choos
optics, and to ensure that your optics are prop
projection distance. 

◆ HINT: If you’re using zoom lenses, you may 
by changing the focal length and moving t

Correcting Optical Errors If necessary, use the geometry correction featu
(page 146) to compensate for the distortion. S
capabilities built in.

Pin-cushion and barrel distortion.
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UTER PROTOCOLD

 computer from an external device, 
of communicating using the TCP/IP 

lities and commands, this protocol 
r “Display Cluster Protocol” on 
ontrol the production computer, 
ls one or many display clusters, 
ter.

ncludes commands allowing you to

.

e in this way, you must choose 
 box (see “Accept TCP/IP Control 

 to TCP/IP port number 3040 of the 
ommand is then sent as a string, 
r CR/LF pair.
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D PRODUCTION COMP

You can control a WATCHOUT production
such as a touch panel or software capable 
protocol.

◆ NOTE: While similar in its basic capabi
is different from the one described unde
page 223. This protocol allows you to c
while the Display Cluster Protocol contro
with no need for any production compu

The production computer control protocol i

• Load a show from a specified file.

• Start, stop, position and run the timeline

• Access the standby mode.

To control WATCHOUT production softwar
“TCP/IP Network” in the Preferences dialog
of Production Computer” on page 114).

Command Format To control WATCHOUT, open a connection
WATCHOUT production computer. Each c
terminated by a carriage return, line feed o



etimes followed by parameters. 
ODE character format, which is 

SCII characters – such as å, ä, 
mat.

s. Backslash is used as an 
uote in a string, precede it with 
se “\\” inside the string.

formed commands are not 

, an error response is returned:

g>\n

ode number, the second para-
ssage, and the third parameter 
 quoted string.
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A command consists of a command name, som
Commands are encoded using the UTF-8 UNIC
downward compatible with ASCII strings.

▲ IMPORTANT: Commands containing non-A
ü, ç – must be encoded using the UTF-8 for

String parameters are sent within double quote
escape character (that is, to encode a double q
a backslash). To send a backslash character, u

Commands are case sensitive. Successfully per
acknowledged.

Errors If an error occurs while processing a command

Error <uint> <string> <strin

where the first parameter is an internal error c
meter is a quoted string containing the error me
is a copy of the offending command, also as a
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ands, with some commands 
ages.

. The time can be specified in milli-

econds). Alternatively, specify the 
mm”.

error if the cue can’t be found. The 
d is case sensitive.

rameter is true or false (without 

n.

n milliseconds or as a time.

e is case sensitive).

alse.

with optional parameters.

oduction software.
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LIST OF COMMANDS The table below shows the available comm
explained in more detail on the following p

gotoTime Jumps to a time position along the timeline
seconds:

gotoTime 60000

goes to one minute (60000 / 1000 = 60 s
time as a string in the format “HH:MM:SS.m

gotoControlCue Jumps to a named Control cue. Returns an 
name is specified within double quotes, an

gotoControlCue "anders"

standBy Enters or exits standby mode, where the pa
quotes).

Command Parameters Description

run Run timeline from current positio

halt Stop at the current position.

gotoTime <uint> or <string> Go to a time position, specified i

gotoControlCue <string> Go to a named Control cue (nam

standBy <bool> Set the standby mode to true or f

load <string> [<uint> [<bool>]] Load a show from specified file, 

online <bool> Control the online status of the pr



s a quoted string containing the 
cters in Windows path names 
ape character in this protocol. 
 forward slashes instead (as 

.watch"

 production software will auto-

o override the conditional layer 
e, to enable condition 1 and 2 

.watch" 3

orresponding to each desired 

olling whether the production 
e show (default value is true):

.watch" 3 false

ditions, but remains offline.
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standBy true

load Loads a show by name. The name is specified a
full path to the file. The use of backslash chara
conflict with the use of the backslash as an esc
Either double the backslash characters, or use
shown in this example):

load "C:/Samples/ExampleShow

◆ NOTE: When using this load command, the
matically go online after loading the show.

If desired, you can add a numeric parameter t
settings of the show being loaded. For exampl
only:

load "C:/Samples/ExampleShow

The number is a sum of the decimal numbers c
condition, as shown in the table to the left.

The last optional parameter is a boolean contr
software will go online or not, after loading th

load "C:/Samples/ExampleShow

loads the specified show and sets its layer con

Condition Number to Add

1 1

2 2

3 4

4 8

5 16

6 32

…and so on.
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OTOCOL E

isplay computers using a local 
device capable of communicating 
rotocol. 

omputer protocol described in the 
you to control WATCHOUT display 
being present in the system.

re that the show has been success-
ware (meaning that all media files 

ATCHOUT production software.

ing a file stored on the primary 
mmands sent via the network or 

splay computer’s hard disk to auto-
rotocol when starting the display 
 set up a system that automatically 
uter is switched on.

ext editor or word processor 
those commands when starting the 
 the name of this command file as 
oftware. If started using a shortcut 
Appendix E     Display Cluster Protocol

E DISPLAY CLUSTER PR

Overview You can control a cluster of WATCHOUT d
command file or from a computer or other 
using a serial port or the TCP/IP network p

◆ NOTE: While similar to the production c
previous appendix, this protocol allows 
clusters without a production computer 

Preparation Before attempting to control a cluster, ensu
fully run from WATCHOUT production soft
have been transferred, etc). Then quit the W

CONTROL OPTIONS You can control the display cluster either us
display computer in the cluster, or using co
through a serial port.

File-based Control You can use a file stored on the primary di
matically perform most commands in this p
software. This can, for example, be used to
loads and runs a show every time the comp

The command file can be created using a t
capable of saving as plain text. To perform 
WATCHOUT display software, you provide
a command line parameter to the display s



 name of the command file to 

mand file that displays a 
w seconds, loads a show, waits 
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(possibly located in the Startup folder), add the
the Target field of the shortcut.

The example below shows the content of a com
message on the WATCHOUT screen, waits a fe

Enter the name of the command 
file here. This example assumes 
that the file is stored in the folder 
where WATCHOUT is installed.

Make sure this is set to the folder 
where WATCHOUT is installed.
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T display cluster to become ready, 

ill begin shortly"

appendix for details.

ers in the show name (for example; 
 to save the text using the UTF-8 
 usually easiest to rename the show 

uting commands from a such a 
e window. However, to see this 
ATCHOUT display window by 
ur command file doesn’t work as 

a the network, connect to TCP/IP 
T display computers. The computer 

he master of the cluster, and will 
bers, as specified by the presenta-
Appendix E     Display Cluster Protocol

for any other computers in the WATCHOU
and then runs the show.

authenticate 1
setLogoString "The show w
delay 5000
load "MyShow"
wait
run

See each individual command later in this 

▲ IMPORTANT: If using non-ASCII charact
å, ö, ü, ß), your text editor must be able
encoding. If you’re unsure about this, it’s
to avoid non-ASCII characters.

◆ NOTE: Any errors occurring while exec
command file are displayed in a consol
window, you have to close the main W
pressing Ctrl-W. Keep this in mind if yo
expected.

Network Control To control a WATCHOUT display cluster vi
port number 3039 of one of the WATCHOU
you initiate communication with becomes t
automatically control the other cluster mem
tion loaded using the “load” command.



tion. Open the port specified 
TCHOUT will respond with a 
 some other details.

 a serial port, connect the 
 WATCHOUT display 
es the master of the cluster, and 
bers, as specified by the presen-

lPort command to open a serial 
the file-based control feature to 
ed Control” on page 223).

ommands. Some commands 
d of response to the controller. 

xception of the “ping” 
 level. To control WATCHOUT, 

. You can now send other 

y a carriage return, line feed or 
d name, sometimes followed by 
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Use a Telnet program to check the communica
above, then type “ping” and press Return. WA
Ready message, stating its version number and

Serial Control To control WATCHOUT display cluster through
controlling device to a serial port of one of the
computers. The computer you connect to becom
will automatically control the other cluster mem
tation loaded using the “load” command.

No serial port is open by default. Use the seria
port. Put this command into a text file, and use 
perform the serialPort command (see “File-bas

COMMANDS AND RESPONSES WATCHOUT uses a simple text format for its c
may return a reply, error message or other kin
Such responses are also sent as text.

Authentication Before you can give any command (with the e
command), you must specify the authentication
you need authentication level 1:

authenticate 1

WATCHOUT responds with a Ready message
commands.

Command Format Each command is sent as a string, terminated b
CR/LF pair. A command consists of a comman
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 Commands are encoded using the 
 downward compatible with ASCII.

 containing non-ASCII characters – 
ed using the UTF-8 format.

essful. You can explicitly request 
bed under “Command ID Tagging” 

eters are separated by white-
n in square brackets, like this: 
d below.

uotes.

hat is, to encode a double quote in 
nd a backslash character, use “\\” 

nce of decimal digits.

equence of decimal digits, optio-
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parameters. Commands are case sensitive.
UTF-8 UNICODE character format, which is

▲ IMPORTANT: When sending commands
such as å, ä, ü, ç – these must be encod

Responses and Feedback Most commands perform silently when succ
acknowledge from any command as descri
on page 239.

Parameters For commands that take parameters, param
space only. Optional parameters are show
[<uint>]. The parameter types are describe

<string> String parameters are sent within double q

"This is a string"

Backslash is used as an escape character (t
a string, precede it with a backslash). To se
inside the string.

<uint> An unsigned integer, expressed as a seque

123

<int> A signed decimal integer, expressed as a s
nally preceded by a minus sign.

-123

<bool> The keyword true or false, with no quotes.

true



s, with some commands 
 brackets.

ack message to be sent.

er commands [226].

 cue [230].

ning show [231].

go on screen [230].

and file use only) [232].

 established [232].

pecifying its parameters [232].

 [233].
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LIST OF COMMANDS The table below shows the available command
explained further on the page indicated within

Command Description

ping Do-nothing command causing a Ready feedb

authenticate Perform authentication. Required prior to oth

load Load a show and get ready to run [229].

run Start running.

halt Stop running.

gotoTime Jump to a time position [229].

gotoControlCue Jump to the time position of a named Control

enableLayerCond Turn conditional layers on or off [230].

standBy Enter/exit standby mode [230].

getStatus Retrieves name and status of the currently run

setLogoString Display some text next to the WATCHOUT lo

delay Introduces a delay between commands (comm

wait Waits for the entire display cluster to become

serialPort Opens a serial port for control protocol use, s

timecodeMode Activates LTC (SMPTE/EBU) timecode control
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 local file associated with the show 
 feedback may be sent to the host 
 progress (see “Busy” on page 
(see “Error” on page 236). Finally, 
ess of whether any error occurred 

h to the show. The show must be 
n the same folder as the 

e timeline.

faults to true.

. Defaults to true.

ficant bit is condition 1 (see table 

as a string in this format: 
ds.
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load Load a complete show specification from a
name specified by the first parameter. Busy
while loading, informing the host about the
235). If errors occur, Error feedback is sent 
a Ready feedback message is sent, regardl
(see “Ready” on page 234).

load "Phantom"

◆ NOTE: You can not specify a folder pat
present in the “Shows” folder, located i
WATCHOUT display software.

gotoTime Jump to the specified time position along th

gotoTime 5000

Parameter Description

<string> Name of the show to be loaded.

[<bool>] Manage cluster loading and feedback. De

[<bool>] Designate as the master display computer

[<uint>] Conditional layer enable flags, least signi
on page 222).

Parameter Description

<uint> or <string> Time position to go to, in milliseconds, or 
“HH:MM:SS.FFF”, where FFF is millisecon



optional “reverse only” boolean 
ly back in time from the current 
rd then reverse. 

f the timeline. If specified cue is 
and a runtime error message to 

e

hile the layer conditions can be 
parate command allows the 
g another show. The command 
th the same interpretation as the 
and (see table on page 222).

HOUT logo, when shown on 

ay and sound is muted, or 
d (see “Perform Normal/In 
red/exited smoothly, by speci-

ecified, then search both ways.
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gotoControlCue Jump to the time of specified Control cue. If the 
is set to true, it searches for the Control cue on
time position. Otherwise it searches first forwa

The command does not change the run mode o
not found, the timeline’s state will not change, 
this effect will be returned.

gotoControlCue "William" tru

enableLayerCond Change the set of enabled layer conditions. W
specified as part of the load command, this se
layer conditions to be changed without loadin
takes a single, mandatory <uint> parameter wi
conditional layers parameter of the load comm

setLogoString Display the string parameter next to the WATC
screen. See example on page 225.

standBy Enter/exit standby mode. In standby, the displ
media on standby layers – if any – is performe
Standby” on page 93). This mode can be ente
fying a fade rate.

standBy true 1000

Parameter Description

<string> Name of Control cue to look for.

[<bool>] Search in reverse only if true. If false or not sp
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d and enter standby mode. If any 
ormed instead.

luster master. 

true true false 122 true

arameters:

o if not specified.

w loaded.

or any of its slaves is busy 

, 1: Suboptimal, 2: Problems, 3: 

y included if show is active).

luded if show is active).
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Fade out sound and image over one secon
standby layer is available, its media is perf

getStatus Get the current status of the WATCHOUT c

getStatus
Reply "WO2Launch" false 0 

Responds with a Reply with the following p

Parameter Description

<bool> Enter standby if true, exit if false.

[<uint>] Fade rate, in milliseconds. Defaults to zer

Reply Parameter Description

<string> Name of the show. Empty string if no sho

<bool> Busy. True if the master display computer 

<uint> General health status of the cluster; 0: OK
Dead.

<bool> Display is open (in its full screen mode).

<bool> Show is active (ready to run).

<bool> Programmer is on line.

[<uint>] Current time position, in milliseconds (onl

[<bool>] Show is playing – false if paused (only inc



e parameter before performing 
page 225. 

mand file.

blished before proceeding with 
e number of milliseconds speci-
25. 

mand file.

e, setting its parameters.

Port command into a text file, 
rform the commands in this file 

.

is none.
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delay Wait the number of milliseconds specified by th
the next command in the file. See example on 

◆ NOTE: Performed only when used in a com

wait Wait for the display cluster to become fully esta
the next command in the file. Waits at most th
fied by the parameter. See example on page 2

◆ NOTE: Performed only when used in a com

serialPort Open serial port for cluster control protocol us

serialPort true "COM1"

◆ HINT: For serial-only control, put the serial
and use the file based control feature to pe
(see “File-based Control” on page 223).

Parameter Description

<bool> Open (true) or close (false) the serial port.

<string> The name of the serial port.

[<uint>] Protocol selector. Must be 0. Default is 0.

[<uint>] Data rate, in bits per second. Default is 9600

[<uint>] Number of data bits, 7 or 8. Default is 8.

[<uint>] Number of stop bits, 1 or 2. Default is 1.

[<uint>] Parity: 0 = none, 1 = odd, 2 = even. Default 
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isplay computer. The timecode 
oming timecode will control the 

otoTime commands. Furthermore, 
hronized to the timecode.

r possible. Instead, specify the 
ically, the SMPTE 30 (”B&W”) 

on to verify proper timecode recep-
onnector to use for the timecode 
).

de control feature, put this 
nder “File-based Control” on 

computer can’t be used while the 
e, use the corresponding feature of 
ntrolling the Production Computer” 

 = EBU 25 fps, 3 = SMPTE 29.97 
0 (”B&W”).

s a string in this format: 
ds. Default is 0.
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timecodeMode Controls the LTC timecode receiver fo the d
receiver is initially off. When turned on, inc
presentation as if using the run, halt and g
while playing, the presentation will be sync

timecodeMode 2 "-1:00:00"

Avoid using the auto-detect mode wheneve
expected timecode format explicitly. Specif
format can not be detected automatically.

Use the separate Timecode Tester applicati
tion, and to choose the appropriate input c
signal (see “Timecode Control” on page 74

◆ HINT: For stand-alone use of the timeco
command into a text file, as described u
page 223.

◆ NOTE: Timecode control of the display 
production software is online. In this cas
the production software instead. See “Co
on page 74.

Parameter Description

<uint> 0 = receiver off, 1 = auto-detect format, 2
NDF, 4 = SMPTE 29.97 DF, 5 = SMPTE 3

[<int> or <string>] Time offset expressed in milliseconds, or a
“HH:MM:SS.FFF”, where FFF is millisecon



k messages to the controller. 
eive such messages at any time 
mmands.

or occurs. Use the command ID 
ively acknowledged, if desired 
hen using command ID 

ct response to a command will 
nt to the sender of that 

ot directly associated with a 
cently connected or authenti-

sy (as indicated by one or more 
ping” command. 

ndows" true

ginating from the master).
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FEEDBACK The WATCHOUT cluster master sends feedbac
Note that the controller must be prepared to rec
– not only as a direct response to particular co

Most commands execute silently, unless an err
tagging feature to force commands to be posit
(see “Command ID Tagging” on page 239). W
tagging, any feedback message sent as a dire
be tagged by that command ID, and will be se
command.

Any spontaneous feedback message (that is, n
particular command) will be sent to the most re
cated controller.

Ready Sent once when becomes ready after being bu
Busy messages). Also sent as response to the “

Ready "2.0" "WATCHPOINT" "Wi

Feedback Parameter Description

<string> The version of the program.

<string> The name of the program.

<string> The name of the computer/OS.

<bool> License key is up to date.

[<string>] Address of originator (empty or omitted if ori
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asks, such as downloading or 

a/Wilfred.jpg" 76

ay be empty, in which case the 
 for these parameters and just 

erring”). May be empty string.

ce, a file name). May be empty.

 originating from the master).
Appendix E     Display Cluster Protocol

Busy Sent repeatedly while busy doing lengthy t
caching files.

Busy "Transferring" "Medi

Note that either or both string parameters m
controller should retain the previous values
update the progress value.

Feedback Parameter Description

<string> What is being done (for instance, “Transf

<string> The subject of the above action (for instan

<uint> Percentage done so far, 0...100

[<string>] Address of originator (empty or omitted if



esult of a command, or for any 

 the host’s OS. Under 
re, with the error code included 
o an error message string). The 
ation.

inating from QuickTime. This is 
 QT errors use MacOS style 
 error typically originates from 
 opened or played. The third 
offending media file.

Win32 HRESULT).

und during download).
 loading a specification file).
ring.

ero.

ginating from the master).
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Error Sent when any error occurs, either as a direct r
other reason.

Operating System Error Indicates a generic operating system error from
Windows, this is a HRESULT that indicates failu
as the second parameter (possibly decoded int
third parameter may provide additional inform

QuickTime Error Similar to the Operating System Error, but orig
treated separately from the OS errors since the
error codes even under Windows. This kind of
still image files, or from video files as they are
parameter generally contains the name of the 

Feedback Parameter Description

<uint> Error kind:

1 Operating system error (for instance, a 
2 QuickTime error (Mac OSErr style).
3 Rendering API error (that is, DirectX).
4 Network errors (that is, WinSock).
5 File server error (for example, file not fo
6 Syntax/parser error (for instance, when
7 General runtime error – described by st
8 Authentication error.

<int> or <string> Error number or description string. May be z

<string> Excuse or explanation, may be empty string.

[<string>] Address of originator (empty or omitted if ori
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ring. This is similar to other oper-
w that it occurred while rendering. 
isplay card driver issues, video 

tions.

rk communication. This is similar to 
ou also know that it occurred 
mes, network errors are caused by 
s, the computer’s network configu-
r instance, a bad cable/hub or 

e from the media file server. The 
e first Reply parameter in the File 

ly the name of the required file.

ng structured data (such as a show 
ry with the nature of the error. 

ve cases. Always described further 
ll as further information in the third 
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Rendering API Error Error occurred specifically related to rende
ating system errors, except that you also kno
Sometimes, rendering errors occur due to d
memory or other hardware resource limita

Network Error Error occurred specifically related to netwo
other operating system errors, except that y
specifically while using the network. Someti
network interface hardware or driver issue
ration, or problems on the network itself (fo
incorrectly configured router).

File Server Error Error occurred when attempting to get a fil
error number the same as those listed for th
Transfer group. The Excuse string is typical

Syntax/Parser Error Indicates an error that occurred when readi
specification file). Error code and excuse va

General Runtime Error Other errors, not covered by any of the abo
by a string as the second parameter, as we
parameter (optional).



ntext information. For instance, 
r, it may provide information to 

 Video 960 KB"

 this command.

nse sequence failed.

 for port.

only mode.

ginating from the master).
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Authentication Error The second parameter gives further details:

The third parameter may provide additional co
in the case of being in use by another controlle
identify that controller – such as its address.

Warning Sent when a non-critical error occurs.

Warning "Low Memory: Primary

Value Description

1 You have no authority.

2 Your authority is insufficient for

3 In use by another Programmer.

4 Authentication challenge/respo

5 Invalid authentication level.

6 Authentication level not allowed

7 Command not allowed in read-

Feedback Parameter Description

<string> The warning message, as a quoted string.

[<string>] Address of originator (empty or omitted if ori
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ct response to a query command 
231). Use a command ID to posi-
.

s on the command that caused the 

either due to a keyboard or other 
rs.

 a command ID. This is any 
brackets. When used, at least one 
and. The reply is then also tagged 

NT" "Windows" true

ation of commands, or to explicitly 
and.

ing.

 originating from the master).
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Information Sent to convey some general information.

Reply A Reply feedback message is sent as a dire
(for instance, getStatus described on page 
tively associate the reply with the command

The format of the reply parameter(s) depend
reply to be sent.

Quit Sent when the application is about to quit (
command). This message has no paramete

COMMAND ID TAGGING Commands may optionally be preceded by
sequence of characters enclosed in square 
explicit reply is always sent for each comm
with the same ID:

[23]ping
[23]Ready "2.0" "WATCHPOI

Use this feature if you want positive confirm
associate a feedback message with a comm

Feedback Parameter Description

<string> The information message, as a quoted str

[<string>] Address of originator (empty or omitted if
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d 125

st Image command 124
ol 223

eview of 126
d 109
Index

INDEX
A
acceleration 67
Add Composition command 131
adding a control cue 138
adding a display 121
adding a media proxy 128
Adobe After Effects 41
alpha channel 37, 42, 130
anchor point 65
anchor point, in images 113
anti-aliasing 39
audio see sound
Autodesk Cleaner 41
auxiliary timeline 178, 186

settings 139
AVI 39

B
Background Color command 127

batch file 223
Best Quality comman

C
cache folder 70
CachedFiles 70
Clear command 116
Click Selects Frontmo
cluster control protoc
codec 42
color correction 151
color tweening 167
command file 223
composition 77, 131

settings 141
computer screen 131
conditional layers, pr
Consolidate comman
control cue 138
Copy command 116
crop tweening 166



, 143

eferences 112

T 69
0

242 Index

cue 12, 56, 153
adding 91, 153
control 138
cutting 154
deleting 154
duration 59, 155
media position 154
pasting 154
pause 60
positioning 153
replacing media 58, 156
selecting 153
specifications 59, 156
string 183
tween track 61, 161

curved screen 146
Cut command 116

D
DA (distribution amplifier) 21
deinterlace

live video 134

display 143
adding 51, 87, 121
address 144
address prefix, in pr
arranging 51
duplicating 144
DVI 211
geometry 146
installing 19
LCD 209
name 144
online 123
positioning 143
removing 144
selecting 143
specifications 144
stage position 145

display computer 9
connecting to 69
quitting WATCHOU

distribution amplifier 21
DLP projector 208
DMX-512 176, 180
DV 39
DV video format 43
DVI connector 211
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en track 176
8

tion 71

mmand 136

 91

 of 92
Index

E
EBU timecode 74
edge blend 113, 140, 146, 215
edit menu 116
Ethernet 18
Ethernet port 181
expression 177, 188
external control 73

F
file menu 107
find and replace 118
Find command 172
Find/Replace Again command 119
Find/Replace command 118
folder, in media window 136
frame rate 112
free running 158
function keys 172

G
gamma setting 215
geometry correction 146

adding points 150

H
HDMI 211
high definition video 39
hub 18

I
input 173

controlling a twe
starting a task 17

in-time 158
IP address 29

J
jump button 91
jumping, in presenta

L
Large Thumbnails co
layer 58

changing height
collapse 90
condition 93
current 91
deleting 138
disabling preview
inserting 138
locking 92
renaming 138
selecting 91
settings 92, 138

LCD display 209
LCD projector 209
license key 18
live video 133, 134



al frames 41
 48
 40

4

25

DER 72
244 Index

live video input 20
logical operators 190
loop 71, 158, 171

M
Masked by Displays command 125
media 12, 53

adding 53, 96
changing file association 54, 97
changing path to files 118
downloading files 70
dragging to stage 87
editing file 54, 98
locating file 97
opening original 98
positioning 88, 154
proxy 55, 98, 128
purging unused 54
refreshing 54, 98, 136
removing 96
selecting unused 137
thumbnail size 136
window 96

menu
edit 116
file 107
media 128
preview 124
stage 121
timeline 138
tween 142
window 142

message 102
removing 102

MIDI 173
MOV file format 39
movie 39

assembling individu
audio embedded in
computer generated
pre-splitting 44, 129

moving along a path 16
MPEG 39
MPEG-1 42
MPEG-2 43

N
network 9

connecting 18
control 219, 223, 2
requirements 194

NETWORK TRANSPON
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f 71

vies 44

r 127
s 126
mages 125

26

and 121
ers command 126
 8
219
Index

New Folder command 136

O
online 69, 123
opacity 37, 42, 64

tweening 162
Open command 108
operator 191
optical distortion 146, 218
Outline Dimmed Images command 125
output 179

DMX-512 180
serial 182
string 181

output cue, creating 179

P
Paste command 116
pause cue 60
perspective correction 147
PICKUP 11, 72
play 91
Play Audio Media command 126
PNG image files 43
position

animating 66
editing 66
moving along a path 67, 68
tweening of 164

preferences 112
pre-roll 158
presentation

controlling 73
looping 71
making new 107
manual control o
opening 108
saving 108

pre-splitting large mo
preview

background colo
conditional layer
outline dimmed i
stage tiers 126
standby layers 1
wireframe 125

preview menu 124
Preview Scale comm
Preview Standby Lay
production computer

control protocol 
progressive video 40
projection screen 19
projector

DLP 208
LCD 209

protocol 219, 223
proxy 55, 98, 128
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 145
review 57, 88

, 159

7

r 92

78
9, 223
n 38
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246 Index

Q
QuickFind 172
QuickTime

installing 17
obtaining 17

R
reference frame 141
Refresh Media command 98, 136
relational operators 190
rotation tweening 165

S
Save a Copy command 108
Save command 108
scale tweening 163
scaling 64
Select All command 116
Select to End command 117
Select Unused command 137
serial control 73, 114, 226
serial port 182
SMPTE 74
sound

file formats 47
installing 20
multi-channel 20, 47
producing 47
settings 33

Specifications command
speed of motion 67
spherical projection 149
stacking order 140
stage

adding displays 87
adding media 87
background color 1
online 123
positioning displays
positioning media p
preview 121
preview quality 124
scale 87
tier 88, 123
updating 71, 124

stage menu 121
stage window 12, 51, 8
still image

formats 36
producing 36

sun icon, in layer heade

T
task 185

starting from input 1
TCP/IP network 181, 21
text, using in presentatio
Thumbnails command 1



247

161
 62

4

 210
 command 125
plifier 21
Index

tier 123
preview of 126

time scale, adjusting 91
timecode 74, 233
timeline 12, 56

adding cues to 56, 91
jump button 91
layer 58
playing 91
settings 139
starting 91
window 90

timeline menu 138
Timeline Settings command 139
tint tweening 170
transparency

pre-multiplied, straight 130
transparency see opacity
triangle, in layer header 90
tween menu 142
tween point 62

copying 62
corner 62
editing numerically 63
removing 62
smooth 62

tween track 12, 61, 
adding points to
opacity 64
position 66
red curve 177
rotation 65
scale 64
stretching 62
volume 64

U
UDP 181
Undo command 116
Update command 12
USB port 18

V
velocity 67
VGA connector 204,
Video as Thumbnails
video distribution am
video see movie
VNC 131
volume 64
volume tweening 162
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W
warping 146
WATCHOUT

installing 17
obtaining 17
screenshot 13
system overview 8

window
media 96
message 102
overview 85
stage 87
timeline 90

window menu 142
Windows 24
Windows Media 9 39
Wireframes command 1
WMV file format 39
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